Sharing Data
with Other
Applications

Windows applications are designed to work together.
The applications in Microsoft Office are an excellent
example. These programs have a common look and feel, and
sharing data among these applications is quite easy. This

chapter explores some ways that you can make use of other
applications while working with Excel, as well as some ways

that you can use Excel while working with other applications.

Sharing Data with Other Windows
Applications

Besides importing and exporting files, the following are the
essential three ways in which you can transfer data to and
from other Windows applications:

» Copy and paste, using either the Windows Clipboard or
the Office Clipboard. Copying and pasting information
creates a static copy of the data.

« Create a link so that changes in the source data are
reflected in the destination document.

» Emibed an entire object from one application into
another application’s document,

The following sections discuss these techniques and present
an example for each one.
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Using the Windows or Office Clipboards

As you probably know, whenever Windows is running, you have access to the
Windows Clipboard —an area of your computer’s memory that acts as a shared
holding area for information that you have cut or copied from an application. The
Windows Clipboard works behind the scenes, and you usually aren’t aware of it.
Whenever you select data and then choose either Edits Copy or Edit+ Cut, the
application places the selected data on the Windows Clipboard. Like most other
Windows applications, Excel can then access the Clipboard data if you choose
the Edit+ Paste command (or the Edit« Paste Special command).

jE

if you copy or cut information while working in an Office application, the applica-
tion places the copied information on both the Windows Clipboard and the Office
Clipboard.

Once you copy information to the Windows Clipboard, it remains on the Windows
Clipboard even after you paste it, so you can use it multiple times. However,
because the Windows Clipboard can hold only ane item at a time, when you copy
or cut something else, the information previously stored on the Windows
Clipboard is replaced. The Office Clipboard, unlike the Windows Clipboard, can
hold up to 12 separate selections. The Office Clipboard operates in all Office appli-
cations; for example, you can copy two selections from Word and three from Excel
and paste any or all of them in PowerPaint.

Copying information from one Windows application to another is quite easy. The
application that contains the information that you’re copying is called the source
application, and the application to which yvou're copying the information is called
the destination application.

The general steps that are required to copy from one application to another are as
follows. These steps apply to copying from Excel to another application and to
copying from another application to Excel.

1. Activate the source document window that contains the information that you
want to copwv.

2, Select the information by using the mouse or the keyboard. If Excel is the
source application, this information can be a cell, range, chart, or drawn object.

3. Select Edit+ Copy. Excel places a copy of the information onto the Windows
Clipboard and the Office Clipboard.

4, Activate the destination application. lf the program isn’t running, you can
start it without affecting the contents of the Clipboard.

5. Move to the appropriate position in the destination application (where you
want to paste the copied material).

6. Select Edit+ Paste from the menu in the destination application. If the
Clipboard contents are not appropriate for pasting, the Paste command is
grayed (not available).
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In Step 3 in the preceding steps, you also can select Edite Cut from the source
application menu. This step erases your selection from the source application after
placing the selection on the Clipboard.
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if you repeat Step 3 in any Office application, the Office Clipboard toolbar appears
automatically. It continues to appear if the destination application that you activate
in Step 4 is another Office application.

In Step 6 in the preceding steps, you can sometimes select the Edit- Paste Special
command, which displays a dialog box that presents different pasting options.

If you're copying a graphics imnage, vou may have to resize or crop it. lf you're
copying text, vou may have to reformat it by using tools that are available in the
destination application. The information that you copy from the source applica-
tion remains intact, and a copy remains on the Clipboard until you copy or cut
something else. Figure 29-1 shows an embedded Excel chart. You can easily insert
a copy of this chart into a Microsoft Word report. First, select the chart in Excel
by clicking it once. Then, copy it to the Clipboard by choosing Edit+ Copy. Next,
activate the Word document into which you want to paste the copy of the chart,
and move the insertion point to the place where you want the chart to appear.
When vou select Edit+ Paste from the Word menu bar, the chart is pasted from
the Clipboard and appears in your document (see Figure 29-2).

Figure 29-1: An Excel chart, ready to be copied into a Word document.
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Figure 29-2: The Excel chart copied to a Word document.

You need to understand that Windows applications vary in the way that they
respond to data that you paste from the Clipboard. If the Edit- Paste command
is not available (is grayed on the menu) in the destination application, the appli-
cation can't accept the information from the Clipboard. If you copy a range of
data from Excel to the Clipboard and paste it into Word, Word creates a table
when you paste the data. Other applications may respond differently to Excel
data. If you plan to do a lot of copying and pasting, | suggest that you experiment
until you understand how the two applications handle each other’s data.

You should understand that this copy-and-paste technique is static. In other words,
no link exists between the information that you copy from the source application
and the information that you paste into the destination application. If you're copy-
ing from Excel to a word processing docurment, for example, the word processing
document will not reflect any subsequent changes that you make in your Excel
worksheet or charts. Consequently, vou have to repeat the copy-and-paste proce-
dure to update the destination document with the source document changes. The
next topic presents a way to get around this limitation.
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Linking Data

If you want to share data that may change, the static copy-and-paste procedure
described in the preceding section isn’t your best choice. Instead, create a dynamic
link between the data that you copy from one Windows application to another. In
this way, if you change the data in the source document, you don’t also need to
make the changes in the destination document, because the link automatically
updates the destination document.

When would you want to use this technique? If you generate proposals by using a
word processor, for example, you may need to refer to pricing information that you
store in an Excel worksheet. If you set up a link between your word processing
document and the Excel worksheet, you can be sure that your proposals always
quote the latest prices. Not all Windows applications support dynamic linking, so
you must make sure that the application to which you are copying is capable of
handling such a link.

Creating Links

Setting up a link from one Windows application to another isn’t difficult, although
the process varies slightly from application to application. The following are the
general steps to take:

1. Activate the window in the source application that contains the information
that vou want to copy.

2, Select the information by using the mouse or the keyboard. If Excel is the
source application, you can select a cell, range, or entire chart.

3. Select Edit+ Copy from the source application’s menu. The source application
copies the information to the Windows Clipboard.

4., Activate the destination application. [f it isn’t open, you can start it without
affecting the contents of the Clipboard.

v

. Move to the appropriate position in the destination application.

6. Select the appropriate command in the destination application to paste a link.
The command varies, depending on the application. In Microsoft Office
applications, the command is Edit+ Paste Special.

7. A dialog box will probably appear, letting you specify the type of link that you
want to create. The following section provides more details.

More About Links

Keep in mind the following information when you’re using links between two
applications:
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Not all Windows applications support linking. Furthermore, you can link from
but not to some programs. When in doubt, consult the documentation for the
application with which you’re dealing.

When you save an Excel file that has a link, vou save the most recent values
with the document. When yvou reopen this document, Excel asks whether you
want to update the links.

Links can be broken rather easily. If yvou move the source document to another
directory or save it under a different name, for example, the destination docu-
ment’s application won’t be able to update the link. You can usually reestablish
the link manually, if you understand how the application manages the links. In
Excel, you use the Edit+ Links command, which displays the Links dialog box,
shown in Figure 29-3.

You also can use the Edit « Links command to break a link. After breaking a
link, the data remains in the destination document, but is no longer linked to
the source document.

In Excel, external links are stored in array formulas. If you know what you're
doing, vou can modify a link by editing the array formula.

When Excel is running, it responds to link requests from other applications,
unless you have disabled remote requests. If you don’t want Excel to respond
to link-update requests from other applications, choose Tools» Options,
select the General tab, and then place a check in the Ignore other applica-
tions check box.
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Figure 29-3: The Links dialog box lets you work with links to
other applications.
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Copying Excel Data to Word

One of the most frequently used software combinations is a spreadsheet and a
word processor. This section discusses the types of links that you can create by
using Microsoft Word.

Most information in this section also applies to other word processors, such as
Corel's WordPerfect for Windows and Lotus Word Pro. The exact techniques vary,
however. | use Word in the examples because readers who acquired Excel as part
of the Microsoft Office have Word installed on their systems. If you don't have a
word processor installed on your system, you can use the WordPad application
that comes with Windows. The manner in which WordPad handles links is very
similar to that for Word.

Figure 29-4 shows the Paste Special dialog box from Microsoft Word after a range of
data has been copied from Excel to the Clipboard. The result that you get depends
on whether you select the Paste or the Paste link option, and on your choice of the
type of item to paste. If you select the Paste link option, you can choase to have the
information pasted as an icon. If you do so, you can double-click this icon to
activate the source worksheet.
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Figure 29-4: The Paste Special dialog box is where you
specify the type of link to create.

Pasting Without a Link

Often, you don’t need a link when you copy data. For example, if you’re preparing a
report in vour word processaor and you simply want to include a range of data from
an Excel worksheet, you probably don't need to create a link.

Table 29-1 describes the effect of choosing the various paste choices when you
select the Paste option —the option that doesn 't create a link to the source data.
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Paste Type Result

Formatted Text A Word table that is formatted as the original Excel range. No link to
(RTF) the source exists. This produces the same result as using Edit+ Paste

A picture abject that retains the formatting from Excel. No link to the
source exists. This usually produces better results than the Bitmap
option. Double-clicking the object after you paste it enables you to edit
the picture.

HTML Format A table that is formatted as the original Excel range. No link to the
source exists. Use this format when you expect to publish the docu-
ment as a Web page.
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Figure 29-5 shows how a copied range from Excel appears in Word, using each of the
paste special formats.

Figure 29-5: Data that is copied from Excel and pasted using various formats.

The pasted data looks the same regardless of whether the Paste or Paste link option
is selected.

Some Excel formatting dees not transfer when pasted to Word as formatted text.
For example, Word doesn’t support vertical alignment for table cells (but you can
use Word’s paragraph formatting commands to apply vertical alignment).

Pasting with a Link

If you think the data that you're copying will change, you may want to paste a link. If
you paste the data by using the Paste link option in the Paste Special dialog box, you
can make changes to the source document, and the changes appear in the destina-
tion application (a few seconds of delay may occur). You can test these changes by
displaying both applications onscreen, making changes to the source document, and
watching for them to appear in the destination document.

Table 29-2 describes the effect of choosing the various paste choices in Word’s
Paste Special dialog box when the Paste link option is selected.
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Paste Type Result

Formatted Text A Word table that is formatted as the original Excel range. Changes in
icall

e formatting from Excel. Changes in the
source are reflected automatically. This usually produces better results
than the Bitmap option. Double-click the object after pasting it to edit
the source data in Excel.

HTML Format A table that is formatted as the original Excel range. Use this format
when you expect to publish the document as a Web page.

Embedding Objects

Using Obyect Linking and Embedding (OLE), you can also embed an object to share
information between Windows applications. This technique enables you to insert
an object from another program and use that program’s editing tools to manipulate
it. The OLE objects can be items such as those in the following list:

» Text documents from other products, such as word processors

» Drawings or pictures from other products

« Information from special OLE server applications, such as Microsoft Equation

» Sound files

* Video or animation files

Most of the major Windows applications support OLE. You can embed an object into
your document in either of two ways:
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« Choose Edit+ Paste Special, and select the “object” choice (if it’s available).
If you do this, select the Paste option rather than the Paste link option.

» Select Insert+ Object.

Some applications —such as those in Microsoft Office — can also embed an object
by dragging it from one application to another.

The following sections discuss these two methods and provide a few examples using
Excel and Word.

Embedding an Excel Range in a Word Document

This example embeds the Excel range shown in Figure 29-6 in a Word document.

Figure 29-6: This range will be embedded in a
Word document.

To start, select A1:D15 and copy the range to the Clipboard. Then, activate (or
start) Word, open the document in which you want to embed the range, and then
move the insertion point to the location in the document where you want the
table to appear. Choose Word’s Edit + Paste Special command. Select the Paste
option (not Paste link), and choose the Microsoft Excel Worksheet Object format
(see Figure 29-7). Click OK, and the range appears in the Word document.

The pasted object is not a standard Word table. For example, vou can’t select or
format individual cells in the table. Furthermore, it’s not linked to the Excel source
range. [f you change a value in the Excel worksheet, the change does not appear in
the embedded object in the Word document.
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Figure 29-7: This operation embeds an Excel object in
a Word document.

If vou double-click the object, however, you notice something unusual: Word’s
menus and toolbars change to those used by Excel. In addition, the embedded
object appears with Excel’s familiar row and column borders. In other words, you
can edit this object in place by using Excel's commands. Figure 29-8 shows how
this looks. To return to Word, just click anywhere in the Word document.

I i
Figure 29-8: Double-clicking the embedded Excel object enables you to edit it in
place. Note that Word now displays Excel’s menus and toolbars.
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Remember that no link is involved here. If you make changes to the embedded
object in Word, these changes do not appear in the original Excel worksheet. The
embedded object is completely independent from the original source.

Using this technique, you have access to all of Excel’s features while you are still in
Word. Microsoft’s ultimate goal is to enable users to focus on their documents —
not on the application that produces the document.

You can accomplish the embedding previously described by selecting the range in
Excel and then dragging it to your Word document. In fact, you can use the
Windows desktop as an intermediary storage location. For example, you can drag
a range from Excel to the desktop and create a scrap. Then, you can drag this scrap
into your Word document. The result is an embedded Excel object.

Creating a New Excel Object in Word

The preceding example embeds a range from an existing Excel worksheet into a
Word document. This section demonstrates how to create a new (empty) Excel
object in Word. This may be useful if you're creating a report and need to insert a
table of values that doesn’t exist in a worksheet. You could insert a normal Word
table, but you can take advantage of Excel’s formulas and functions to make this
task much easier.

To create a new Excel object in a Word document, choose Insert+ Object in Word.
Word responds with the Object dialog box, shown in Figure 29-9. The Create New
tab lists the types of objects that you can create (the contents of the list depends
on the applications that you have installed on your system). Choose the Microsoft
Excel Worksheet option and click OK.
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Figure 29-9: Word's Object dialog box enables you
to create a new object.
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Word inserts an empty Excel worksheet object into the document and activates it for
you, as shown in Figure 29-10. You have full access to Excel commands, so you can
enter whatever yvou want into the worksheet object. After you finish, click anvwhere
in the Word document. You can, of course, double-click this object at any time to
make changes or additions.

Figure 29-10: Word created an empty Excel worksheet object.

You can change the size of the object while it's activated by dragging any of the
sizing handles that appear on the borders of the object. You also can crop the
object, so that when it isn’t activated, the abject displays only cells that contain
information. To crop an object in Word, select the object so that you can see sizing
handles. Then, display Word’s Picture toolbar (right-click any toolbar button and
choose Picture). Click the Cropping tool (it looks like a pair of plus signs) and then
drag any sizing handle on the object.

Even if you crop an Excel worksheet abject in Word, when you double-click the
object, you have access to all rows and columns in Excel. Cropping changes only
the displayed area of the object.
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Embedding an Existing Workbook in Word

Yet another option is to embed an existing workbook into a Word document. Use
Word’s Insert+ Object command. In the Object dialog box, click the tab labeled
Create from File (see Figure 29-11). Click the Browse button and locate the Excel
workbook that you want to embed.

HErmmeaa e

Figure 29-11: This dialog box enables you to locate
a file to embed in the active document.

When you use this technique, you embed a copy of the selected workbook in the
Word document. You can either use it as is or double-click it to make changes. Note
that any changes that you make to this copy of the document are not reflected in
the original workbook.

Embedding Objects in an Excel Worksheet

The preceding examples involve embedding Excel objects in a Word document. The
same procedures can be used to embed other objects into an Excel worksheet.

For example, if you have an Excel workbook that requires a great amount of explana-
tory text, vou have several choices:

* You can enter the text into cells. This is tedious and doesn’t allow much
formatting.

» You can use a text box. This is a good alternative, but it doesn’t offer many
formatting features.

* You can embed a Word document in your worksheet. This gives vou full access
to all of Word’s formatting features.
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To embed an empty Word document into an Excel worksheet, choose Excel’s
Inserts Object command. In the Object dialog box, click the Create New tab and
select Microsoft Word Document from the Object type list.

The result is a blank Word document, activated and ready for vou to enter text.
Notice that Word's menus and toolbars replace Excel’s menus and toolbars. You
can resize the document as you like, and the words wrap accordingly. Figure 29-12
shows an example of a Word document embedded in an Excel worksheet.
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Figure 29-12: A Word document that is embedded in an Excel worksheet.

You can embed many other types of objects, including audio clips, video clips, MIDI
sequences, and even an entire Microsoft PowerPaint presentation.

When vou embed a video clip, Excel doesn’t store the actual video clip file in the
Excel document. Rather, Excel stores a pointer to the original file. If, for some
reason, you want to embed the complete video clip file, you can use the Object
Packager application. Be aware, however, that video clip files are typically quite
large, and opening and saving the workbook will take a lot of time.

Microsoft Office includes a few additional applications that you may find useful.
These all can be embedded in Excel documents:
» Microsoft Equation: Create equations, such as the one shown in Figure 29-13.
» Microsoft WordArt: Modify text in some interesting ways, as in Figure 29-14,

* MS Organization Chart: Create attractive organizational charts, as shown in
Figure 29-15.
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Figure 29-13: This object was created with Microsoft Equation.

Figure 29-14: An example of Microsoft WordArt.

Moe's Yard Service

Moe Howard
President

] | ]
Larry Fine Curly Howard Shemp Howard
ice-Presiders vice Presicent Vige President
Clipping Clean-Up IMowing

111, Sheett 4 T D i
Figure 29-15: An example of an embedded organizational chart.
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Using Office Binders

If you have Microsoft Office installed, you may take advantage of its binder feature.
A binder is a container that can hold documents from different applications: Excel,
Word, and PowerPoint.

You may find that a binder is useful when you are working on a project that involves
documents from different applications. For example, you may be preparing a sales
presentation that uses charts and tables from Excel, reports and memas from Word,
and slides prepared with PowerPoint. You can store all the information in a single file.
And, when you print the entire binder, pages are numbered sequentially.

To use a binder, start the Binder application, and an empty binder appears. You then
can add existing documents to the binder or create new documents in the binder.
Figure 29-16 shows a binder that contains Word, Excel, and PowerPoint documents.
Consult the online Help for complete details on using this application.

Figure 29-16: An Office binder can hold documents that are produced by
different applications.

You may need to rerun Office setup if Binder isn't installed on your computer.
You'll find it under a category called Office Tools.
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Summary

This chapter describes technigues that enable you to use data from other applica-
tions. These techniques include standard copy-and-paste options using the Windows
and Office Clipboards, dynamic linking between applications, and embedding objects.
This chapter concludes with a note on Microsoft Office’s binder application, which
enables you to work with documents that are produced by different applications.

*  SORGEIANINE  HECESEINENS
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Excel and the
Internet

‘ hances are, you're already involved in the Internet in

some way. This technology seems to have taken the
world by storm. The World Wide Web (WWW) is probably the
most exciting thing happening these days in the world of com-
puting. In fact, the Web reaches well beyond the computer
community and is a pervasive force in our lives. [t's now quite
common to see Web site addresses listed in TV commercials,
in magazine ads, and even on billboards.

The applications in Microsoft Office 2000 —including Excel —
have all been revamped to put them on a better footing with
the Internet. This chapter provides an introduction to the
Internet (for those who have yet to discover this resource) and
discusses the Internet features that are available in Excel 2000.

What Is the Internet?

The Internet, in a nutshell, is a collection of computers that are
located all around the world. These computers are all con-
nected to each other, and they can pass information back and
forth. Strange as it may seem, the Internet is essentially a non-
commercial system, and no single entity “runs” the Internet.

Most people don't think of the Internet as a collection of
computers. Rather, the Internet is a resource that contains
information — and you use a computer to access that infor-
mation. The computers that are connected to the Internet
simply do the grunt work of passing the information from
point A (which could be a computer in Hamburg, Germany)
to point B (which could be the computer in your cubicle).
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What's Available on the Internet?

The amount and variety of information that’s available on the Internet is simply
mind-boggling. You can think of virtually any topic in the world, and an excellent
chance exists that at least some information on that topic can be found on the
[nternet. Not unexpectedly, computer-related information is especially abundant.

So, where do you get this information? The following are the four primary sources
for information on the Internet:

» Web sites: The Web has rapidly become the most popular part of the Internet.
Hundreds of thousands of Web sites are available that you can access with
yvour Web browser software. For example, my own Web site (The Spreadsheet
Page) has the following URL: http://www. j-walk.com/ss/

* FTP sites: These are computers that have files available for download. You
can download these files by using Web browser software or other software
that is designed specifically to download files from FTP sites. The following is
the URL for Microsolt’s FTP site: ftp://ftp.microsofti.com

= Newsgroups: These are essentially electronic bulletin boards. People post
messages or questions, and others respond to the messages or answer their
questions. Thousands of newsgroups are available for just about any topic
that you can think of. You need special “news reader” software to read or
post messages to a newsgroup (although most Web browsers also include
this feature). For more information, see the sidebar “Excel Newsgroups.”

« Mailing lists: If you have access to Internet e-mail, you can subscribe to any of
several thousand muailing lists that address a broad array of topics. Subscribers
send e-mail to the mailing list, and then every other subscriber to the list
receives that e-mail. There are two popular mailing lists that deal with Excel
(refer to the “Excel Mailing Lists™ sidebar for details).

How Do You Get on the Internet?

You can access the Internet in a number of ways. Here are some of the most com-
mon ways:

» Through your company: Your company may already be connected to the
Internet. If so, just fire up vour Web browser and you're there!

» Through an Internet Service Provider (ISP): Most communities have several
companies that can set up an Internet account for you. For a small monthly
fee (usually around $20) you can have unlimited (or almost unlimited) access
to the Internet. All that’s required on your part is a computer, a modem, and a
phone line.

* Through an online service: I you subscribe to any of the following online
services, you can access the Internet through that service: America Online,
CompuServe, Microsoft Network, or Prodigy.
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if your ISP doesnt carry the microsoft.public.excel .* groups, you can
access them directly from Microsoft’'s news server. You need to configure your
newsreader software or Web browser to access Microsoft's news server, which is
msrnews.microsaft.com
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Where to Find Out More About the Internet

The best place to find out more about the Internet is —you guessed it—the Internet.
A good starting place is the IDG Books Web site. To access it, open the following URL
in your Web browser: http://www.idgbooks.com

DG Books Worldwide publishes numerous Internet books for users of all levels, and
you can find these listed and described on the IDG Web site.

Excel’s Internet Tools

The remainder of this chapter describes the Internet-related features available in
Excel 2000. These features include:

= Using HTML as a native file format (instead of the XLS file format).
« Saving a worksheet as an interactive Web page.
« Using Excel’'s Web toolbar.

* Inserting hyperlinks into a worksheet.
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« Creating and using Web queries.

+ Scheduling and conducting online meetings.

» Creating discussion groups.

Usmg HTML As a Native File Format

Excel's standard file format is, of course, an XLS file. Excel 2000, however, has the
ability to use HTML as a native file format. This means that you can create a work-
book and save it in HTML format. Then, you can reopen the file without losing any
information. In other words, your Excel-specific information (such as formulas,
charts, pivot tables, and macros) survive the translation to HTML.

If vou've used the “save as HTML” feature in Excel 97, you probably know that the
HTML file that's created works fine in Web browsers — but if you reopen the file in
Excel, all of your formulas (as well as other Excel-specific features) will be gone.
With Excel 2000, this problem no longer exists, because the HTML file contains lots
of proprietary tags that are ignored by browsers but that enable Excel to re-create
the workbook.

To save a workbook in HTML format, select File+ Save As. You'll see the familiar
Save As dialog box— but with some new options (see Figure 30-1). In the field
labeled Save as type, make sure Web Page (*.htm, *.html) is selected. Provide a
filename, and click Save. To reopen the file, use the normal File= Open command.

i)
i) Page files
%l Old Excel Documents

4] testFile htm

Figure 30-1: Use the Save As dialog box to save a workbook in HTML
format.
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Unless your workbook is very simple, saving it in HTML format generates addi-
tional “supporting” files, because the HTML file format can't handle Excel-specific
items, such as macros, charts, and pivot tables. The supporting files are stored in a
separate subdirectory within the directory where you save the file. The directory
name consists of the file’s name, followed by a space and the word “files”
Therefore, if you need to transfer the file to another computer, make sure that you
also transfer the supporting files in the subdirectory.

If vou save your work in HTML format, you should be aware of some additional
options. Select Tools» Options, click the General tab, and then click the Web Options
button. You'll see the dialog box shown in Figure 30-2. Most of the time, the default
settings work just fine. However, familiarizing yourself with the options available is
worthwhile (these are described in the online Help). You can also access the Web
Options dialog box from the Tools menu in the Save As dialog box.

Figure 30-2: Use the Web Options dialog box to
set various options for working with HTML files.

When you save a workbook in HTML format, by default, it will not be interactive
when it’s opened in a browser. The browser displays a good rendition of the
worksheet, but it’s essentially a “dead” workbook, because the user can’t change
any cells. The next section describes how to save vour Excel workbaook in a way
that provides interactivity within a Web browser.

Providing Interactivity in Your Web Documents

When vou save an Excel workbook in HTML format, you can select an option that
makes the file interactive within the browser. This means that the user can perform
standard Excel operations directly in the browser. For example, the user can change
cells or manipulate data in a pivot table. Saving an Excel file with interactivity is
limited to a single sheet.
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To take advantage of this interactivity, the user must have Office 2000 installed, or
have a licensed copy of the Office Client Pak. The Office Client Pak consists of the
ActiveX controls necessary to work with interactive Office documents in a Web
browser. Currently, the only browser that supports this technology is Microsoft
Internet Explorer.

Figure 30-3 shows an example of an Excel workbook displayed in Internet Explorer.
The user can change the values, and the formulas display the calculated results.

$245,000.00

owen Payment Percent: ; 20.00%
Loan Amount: $195,0600.00
Interest Rate: 7 .85%

Figure 30-3: An interactive Excel workbook opened in
Internet Explorer.

You need to understand that the interactivity is limited. For example, you can’t
execute macros when an interactive Excel file is displayed in a browser.

Using the Web Toolbar

Use the Web toolbar (shown in Figure 30-4) to move among files (Excel files and
HTML documents); this is similar to using a Web browser. You can jump forward or
backward among the workbooks and other files that you've visited, and add the
ones that you may use frequently to a “favorites” list.
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Figure 30-4: The Web toolbar.

Working with Hyperlinks

Hyperlinks are shortcuts that provide a quick way to jump to other workbooks and
files. You can jump to files on your own computer, your network, and the Internet
and Web.

Inserting a hyperlink

You can create hyperlinks from cell text or graphic objects, such as shapes and
pictures. To create a text hyperlink, choose the Inserts Hyperlink command Cor
press Ctrl+K). Excel responds with the dialog box shown in Figure 30-5.

Select an icon in the Link to column that represents the type of hyperlink you want
to create. Then, specify the location for the file that vou want to link to. The dialog
box will change, depending on the icon selected. Click OK, and Excel creates the
hyperlink in the active cell.

he Spreadshest Pags
he Spreadshest Page

Figure 30-5: The Insert Hyperlink dialog box.

Adding a hyperlink to a graphic object works the same way. Add an object to your
worksheet by using the Drawing toolbar. Select the object and then choose the
[nsert+ Hyperlink command. Specify the required information as outlined in the
previous paragraph.
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Using hyperlinks

When you work with hyperlinks, remember that Excel attempts to mimic a Weh
browser. For example, when you click a hyperlink, the hyperlinked document
replaces the current document — it takes on the same window size and position.
The document that contains the hyperlink is hidden. You can use the Back and
Forward buttons on the Web toolbar to activate the docurnents.

Web Queries

Excel enables you to pull in data contained in an HTML file by performing a Web
query. The data is transferred to a worksheet, where you can manipulate it any
way you like. You need to understand that performing a Web query does not
actually open the HTML file in Excel.

The Web query feature is very similar to performing a normal database query (see
Chapter 24). The only difference is that the data is coming from a Web page rather
than a database file. Figure 30-6 shows a Web page that's a good candidate for a
Web query.

| htip:divali/ ssdsalesdate. btrn

Miilson |iNew

Franks Existing

Vilson New

Fetarson Existing
Sheldon New
Petarsan _j|Existing

Kenkins Existing
K‘zFebruary Sheldon New
anuary  [Wilson  [New

| anuary  [Wilsan New

i Wanuary  ||Sheldan |{Maw
February  [Sheldon |{new

Figure 30-6: The table in this Web page will be brought inta
a worksheet as a Web query.
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The best part about a Web query is that Excel remembers where the data came
from. Therefore, after vou create a Web query, you can “refresh” the query to pull
in the most recent data.

To create a Web query, select Data+ Get External Data+ New Web Query. Excel
displays the New Web Query dialog box, shown in Figure 30-7. [n part 1, specify
the HTML file, using the Browse button if you like. The HTML file can be on the
Internet, a corporate intranet, or on a local or network drive. In part 2, select how
much of the file you want to use. Most of the time, you’ll just want to bring in a
particular table. In part 3, specify the type of formatting that vou'd like to see.
Click the Advanced button for some additional options — these options might be
necessary if the data in the HTML file is not in the form of a table. Click OK and
you get another dialog box asking where you want to place the data.

i
Figure 30-7: Use the New Web Query dialog box to
specify the source of the data.
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Figure 30-9: The External Data Range Properties
dialog box provides you with some options
regarding your Web query.

Summary

This chapter provides a brief introduction to the Internet and describes several
Internet tools that are available in Excel. It explains how to use HTML as a native
file format, use the Web toolbar, work with hyperlinks, and use Web queries.

* FERESRUSERN NSO IUI SR
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Making Your
Worksheets
Error-Free

I he ultimate goal in developing a spreadsheet solution is
to generate accurate results. For simple worksheets, this
isn’t difficult, and you can usually tell whether the results are
correct. But when your worksheets are large or complex,
ensuring accuracy becomes more difficult. This chapter pro-
vides you with tools and techniques to help you identify and
correct errars.

Types of Worksheet Problems

Making a change in a worksheet —even a relatively minor
change —may produce a ripple effect that introduces errors
in other cells. For example, accidentally entering a value into
a cell that formerly held a formula is all too easy to do. This
can have a major impact on other formulas, and you may not
discover the problem until long after you make the change.
Or, you may never discover the problem.

An Excel worksheet can have many types of problems. Some
problems —such as a formula that returns an error value —
are immediately apparent. Other problems are more subtle.
For example, if a formula was constructed using faulty logic,
it may never return an error value —it simply returns the
wrong values. If you're lucky, vou can discover the problem
and correct it.

Common problems that occur in worksheets are the following:

« Incorrect approach to a problem
» Faulty logic in a formula

» Formulas that return error values
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« Circular references

+ Spelling mistakes

» A worksheet is new to you, and you can’t figure out how it works

Excel provides tools to help you identify and correct some of these problems. In the
remaining sections, [ discuss these tools along with others that I've developed.

Formula AutoCorrect

When you enter a formula that has a syntax error, Excel attempts to determine the
problem and offers a suggested correction.

For example, if vou enter the following formula (which has a syntax error), Excel
displays the dialog box that is shown in Figure 31-1:

=SUM(AL:AL2)/3B

Figure 31-1: Excel can often offer a suggestion to correct
a formula.

Be careful about accepting corrections for your formulas from Excel, because it
doesn't always guess correctly. For example, 1 entered the following formula
(which has mismatched parentheses):

=AVERAGE(SUM(AL:A12 ,SUM(B1:B12))
Excel proposed the following correction to the formula:
=AVERAGE(SUM(AL:A12,SUM(BL1:B12))}

You may be tempted to accept the suggestion without even thinking. In this case,
the proposed formula is syntactically correct—but not what | intended.

Tracing Cell Relationships

Excel has several useful tools that can help you track down errors and logical flaws
in vour worksheets. This section discusses the following items:
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« Go To Special dialog box

+ Excel’s built-in auditing tools

These tools are useful for debugging formulas. As you probably realize by now, the
formulas in a worksheet can become complicated and refer (directly or indirectly)
to hundreds or thousands of other cells. Trying to isolate a problem in a tangled
web of formulas can be frustrating.

Before discussing these features, you need to be familiar with the following two
concepts:

» Cell precedents: Applicable only to cells that contain a formula. A formula
cell's precedents are all the cells that contribute to the formula’s result. A
direct precedent is a cell that you use directly in the formula. An indirect
precedent is a cell that isn’t used directly in the formula, but is used by a cell
to which you refer in the formula.

» Cell dependents: Formula cells that depend on a particular cell. Again, the
formula cell can be a direct dependent or an indirect dependent.

Often, identifying cell precedents for a formula cell sheds light on why the formula
isn’t working correctly. On the other hand, knowing which formula cells depend on
a particular cell is often helpful. For example, if you're about to delete a formula,
you may want to check whether it has any dependents.

The Go To Special Dialog Box

The Go To Special dialog box can be useful, because it enables you to specify the
type of cells that you want Excel to select. To display this dialog box, choose Edit«
Go To (or press F5). The Go Ta dialog box appears. Click the Special button, which
displays the Go To Special dialog box, as shown in Figure 31-2.

Figure 31-2: The Go To Special
dialog box.
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If you select a range before choosing Edit+ Go To, the command looks only at the
selected cells. If only a single cell is selected, the command operates on the entire
worksheet.

You can use this dialog box to select cells of a certain type —which can often be help-
ful in identifying errors. For example, if you choose the Formulas option, Excel selects
all the cells that contain a formula. If you zoom the worksheet out to a small size, you
can get a good idea of the worksheet’s organization (see Figure 31-3). It may also help
you spot a common error: a formula that you overwrote with a value. If you find a cell
that’s not selected amid a group of selected formula cells, chances are good that the
cell formerly contained a formula that has been replaced by a value.

ysheet 1 SRR s il

Figure 31-3: Zooming out and selecting all formula cells can
give you a good averview of how the worksheet is designed.

You can also use the Go To Special dialog box to identify cell precedents and depen-
dents. In this case, Excel selects all cells that qualify. In either case, you can choose
whether to display direct or all levels.

Excel has shortcut keys that you can use to select precedents and dependents. These
are listed in Table 31-1.
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Key Combination What It Selects

Ctri+Shift+] precedents

Ctrl+Shift+] All dependents

You also can select a formula cell's direct dependents by double-clicking the cell. This
technique, however, works only when vou turn off the Edit directly in the cell option
on the Edit tab of the Options dialog box.

Excel’s Auditing Tools

Excel provides a set of interactive auditing tools that you may find helpful. Access
these tools either by selecting Tools « Auditing (which results in a submenu with
additional choices) or by using the Auditing toolbar, shown in Figure 31-4.

The tools on the Auditing toolbar, from left to right, are as follows:

» Trace Precedents: Draws arrows to indicate a formula cell’s precedents. Click
this multiple times to see additional levels of precedents.

» Remove Precedent Arrows: Removes the most recently placed set of
precedent arrows.
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« Trace Dependents: Draws arrows to indicate a cell’s dependents. Click this
multiple times to see additional levels of dependents.

* Remove Dependent Arrows: Removes the most recently placed set of depen-
dent arrows.

« Remove All Arrows: Removes all precedent and dependent arrows from the
worksheet.

» Trace Error: Draws arrows from a cell that contains an error to the cells that
may have caused the error.

*» New Comment: Inserts a comment for the active cell. This really doesn’t have
much to do with auditing. It lets you attach a comment to a cell.

* Circle Invalid Data: Draws a circle around all the cells that contain invalid data,
This applies only to cells that have validation criteria specified with the Data«
Validation command.

* (lear Validation Circles: Removes the circles that are drawn around cells that
contain invalid data.

These tools can identify precedents and dependents by drawing arrows (known
as cell tracers) on the worksheet, as shown in Figure 31-5. In this case, cell G11
was selected and then the Trace Precedents toolbar button was clicked. Excel
drew lines to identify the cells used by the formula in G11 (direct precedents).

15% Improvement Fram Priar Month
5.50% Paid if Sales Goal is Attained

Last This Pct. Com-
Month Monti Change  Change rmizsion

101,233 98,744 {2,489 -25% 5431

120233 134 544 13611 11.3% 7,400

112344 {34887 253 201% 8,768
130533 1651745 0812 15.9% 963
150932 140778 (10,154) 67% 7743
BEE ] 44,323 7.3% Va0 05

R shecte QRURMITEARVE Y VTS T B P
Figure 31-5: Excel draws lines to indicate a cell’'s precedents.
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Figure 31-6 shows what happens when the Trace Precedents button is clicked again.
This time, Excel adds more lines to show the indirect precedents. The result is a
graphical representation of the cells that are used (directly or indirectly) by the
formula in cell G11.
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101233
120933

112,344
130,933
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sheet? 4§ HGHIE
Figure 31-6: Excel draws more lines

L

to indicate the indirect precedents.

This type of interactive tracing is often more revealing when the worksheet is
zoomed out to display a larger area.

The best way to learn about these tools is to use them. Start with a worksheet that

has formulas and experiment with the various buttons on the Auditing toolbar.

Tracing Error Values

The Trace Error button on the Auditing toolbar helps you to identify the cell that is
causing an error value to appear. Often, an error in one cell is the result of an error
in a precedent cell. Activate a cell that contains an error, and click the Trace Error

button. Excel draws arrows to indicate the error source.

Table 31-2 lists the types of error values that may appear in a cell that has a formula.
The Trace Error button works with all of these errors.
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Error Value Explanation

#NAME? The formula uses a name that Excel doesn’t recognize. This can happen if
you delete a name that's used in the formula or if you have unmatched
uotation marks when using text

#NULL! The formula uses an intersection of two ranges that do not intersect (this
concept is desaribed later in the chapter).

Circular References

A circular reference occurs when a formula refers to its own cell—either directly or
indirectly. Usually, this is the result of an error (although some circular references
are intentional). When a worksheet has a circular reference, Excel displays the cell
reference in the status bar.

Refer to the discussion of circular references in Chapter 9.

Other Auditing Tools

The registered version of the Power Utility Pak includes a utility named Auditing
Tools. The dialog box for this utility is shown in Figure 31-7.

Figure 31-7: The Worksheet
Auditing dialog box from
the Power Utility Pak.
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This utility works with the active worksheet and can generate any or all of the
following items:

» Worksheet map: A color-coded graphical map of the worksheet that shows the
type of contents for each cell—value, text, formula, logical value, or error. See
Figure 31-8.

» Formula list: A list of all formulas in the worksheet, including their current
values.

» Summary report: An informative report that includes details about the work-
sheet, the workbook that it’s in, and a list of all defined names.

liish R, Work sheet Map i NESiiai kR0
Figure 31-8: This worksheet map was

produced by the Auditing Tools utility
from the Power Utility Pak.

You can find the shareware version of the Power Utility Pak on this book’s CD-ROM.
Owners of this book can purchase the Power Utility Pak at a significant discount. Use
the coupon in the back of the book to order your copy.

Spelling and Word-Related Options

Excel includes several handy tools te help you with the non-numeric problems —
those related to spelling and words.
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Spell Checking

If you use a word processing program, vou probably run its spelling checker before
printing an important document. Spelling mistakes can be just as embarrassing when
they appear in a spreadsheet. Fortunately, Microsoft includes a spelling checker with
Excel. You can access the spelling checker by using any of these methods:

» Select Tools» Spelling
« Click the Spelling button on the Standard toolbar

» Press F7

The result of using any one of these methods is the Spelling dialog box that is shown
in Figure 31-9.

Figure 31-9: The Spelling dialog box.

The extent of the spell checking depends on what you selected before you opened
the Spelling dialog box. If you selected a single cell, Excel checks the entire work-
sheet, including cell contents, notes, text in graphic objects and charts, and page
headers and footers. Even the contents of hidden rows and columns are checked.
If you select a range of cells, Excel checks only that range. If yvou select a group of
characters in the formula bar, Excel checks only those characters.

The Spelling dialog box works similarly to other spelling checkers with which you
may be familiar. If Excel encounters a word that isn’t in the current dictionary or is
misspelled, it offers a list of suggestions. You can respond by clicking one of the
following buttons:

» Ignore: [gnores the word and continues the spell check.

* Ignare All: [gnores the word and all subsequent occurrences of it.

» Change: Changes the word to the selected word in the Change to edit box.
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« Change All: Changes the word to the selected word in the Change to edit box
and changes all subsequent occurrences of it without asking.

* Add: Adds the word to the dictionary.

» Suggest: Displays a list of replacement words. This button is grayed if the
Always suggest check box is checked.

» AutoCorrect: Adds the misspelled word and its correct spelling to the list:

=SUM(AL:AL2)/3B

Using AutoCorrect

AutoCorrect is a handy feature that automatically corrects common typing mistakes.
You also can add words to the list that Excel corrects automatically. The AutoCorrect
dialog box appears in Figure 31-10. You access this feature by choosing Tools =
AutoCorrect.

utoCerract

about the
gbsence
accessaries
accident

Figure 31-10: The AutoCorrect dialog box.

This dialog box has several options:

» Correct TWo INitial CApitals: Automatically corrects words with two
initial uppercase letters. For example, BUdget is converted to Budget. This is a
common mistake among fast typists. You can click on the Exceptions button
to specify a list of exceptions to this rule. For example, my company name is
JWalk and Associates, so | created an exception for JWaik.

» Capitalize first letter of sentence: Capitalizes the first letter in a sentence.
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« Capitalize names of days: Capitalizes the days of the week. If you enter monday,
Excel converts it ta Monday.

« Correct accidental use of cAPS LOCK key: Corrects errors caused if you acci-
dentally hit the CapsLock key while typing.

» Replace text as you type: AutoCorrect automatically changes incorrect words
as you type them.

Excel includes a long list of AutoCorrect entries for commonly misspelled words. In
addition, it has AutoCorrect entries for some symbols. For example, (c) is replaced
with © and () is replaced with ® You can also add your own AutoCorrect entries.
For example, if you find that you frequently misspell the word January as Janraary,
you can create an AutoCorrect entry so that it’s changed automatically. To create a
new AutoCorrect entry, enter the misspelled word in the Replace box and the cor-
rectly spelled word in the With box. As [ noted previously, you also can do this in the
Spelling dialog box.

You also can use the AutoCorrect feature to create shortcuts for commonly used
words or phrases. For example, if you work for a company named Consolidated
Data Processing Corporation, you can create an AutoCorrect entry for an abbrevi-
ation, such as ¢dp. Then, whenever you type ¢dp, Excel automatically changes it
to Consolidated Data Processing Corporation.

Using AutoComplete

AutoComplete automatically finishes a word as soon as Excel recognizes it. For Excel
to recognize the word, it must appear elsewhere in the same column. This feature is
most useful when you're entering a list that contains repeated text in a column. For
example, assume that you're entering customer data in a list, and one of the fields is
City. Whenever you start typing, Excel searches the other entries in the column. If it
finds a match, it completes the entry for you. Press Enter to accept it. If Excel guesses
incorrectly, keep typing to ignore the suggestion.

If AutoComplete isn’t working, select Tools+ Options, click on the Edit tab, and
check the box labeled Enable AutoComplete for cell values.

You also can display a list of all items in a column by right-clicking and choosing Pick
from list from the shortcut menu. Excel then displays a list box of all entries that are
in the column (see Figure 31-11). Click on the one that you want, and Excel enters it
into the cell for you.
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Oregon 2,842,
Pennsylvania 11,681643
Hhode Islznd 1,003 454
Sautk Caralina 3483 703
Soutk Dakotz 695 004
Tennesses 4877185
Texas 16,333 510
Utah 1,722 850
Vermant 562 758
Virginia 5,187 358
. Maskingtan 4 g6s 32
West Virginia 1,793 477
Wisconsin 4891 769
~ Myoming 453 588

Albama
1 Alaska
-4 Arizona

Calformia
"] Calorada

W T : AT e el
Figure 31-11: Choosing the Pick from list option
from the shortcut menu gives you a list of entries
from which to choose.

Learning About an Unfamiliar Spreadsheet

When you develop a workbook yourself, you have a thorough understanding of how
it's put together. But if you receive an unfamiliar workbook from someone, it may be
difficult to understand how it all fits together — especially if it’s large.

First, identify the bottomrline cell or cells. Often, a worksheet is designed to produce
results in a single cell or in a range of cells. After you identify this cell or range, you
should be able to use the celltracing techniques described earlier in this chapter to
determine the cell relationships.

Although every worksheet is different, a few techniques can help you become familiar
with an unfamiliar workhook. [ discuss these techniques in the following sections.

Zooming Out for the Big Picture

I find that it's often helpful to use Excel’'s zoom feature to zocom out to get an over-
view of the worksheet’s layout. You can select View+ Full Screen to see even more
of the worksheet. When a workbook is zoomed out, vou can use all of the normal
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commands. For example, you can use the Edit+ Go To command to select a name
range. Or, you can use the options that are available in the Go To Special dialog box
(explained previously in this chapter) to select formula cells, constants, or other
special cell types.

Viewing Formulas

You can become familiar with an unfamiliar workbook by displaying the formulas
rather than the results of the formulas. Select Tools+ Options, and check the box
labeled Formulas on the View tab. You may want to create a new window for the
workbook before issuing this command. That way, you can see the formulas in one
window and the results in the other.

Figure 31-12 shows an example. The window on the top shows the normal view
{(formula results). The window on the bottom displays the formulas.

5 SRR

Comrrission Jate: 6.60% Noor al Cormmiss on Ratz
Salee Goal; 8% lmprovement Frar Prior Month
Borus Rats: 6.50% Paid if Sales Goal is Altainsc
#arsil This Chaer Mel Coet-
Sales Rep Monih Honth Change _ ge Goai? mssion
Wurrax 10 233 98744 (2409) -25% FALSE 5431
| Knuckles 120,933 124544 13611 11.3% FALSE 7.4C0
efty 112,244 134987 22543 2M1% TRUE g7e8
ucky 130,933 1617468 20812 163% TRUE 9863
|Scarface 150,932 140,778 (10.154) B/% FALSE F#43
Totals 616,375 BE0508 44,323 7.2% 39,305
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. 101233 98744 =C5-B6 L

120333 134544 =C7-B7

112344 134837 =C8-88

130933 181745 =(3-B9

160432 140778 =C10-810
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Figure 31-12: The underlying formulas are shown in the bottom window.

CiM Ex. 1054 Page 48



Pasting a List of Names

If the worksheet uses named ranges, create a list of the names and their references.
Move the cell pointer to an empty area of the worksheet and choose Insert+ Name-
Paste. Excel responds with its Paste Name dialog box. Click on the Paste List button
to paste a list of the names and their references into the workbook. Figure 31-13
shows an example.

1101233 98744 (2489
120933 134,544 13611

112344 134887 22543
120933 151745 20812
150932 140778 (10.154)
616375 BB0B3E 44 323

werage Commission Rate: 593%

nnusHate =Sheet1158%3

~ammissionRate =Shest11GB51
=3heet!/5B$6: 58811
=3heet!!50$2
=Sheet1$CHE 50511
=Sheet11$BF11 5GF11

ik, Sheet! AR T A e
Figure 31-13: Pasting a list of names (in A15:B20) can some-
times help you understand how a worksheet is constructed.

Summary

In this chapter, [ discuss tools that can help you make your worksheets error-free.

I identify the types of errors that you're likely to encounter. | also cover three tools
that Excel provides, which can help you trace the relationships between cells: the
Info window, the Go To Special dialog box, and Excel's interactive auditing tools. [ go
over text-related features, including spell checking, AutoCorrect, and AutoComplete.
I conclude the chapter with general tips that can help you understand how an unfa-
miliar worksheet is put together.

" SESSENRAIRE  SEEENSISNRS
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Fun Stuff

A Ithough Excel is used primarily for serious applications,
many users discover that this product has a lighter
side. This chapter is devoted to the less-serious applications
of Excel, including games and interesting diversions.

Games

Excel certainly wasn’t designed as a platform for games.
Nevertheless, 've developed a few games using Excel and
have downloaded several others from various Internet sites.
I've found that the key ingredient in developing these games is
creativity. In almost every case, [ had to invent one or more
workarounds to compensate for Excel’s lack of game-making
features. In this section, [ show vou a few of my own creations.

The examples in this chapter are either available on the com-
panion CD-ROM or included with the registered version of my
Power Utility Pak (see the coupon at the back of the book).

Tick-Tack-Toe

Although Tick-Tack-Toe is not the most mentally stimulating
game, everyone knows how to play it. Figure 32-1 shows the
Tick-Tack-Toe game that | developed using Excel. In this
implementation, the user plays against the computer. | wrote
some formulas and VBA macros to determine the computer’s
moves, and it plays a reasonably good game — about on par
with a three-yvear-old child. 'm embarrassed to admit that
the program has even beaten me a few times (OK, so [ was
distracted!).

This workbook is available on the companion CD-ROM.

You can choose who makes the first move (you or the com-
puter) and which marker vou want to use (X or O). The winning
games and ties are tallied in cells at the bottom of the window.
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Figure 32-1: My Tick-Tack-Toe game.

Moving Tile Puzzle

At some time in your life, you've probably played one of those moving tile puzzles.
They come in several variations, but the goal is always the same: rearrange the tiles
so that they are in order.

This workbook is available on the companion CD-ROM.

Figure 32-2 shows a version of this game that [ wrote using VBA. This version lets
you choose the number of tiles (from a simple 3x3 matrix up to a challenging 6x6
matrix).

When you click the tile, it appears to move to the empty position. Actually, no
movement is taking place. The program is simply changing the text on the buttons
and making the button in the empty position invisible.

Figure 32-2: My Moving Tile puzzle.
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Keno

If you've ever spent any time in a casino, you may be familiar with Keno (see
Figure 32-3). If you're smart, you probably know to avoid this game like the plague,
because it has the lowest return of any casino game. With my Keno for Excel, you
don’t have to worry about losing any money: all the action takes place on a
worksheet, and no money changes hands. And, it’s a lot faster than the casino
version.

This workbook is available on the companion CD-ROM. In addition, I've included
. another workbook that calculates the various odds associated with Keno. Take a look
at this workbook and you may never play casino Keno again!

Figure 32-3: Keno for Excel.

Power Utility Pak Games

The four games listed in this section are included with my Power Utility Pak. Use
the coupon in the back of the book to order your copy at a huge discount.

Video Poker

Developing my Video Poker game for Excel (see Figure 32-4) was quite a challenge.
[ was forced to spend many hours performing research at a local casino to perfect
this game so that it captures the excitement of a real poker machine. The only
problem is that [ haven’t figured out a way to dispense the winnings. Oh well,
maybe in the next version.
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Figure 32-4: My Video Poker game.

This version has two games: Joker’s Wild (a joker can be used for any card) and
Jacks or Better (a pair of jacks or better is required to win). You select which cards
to discard by clicking the card face. You can change the game (or the bet) at any
time while playing. You can also request a graph that shows your cumulative
winnings (or, more typically, your cumulative losses).

[dentifying the various poker hands is done using VBA procedures. The game also
has a Hide button that temporarily hides the game (pressing Esc has the same
effect). You can then resume the game when your boss leaves the room.

This game is included with the registered version of the Power Utility Pak. See the
coupon in the back of the book for details on how to get your copy.

Dice Game

The goal of the Dice Game (shown in Figure 32-5) is to obtain a high score by
assigning dice rolls to various categories. You get to roll the dice three times on
each turn, and you can keep or discard the dice before rolling again. Everything is
done using VBA.

This game is included with the registered version of the Power Utility Pak. See the
coupon in the back of the book for details on how to get your copy.

Bomb Hunt

Windows comes with a game called Minesweeper. [ developed a version of this
game for Excel and named it Bomb Hunt (see Figure 32-6). The goal is to discover
the hidden bombs in the grid. Double-clicking a cell reveals a bomb (you lose) or a
number that indicates the number of bombs in the surrounding cells. You use logic
to determine where the bombs are located.

This game is included with the registered version of the Power Utility Pak. See the
coupon in the back of the book for details on how to get your copy.
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Figure 32-6: My Bomb Hunt game.

Hangman

Hangman is another game that almost everyone has played. Figure 32-7 shows a
version that [ developed for Excel. The objective is to identify a word by guessing
letters. Correctly guessed letters appear in their proper position. Every incorrectly
guessed letter adds a new body part to the person being hanged (to reduce gratu-
itous violence, | substituted a skeleton for the hanged gentleman). Ten incorrect
guesses and the skeleton is completed —that is, the game is over.
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Figure 32-7: My Hangman game.

The workbook includes 1,400 words, ranging in length from 6 to 12 letters. You can
either choose how many letters you want in the word or have the number of letters
determined randomly. The entire game takes place in a dialog box.

Animated Shapes

With a bit of imagination (and lots of help from VBA), you can create some simple
animations in a workbook. I've put together a few examples to demonstrate how it’s
done. Figure 32-8 shows an example (use your imagination — it really is animated).

i Demod

Figure 32-8: Animated Shapes.
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This workbook is available on the companion CD-ROM.

Symmetrical Pattern Drawing

[ must admit, this program is rather addictive —especially for doodlers. It lets you
create colorful symmetrical patterns by using the arrow keys on the keyboard.
Figure 32-9 shows an example. As you draw, the drawing is reproduced as mirror
images in the other three quadrants. When you move the cursor to the edge of the
drawing area, it wraps around and appears on the other side. This workbook is
great for passing the time on the telephone when you're put on hold.

The drawing is all done with VBA macros. [ used the OnKey method to trap the
following key presses: left, right, up, and down. Each of these keystrokes executes a
macro that shades a cell. The cells in the drawing area are very tiny, so the shading
appears as lines.

This workbook is available on the companion CD-ROM
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Figure 32-9: My Symmetrical Pattern Drawing worksheet.
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For Guitar Players

If you play guitar, check out this workbook. As you see in Figure 32-10, this work-
book has a graphic depiction of a guitar’s fret board. It displays the notes (and fret
positions) of the selected scale or mode in any key. You can even change the tuning
of the guitar, and the formulas automatically recalculate.

This workbook is available on the companion CD-ROM.

Figure 32-10: My guitar fret board application.

Other options include the choice to display hali-notes as sharps or flats, to pop
up information about the selected scale or mode, and to change the color of the
guitar neck. This workbook uses formulas to do the calculation, and VBA plays
only a minor role. This file was designated a “top pick” on America Online, and
I've received positive feedback from fellow pickers all over the world.

An April Fool's Prank

Here's a good April Fool’s trick to play on an office mate (with luck, one with a sense
of humor). When he or she is out of the office, load this workbook and click the
button to reverse the menus. For example, the Insert* Name+ Define command
becomes the Tresni* Eman+ Enifed command. Excel’s menus look like they’re in a
strange language. Figure 32-11 shows how this looks.

This workbook is available on the companion CD-ROM.
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Figure 32-11: Excel with backward menus. The hot keys remain the same.

The routine performs its mischief by calling a custom function that reverses the
text in the captions (except for the ellipses), converts the new text to proper case,
and maintains the original hot keys. The net effect is a worksheet menu system
that works exactly like the original (and is even keystroke-compatible) but laoks
very odd.

Clicking the Reset menu button returns the menus to normal.

Creating Word Search Puzzles

Most daily newspapers feature a word search puzzle. These puzzles contain words
that are hidden in a grid. The words can be vertical, diagonal, horizontal, forwards,
or backwards. If you've ever had the urge to create your own word search puzzle,
this workbook can make your job a lot easier by doing it for you. You supply the
words; the program places them in the grid and fills in the empty squares with
randomn letters. Figure 32-12 shows the puzzle creation sheet plus a sample puzzle
that was created with this application.

This is all done with VBA, and randomness plays a major role. Therefore, you can
create multiple puzzles using the same words.

This workbook is available on the companion CD-ROM.
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Figure 32-12: My Word Search Puzzle Maker.

ASCII Art

ASCII art consists of pictures made up of simnple ASCII characters. The Internet is
filled with thousands of examples of ASCIH art. [ created a workbook with a few
examples that | picked up from the public domain. Figure 32-13 shows an example.

This workbook is available on the companion CD-ROM.

For the image to look correct, you must view ASCII art using a fixed-width font, such
as Courier New.

Sound File Player

Excel doesn’t have to be quiet. I created a simple macro that lets you play any WAV
or MIDI file on your system.

This workbook is available on the companion CD-ROM.
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Figure 32-13: An example of ASCli art.

Fun with Charts

Excel’s charting feature has the potential to be fun. In this section, | provide
examples of some nonserious charting applications.

Plotting Trigonometric Functions

Although [ don’t know too much about trigonometry, I've always enjoyed plotting
various trigonometric functions as XY charts. Sometimes you can come up with
attractive images. Figure 32-14 shows an example of a trigonometric plot. Clicking
the button changes a random number that makes a new chart.

This workbook is available on the companion CD-ROM.
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Figure 32-14: This chart plots trigonometric functions.

XY-Sketch

In this workbook, you use the controls to draw an XY chart (see Figure 32-15).
Clicking a directional button adds a new X and Y value to the chart’s data range,
which is then plotted on the chart. You can change the step size, adjust the color,
and choose between smooth and normal lines. [ include a multilevel Undo button
that successively removes data points that you added.

This workbook is available on the companion CD-ROM.
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Figure 32-15: My XY-Skstch workbook.

Summary

In this chapter, [ present several examples of nonserious applications for Excel.
Some of these examples can most likely be adapted and used in more serious
applications (well, maybe not).

*  HEPEREILIRE  FREINESPOSN
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Customizing
Excel
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Customizing
Toolbars and
Menus

You’re probably familiar with many of Excel’s built-in tool-
bars, and you have most likely thoroughly explored the
menu system. Excel lets you modify both toolbars and menus.
This chapter explains how to customize the built-in toolbars,
create new toolbars, and change the menus that Excel dis-
plays. Although many of these customizations are most useful
when vou create macros (discussed in subsequent chapters),
even nonmacro users may find these techniques helpful.

Menu Bar = Toolbar

Beginning with Excel 97, virtually no distinction exists between
a menu bar and a toolbar. In fact, the menu bar that you see at
the top of Excel’s window is actually a toolbar that is named
Worksheet Menu Bar. As with any toalbar, you can move it to a
new location by dragging it (see Figure 33-1).

Manyv of the menu items display icons in addition to text — a
good sign that Excel’s menus are not “real” menus. To further
demonstrate that Excel’s menu bars are different from those
used in other programs, note that if you change the colors or
fonts used for menus (using the Windows Control panel),
these changes do not appear in Excel’s menus.
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Figure 33-1: Excel's menu bar is actually a toolbar, and you can move it to any
location that you want.

Customizing Toolbars

The official term for toolbars, menu bars, and shortcut menus is a CormmandBar.
All told, Excel comes with nearly 100 built-in CommandBars, made up of the
following:

*» Two menu bars (one for worksheets and one for chart sheets)

+ 40 traditional style toolbars

» 51 shorteut menus (the menus that appear when you right-click a selection)
Each CommandBar consists of one or more “commands.” A command can take the

form of an icon, text, or both. Some additional commands don’t appear on any of
the prebuilt teolbars.

Many users like to create custom toolbars that contain the commands that they use
most often.
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Types of Customizations

The following list is a summary of the types of customizations that you can make
when working with toolbars (which also include menu bars):

Move toolbars. Any toolbar can be moved to another location .

Remove buttons from built-in toolbars. You may want to do this to eliminate
buttons that you never use.

Add buttons to built-in toolbars. You can add as many buttons as you want to
any toolbar.

Create new toolbars. You can create as many new toolbars as you like, with
as many buttons as you like.

Change the functionality of a button. You make such a change by attaching
your own macro to a built-in toolbar button.

Change the image that appears on any toolbar button. A rudimentary but
functional toolbar-button editor is included with Excel.

Shortcut Menus

The casual user cannot modify Excel’s shortcut menus (the menus that appear
when you right-click an object). Doing so requires the use of VBA macros.

Moving Toolbars

A toolbar can be either floating or docked. A docked toolbar is fixed in place at the
top, bottom, left, or right edge of Excel’s workspace. Floating toolbars appear in an
*always-on-top” window, and you can drag them wherever you like.
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To move a toolbar, just click its border and drag it to its new position. If you drag it to
one of the edges of Excel’s window, it attaches itself to the edge and becomes docked.
You can create several layers of docked toolbars. For example, the Standard and
Formatting toolbars are (normally) both docked along the upper edge.

If a toolbar is floating, you can change its dimensions by dragging a border. For
example, you can transform a horizontal toolbar to a vertical toolbar by dragging
one of its corners.

Using the Customize Dialog Box

To make any changes to toolbars, you need to be in “customization mode.” In cus-
tomization mode, the Customize dialog box is displayed, and you can manipulate
the toolbars in a number of ways. To get into customization mode, perform either
of the following actions:

+ Select View* Toolbars+ Customize
» Select Customize from the shortcut menu that appears when you right-click a

toolbar

Either of these methods displays the Customize dialog box that is shown in Figure
33-2. This dialog box lists all the available toolbars, including custom toolbars that
you have created.

Forraatting
3D Settings

ontrol Toalbox
Exit Design Mode
Extsrnal Data
Forms
Full Scresn
Pichure

Figure 33-2: The Customize dialog box.

The Customize dialog box has three tabs, each of which is described in the
following sections.
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The Toolbars Tab

Figure 33-2 shows the Toolbars tab of the Customize dialog box. The following
sections describe how to perform various procedures that involve toolbars.

Operations that you perform by using the Customize dialog box cannot be
undone,

Hiding or displaying a toolbar

The Toolbars tab displays every toolbar (built-in toolbars and custom toolbars).
Add a check mark to display a toolbar; remove the check mark to hide it. The
changes take effect immediately.

Creating a new toolbar

Click the New button and then enter a name in the New Toolbar dialog box. Excel
creates and displays an empty toolbar. You can then add buttons to the new toolbar.
See “Adding or Removing Toolbar Buttons” later in this chapter.

Renaming a custom toolbar

Select a custom toalbar from the list and click the Rename button. Enter a new
name in the Rename Toolbar dialog box. You cannot rename a built-in toolbar.

Deleting a custom toolbar

Select a custom toolbar from the list and click the Delete button. You cannot delete
a built-in toolbar.

Resetting a built-in toolbar

Select a built-in toolbar from the list and click the Reset button. The toolbar is
restored to its default state. If you've added any custom tools to the toolbar, they
are removed. If you've removed any of the default tools, they are restored.

The Reset button is not available when a custom toolbar is selected.

Attaching a toolbar to a workboak

If yvou create a custom toolbar that you want to share with someone else, you can
“attach” it to a workbook. To attach a custom toolbar to a workbook, click the
Attach button, which presents the Attach Toolbars dialog box. Select the toolbars
that you want to attach to a workbook (see Figure 33-3). You can attach any number
of toolbars to a workbook.

A toolbar that’s attached to a workbook appears automatically when the workbook
is opened, unless the workspace already has a toolbar by the same name.
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Custom Formatting

{|Budget Tools

Figure 33-3: You can attach custom toolbars to a
wotkbook in the Attach Toolbars menu.

The toolbar that’s stored in the workbook is an exact copy of the toolbar at the
time that you attach it. If you modify the toolbar after attaching it, the changed
version is not stored in the workbook automatically. You must manually remove
the old toolbar and then add the edited toolbar.

The Commands Tab

The Commands tab of the Customize dialog box contains a list of every tool that’s
available. Use this tab when you customize a toolbar. This feature is described later
in the chapter (see “Adding or Removing Toolbar Buttons™).

The Options Tab

The Options tab of the Customize dialog box, shown in Figure 33-4, gives you
several choices of ways to customize vour menus, toolbars, icons, and the like.
The following list explains these options.

« Personalized Menus and Toolbars: On the Options tab, the new options of
Excel 2000 are Personalized Menus and Toolbars and, in the Other area, List
font names in their font.

¢ These options provide you with some control over how the menus and
toolbars work. Set these options according to vour personal preferences.

« Large icons: To change the size of the icons used in toolbars, select or
deselect the Large icons check box. This option only affects the images that
are in buttons. Buttons that contain only text (such as buttons in a menu)
don’t change.

» List font names in their font: This new feature displays the font names using
the actual font. The advantage is that you can preview the font before you
select it. The disadvantage is that it’s a bit slower.
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« Show ScreenTips on toolbar: ScreenTips are the pop-up messages that display
the button names when you pause the mouse pointer over a button. If you find
the ScreenTips distracting, remove the check mark from the Show ScreenTips
on toolbars check box. The status bar still displays a description of the button
when you move the mouse pointer over it.

*» Menu animations: When you select a menu, Excel animates the display of
the menu as it is dropping down. You can select the type of animation that
you want:

¢ Slide: The menu drops down with a sliding motion
* Unfold: The menu unfolds as it drops down

¢ Random: The menu either slides or unfolds randomly

Figure 33-4: The Options tab of the
Customize dialog box.
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Adding or Removing Toolbar Buttons

As noted earlier in this chapter, you can put Excel into customization mode by
displaying the Customize dialog box. When Excel is in customization mode, vou
have access to all the commands and options in the Customize dialog box. In
addition, you can perform the following actions:

+ Reposition a button on a toolbar
» Move a button to a different toolbar
* Copy a button from one toolbar to another

« Add new buttons to a toolbar by using the Commands tab of the Customize
dialog box

Moving and Copying Buttons

When the Customize dialog box is displayed, you can copy and move buttons freely
among any visible toolbars. To move a button, drag it to its new location (the new
location can be within the current toolbar or on a different toolbar).

To copy a button, press Ctrl while you drag the button to another toolbar. You can
also copy a toolbar button within the same toolbar, but no reason really exists to
have multiple capies of a button the same toolbar.

Inserting a New Button

To add a new button to a toolbar, you use the Commands tab of the Customize
dialog box (see Figure 33-5).

Figure 33-5: The Commands tab contains a
list of every available button.
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The buttons are arranged in 16 categories. When you select a category, the buttons in
that category appear to the right in the Commands list box. To determine a button’s
function, select it and click the Description button.

To add a button to a toolbar, locate it in the Commands tab and then click and drag
it to the toolbar.
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Other Toolbar Button Operations

When Excel is in customization mode (that is, the Customize dialog box is displayed),
you can right-click a toolbar button to get a shortcut menu of additional actions for
the tool. Figure 33-6 shows the shorteut menu that appears when you right-click a
button in customization mode.

Figure 33-6: In customization maode,
right-clicking a button displays this
shortcut menu.

These commands are described in the following list (note that some of these
commands are not available for certain toolbar tools):

* Resel: Resets the tool to its original state.

» Delete: Deletes the tool.

» Name: Lets you change the name of the tool.

« Copy Button Image: Makes a copy of the button’s image and places it on the
Clipboard.

» Paste Button Image: Pastes the image from the Clipboard to the button.
» Reset Button Image: Restores the button’s original image.

« Edit Button Image: Lets you edit the button’s image, using Excel’s button
editor.

« Change Button Image: Lets you change the image by selecting from a list of
42 button images.

» Default Style: Displays the tool with its default style (either text only or image
and text).

CiM Ex. 1054 Page 76



« Text Only (Always): Always displays text (no image) for the tool.

» Text Only (In Menus): Displays text (no image) if the tool is in a menu bar.
» Image and Text: Displays the tool’s image and text.

* Begin a Group: Inserts a divider in the toolbar. In a drop-down menu, a
separator bar appears as a horizontal line between commands. In a toolbar,
a separator bar appears as a vertical line.

= Assign Hyperlink: Lets you assign a hyperlink that will activate a Web page.
+ Assign Macro: Lets you assign a macro that is executed when the button is
clicked.

Assign Hyperlink is a new feature of Excel 2000.

Creating a Custom Toolbar: An Example

This section walks you through the steps that are used to create a custom toolbar.
This toolbar is an enhanced Formatting toolbar that contains many additional
formatting tools that aren’t found on Excel’s built-in Formatting toolbar. You may
want to replace the built-in Formatting toolbar with this new custom toolbar.

If you don't want to create this toolbar yourself, this workbook is available on this
book’s CD-ROM.

Adding the First Button

The following steps are required to create this new toolbar and add one button
(which has five subcommands):
1. Right-click any toolbar and select Customize from the shortcut menu.
Excel displays its Customize dialog box.
2. Click the Toolbars tab and then click New.
Excel displays its New Toolbar dialog box.
3. Enter a name for the toolbar: Custom Formatting. Click OK.
Excel creates a new (empty) toolbar.
4. In the Customize dialog box, click the Commands tab.
5. In the Categories list, scroll down and select New Menu.

The New Menu category has only one command (New Menu), which appears
in the Commands list.

6. Drag the New Menu command from the Commands list to the new toolbar.

This creates a menu button in the new toolbar.
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7. Right-click the New Menu button in the new toolbar and change the name
to Font.

8. In the Customize dialog box, select Format from the Categories list.

9. Scroll down through the Commands list and drag the Bold command to the
Font button in your new toolbar.

This step makes the Font button display a submenu (Bold) when the button
is clicked.

10. Repeat Step 9, adding the following buttons from the Format category: Italic,
Underline, Font Size, and Font.

At this point, you may want to click the Close button in the Customize dialog box to
try out your new toolbar. The new toolbar contains only one button, but this button
expands to show five font-related commands. Figure 33-7 shows the Custom
Formatting toolbar at this stage.

Figure 33-7: A new Custom Formatting toolbar
after adding a menu button with five commands.
In this example, Underline is selected.

Adding More Buttons

If vou followed the steps in the previous section, you should understand how toolbar
customization works, and you can now add additional buttons by following the
procedures that you learned. To finish the toolbar, right-click a toolbar button and
select Customize. Then, add additional toaols.

Figure 33-8 shows the final version of the Custom Formatting toolbar, and Table 33-1
describes the tools on this toolbar. This customized toolbar includes all the tools
that are on the built-in Formatting toolbar — plus quite a few more (38 tools in all).
But, because the Custom Formatting toolbar uses five menus (which expand to
show more commands), the toolbar takes up a relatively small amount of space.

You can, of course, customize the toolbar any way that you like. The tools that are
listed in the table are my preferences. You may prefer to omit tools that you never
use — or add other tools that vou use frequently.

With two exceptions, all the tools are found in the Formatting category. The Clear

Formatting tool is in the Edit category, and the Format Cells tool is in the Built-In
Menus category.
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Figure 33-8: The final version of the Custom
Formatting toolbar.

Tool Subcommands

New Menu (renamed Align) Align Left, Center, Align Right, Decrease Indent,
Increase Indent, Merge and Center, Merge Cells,
Unmerge Cells, Merge Across

New Menu (renamed Border) Clear Border, Apply Qutline Borders, Apply Inside
Border, Left Border, Right Border, Top Border, Bottom
Border, Inside Vertical Border, Inside Horizontal Border,
Bottom Double Border

New Menu (renamed Number) Currency Style, Percent Style, Comma Style, Decrease
Decimal, Increase Decimal

Saving the Custom Toolbar

Excel doesn’t have a command to save a toolbar. Rather, the new toolbar is saved
when you exit Excel. Refer to the sidebar “How Excel Keeps Track of Toolbars,”
earlier in this chapter.
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You need to remember that if Excel shuts down by non-normal means (that is, it
crashes!), your custom toolbar will be lost. Therefore, if you invest a lot of time cre-
ating a new toolbar, you should close Excel to force the new toolbar to be saved.

Changing a Toolbar Button’s Image

To change the image that is displayed on a toolbar button, you have several
options:

» Choose 1 of the 42 images that are provided by Excel
* Madify or create the image by using Excel’'s Button Editor dialog box

+ Copy an image from another toolbar button
Each of these methods is discussed in the following sections.

To make any changes to a button image, you must be in toolbar customization
mode (the Customize dialog box must be visible). Right-click any toolbar button
and select Customize from the shortcut menu.

Using a Built-in Image

To change the image on a toolbar button, right-click the button and select Change
Button Image from the shortcut menu. As you can see in Figure 33-9, this menu
expands to show 42 images from which you can choose. Just click the image that
you want, and the selected button’s image changes.

Editing a Button Image

If none of the 42 built-in images suits your tastes, vou can edit an existing image or
create a new image by using Excel’s Button Editor.

To begin editing, right-click the button that vou want to edit and then choose Edit
Button Image from the shortcut menu. The image appears in the Button Editor
dialog box (see Figure 33-10), in which you can change individual pixels and shift
the entire image up, down, to the left, or to the right. If vou've never worked with
icons before, you may be surprised at how difficult it is to create attractive images
in such a small area.

The Edit Button Image dialog box is straightforward. Just click a color and then

click a pixel (or drag across pixels). When it looks good, click OK. Or, if you don’t
like what you've done, click Cancel, and the button keeps its original image.

CiM Ex. 1054 Page 80



R St R RLALIL R SR N
Figure 33-9: The Change Button Image option gives you 42 built-in button
images to choose from.

i
Figure 33-10: The Button Editor dialog box,

in which you can design your own button
image or edit an existing one.

Copying Another Button Image

Another way to get a button image on a custom toolbar is to copy it from another
toolbar button. Right-click a toolbar button, and it displays a shortcut menu that
enables you to copy a button image to the Clipboard or paste the Clipboard
contents to the selected button.
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Activating a Web Page from a Toolbar Button

You might want to create a button that activates your Web browser and loads a
Web page.

This feature is available only in Excel 2000.

To add a new button and attach a hyperlink, make sure that you’re in taolbar
customization mode. Use the procedure previously described to add a new button
and (optionally) specify a button image. Then, right-click the button and select
Assign Hyperlink* Open. Your'll see the Assign Hyperlink: Open dialog box, shown
in Figure 33-11. Type a URL or select one from the list.

LEp ) fvaean, J

ttp v, hotbat .com!

tep e -walk, comysspup
ttp:)¥supoort miceasaft.com)

thp s msnbe, comf
tbp:fdcffice .micrasoft.comfexcelf

Figure 33-11: The Assign Hyperink: Open dialog box enables
you to assign a hyperlink to a toolbar button.

Summatry

This chapter discusses how to modify two companents of Excel’s user interface:
toolbars and menus. Users of all levels can benefit from creating custom toolbars.
To create new commands that are executed by toolbar buttons, however, you need
to write macros. This chapter also discusses how to change the image that appears
on a toolbar button, and then introduces Excel’s menu editor, which is most useful
for macro writers.

* cansssesate  SRsSEMRAERS
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Using and
Creating
Templates

I his chapter covers one of the most potentially useful
features in Excel —template files. Templates can be used
for a variety of purposes, ranging from custom “fill-in-the-
blanks” workbooks to a way to change Excel’s defaults for new
workbooks or new worksheets.

An Overview of Templates

A template is essentially a model that serves as the basis tor
something else. An Excel template is a workbook that’s used to
create other workbooks. If you understand this concept, you
may save yourself a lot of work. For example, you may always
use a particular header on yvour printouts. Consequently, every
time that you print a worksheet, you need to select File» Page
Setup to add your page header. The solution is to create a new
workbook by modifying the template that Excel uses. In this
case, you modify the template file by inserting your header
into the template. Save the template file, and then every new
workbook that you create has your customized page header.

Excel supports three types of templates:

« The default workbook template: Used as the basis for
new workboaoks.

» The default worksheet template: Used as the basis for
new warksheets that are inserted into a workbook.

» Custom workbook templates: Usually, ready-to-run
workbooks that include formulas. Typically, these
templates are set up so that a user can simply plug in
values and get immediate results. The Spreadsheet
Solutions templates (included with Excel) are examples
of this type of template.
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Each template type is discussed in the following sections.

The Default Workbook Template

Every new workbook that you create starts out with some default settings. For
example, the workbook’s worksheets have gridlines, text appears in Arial 10-point
font, values that are entered display in the General number format, and so on. If
you're not happy with any of the default workbook settings, you can change them.

Changing the Workbook Defaults

Making changes to Excel's default workbook is fairly easy to do, and it can save you
lots of time in the long run. Take the following steps to change Excel’s workbook
defaults:

1. Start with a new workbook.

2. Add or delete sheets to give the workbook the number of worksheets that you
want.

3. Make any other changes that you want to make, which can include column
widths, named styles, page setup options, and many of the settings that are
available in the Options dialog box.

To change the default formatting for cells, choose Format+ Style, and then modify
the settings for the Normal style. For example, you can change the default font,
size, ot number format. Refer to “Using Named Styles” in Chapter 11 for details.

4. When your workboaok is set up to your liking, select Files Save As.
5. In the Save As dialog box, select Template (*.xIt) from the Save as type box.
6. Enter book.xlt for the filename.

7. Save the file in your \XLStart {older. This folder is probably located within
yvour ci\Program Files\Microsoft Office\Office folder.

You can also save your book xlt ternplate file in the folder that is specified as
an alternate startup folder. You specify an alternate startup folder in the
General tab of the Options dialog box.

8. Close the file.

After you perform the preceding steps, the new default workbook is based on the
bookxlt workbook template. You can create a workbook based on your template by
using any of the following methods:

« Click the New button on the Standard toolbar

* Press Ctrl+N

» Choose File» New and then select the Workbook icon in the General tab of
the New dialog box (see Figure 34-1)
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Figure 34-1: After you create a bookxlt template, clicking the Workbook
icon creates a new workbook that is based on your template.

Normally, the Xlistart folder does not contain a file named bookuxlt. If a file with this
name is not present, Excel creates new workbaooks using built-in default settings.

Editing the book.xlt Template

After you create vour book.xlt template, you may discover that you need to change
it. You can open the book.xlt template file and edit it just like any other workbook.
After you finish with your edits, save the workbook and close it.

Resetting the Default Workbook

If you create a book.xlt file and then decide that you would rather use the standard
default workbook settings, simply delete the book.xlt template file from the Xlstart
folder. Excel then resorts to its built-in default settings for new workbooks.

The Default Worksheet Template

When you insert a new worksheet into a workbook, Excel uses its built-in worksheet
defaults for the worksheet. This includes items such as column width, row height,
and so on.

Versions of Excel prior to Excel 97 also use other sheet templates (dialog.xlt and
macro.xlt). These templates are not used in Excel 97 or later versions.
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If vou don’t like the default settings for a new worksheet, vou can change them by
using the following procedure:

1. Start with a new workbook, deleting all the sheets except one.

2, Make any changes that you want to make, which can include column widths,
named styles, page setup options, and many of the settings that are available
in the Options dialog box.

3. When your workbook is set up to your liking, select Files Save As.
4, In the Save As dialog box, select Template (*.xlt) from the Save as type box.
5. Enter sheet.xlt for the filename.

6. Save the file in yvour \XLStart folder. This folder is probably located within
your ¢:\Program Files\Microsoft Office\Office folder.

You can also save vour book.xlt template file in the folder that is specified as
an alternate startup folder. You specify an alternate startup folder in the
General tab of the Options dialog box.

7. Close the file.

After performing this procedure, all new sheets that you insert with the Insert«
Worksheet command are formatted like your sheet xlt template.

When you right-click a sheet tab and choose [nsert from the shortcut menu, Excel
displays its Insert dialog box (which looks just like the New dialog box). If yvou've
created a template named sheet.xlt, you can select it by clicking the icon labeled
Worksheet.

Editing the sheet.xlt Template

After you create your sheet.xlt template, you may discover that you need to change
it. You can open the sheet xlt template [ile and edit it just like any other workbook.
After you make your changes, save the file and close it.

Resetting the Default New Worksheet

If vou create a sheet.xlt template and then decide that you would rather use the
standard default new worksheet settings, simply delete the sheetxlt termplate file
from the Xlstart folder. Excel then resorts to its built-in default settings for new
worksheets.

Custom Workbook Templates

The bookxlt and sheet.xlt templates discussed in the previous section are two
special types of templates that determine default settings for new workbooks and
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new worksheets. This section discusses other types of templates, referred to as
workbook templates, which are simply workbooks that are set up to be used as the
basis for new workbooks.

Why use a workbook template? The simple answer is that it saves you from
repeating work. Assume that you create a monthly sales report that consists of
your company'’s sales by region, plus several summary calculations and charts. You
can create a template file that consists of everything except the input values. Then,
when it’s time to create your report, vou can open a workbook based on the
template, fill in the blanks, and you're finished.

You could, of course, just use the previous month’s workbook and save it with a
different name. This is prone to errors, however, because you easily can forget to
use the Save As command and accidentally overwrite the previous month’s file.

How Templates Work

When you create a workbook that is based on a template, Excel creates a copy of
the template in memory so that the original template remains intact. The default
workbook name is the template name with a number appended. For example, if you
create a new warkbook based on a template named Sales Reportxlt, the
workbook’s default name is Sales Reportl xls. The first time that you save a
workbook that is created from a template, Excel displays its Save As dialog box, so
that you can give the template a new name if you want to.

Templates That Are Included with Excel

Excel ships with three workbook templates (called Spreadsheet Solutions
templates), which were developed by Village Software. When yvou select File+ New,
you can select one of these templates from the New dialog box. Click the tab
labeled Spreadsheet Solutions to choose one of the following templates upon which
to base your new workbook (see Figure 34-2).

These templates are included with Excel 2000.

Expense Statement: Helps you to create expense report forms and a log to
track them

« Invoice: Helps you to create invoices
* Purchase Order: Helps you to create purchase orders to send to vendors

A fourth template, named Village Software.xlt, describes additional templates that
you can obtain from Village Software.

You can also download some additional templates from Microsoft’'s Web site:
http://www.micrasoft.com/excel.
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Figure 34-2: You can create a new workbook based on one of the
Spreadsheet Solutions templates.

Creating Custom Templates

This section describes how to create workbook templates, which is really quite
simple.

A custom template is essentially a normal workbook, and it can use any of Excel’s
features, such as charts, formulas, and macros. Usually, a template is set up so that
the user can enter values and get immediate results. In other words, most
templates include everything but the data— which is entered by the user.

If the template is going to be used by novices, you may consider locking all the cells
except the input cells (use the Protection panel of the Format Cells dialog box for
this). Then, protect the worksheet by choosing Tools+ Protection+ Protect Sheet.

To save the workbook as a template, choose Files Save As and select Template
(* xlt) from the drop-down list labeled Save as type. Save the template in your
Microsoft Office\Templates folder (or a folder within that Templates folder).

Before you save the template, you may want to specify that the file be saved with a
preview image. Select File+ Properties, and check the box that is labeled Save
Preview Picture. That way, the New dialog box displays the preview when the
template’s icon is selected.
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L4KB MS Excel Teraplats
21kB M5 Excal Teraplats
21KB IS Excel Templakz

If you later discover that you want to modify the template, choose Files Open to
open and edit the template (don’t use the File+ New command, which creates a
workbook that is based on the template).
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Ideas for Creating Templates

This section provides a few ideas that may spark your imagination for creating
templates. A partial list of the settings that you can adjust and use in your custom
templates is as follows:

Multiple formatted worksheets: You can, for example, create a workbook
template that has two worksheets: one formatted to print in landscape mode
and one formatted to print in portrait mode.

Workbook properties: You can set one or more workbook properties. For
example, Excel doesn’t store a preview picture of your workbook. Select File
Properties and then change the Save Preview Picture option in the Summary
panel.

Several settings in the View panel of the Options dialog box: For example,
yvou may not like to see sheet tabs, so vou can turn off this setting.

Color palette: Use the Color panel of the Options dialog box to create a
custom color palette for a workbook.

Style: The best approach is to choose Format+ Style and modify the
attributes of the Normal style. For example, you can change the font or size,
the alignment, and so on.

Custom number formats: If you create number formats that vou use
frequently, these can be stored in a template.

Column widths and row heights: You may prefer that columns be wider or
narrower, or you may warnt the rows to be taller.

Print settings: Change these settings in the Page Setup dialog box. You can
adjust the page orientation, paper size, margins, header and footer, and
several other attributes.

Sheet settings: These are options in the Options dialog box. They include
gridlines, automatic page break display, and row and column headers.

Summary

This chapter introduces the concept of templates. Excel supports three template
types: a default workbook template, a default worksheet template, and custom
workbook templates. This chapter describes how to create such templates and
where to store them. It also discusses the Template Wizard, a tool that helps you to
create templates that can store data in a central database.
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Using Visual
Basic for
Applications

I his chapter is an introduction to the Visual Basic for
Applications (VBA) macro language — perhaps the
key component for users who want to customize Excel. A

complete discussion of VBA would require an entire book.
This chapter teaches you how to record macros and create
simple macro subroutines. Subsequent chapters expand upon

the topics in this chapter.

Introducing VBA Macros

In its broadest sense, a macro is a sequence of instructions
that automates some aspect of Excel so that you can work

more efficiently and with fewer errors. You may create a

macro, for example, to format and print your month-end sales
report. After the macro is developed and debugged, you can

invoke the macro— with a single command —to perform
many time-consuming procedures automatically.

Macros are usually considered to be one of the advanced

features of Excel, because you must have a pretty thorough
understanding of Excel to put them to good use. The truth is
that the majority of Excel users have never created a macro

and probably never will. If you want to explore one of the

most powerful aspects of Excel, however, you should know
about macros. This chapter is designed to acquaint you with

VBA, which enables you to develop simple macros and
execute macros that are developed by others.
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VBA: One of Two Macro Languages in Excel

VBA was introduced in Excel 5. Prior to that version, Excel used an entirely
different macro system, known as XLM (that is, the Excel 4 macro language). VBA
is far superior in terms of both power and ease of use. For compatibility reasons,
however, the XLM language is still supported in Excel 2000. This means that you
can load an older Excel file and still execute the macros that are stored in it.
However, Excel 2000 does not let you record XLM macros — and you really have
no reason to do so.

What You Can Do with VBA

VBA is an extremely rich programming language with thousands of uses. The
following list contains just a few things that you can do with VBA macros:

+ Insert a text string or formula: If you need to enter your company name into
worksheets frequently, you can create a macro to do the typing for you. The
AutoCorrect feature can also do this.

« Automate a procedure that you perform frequently: For example, you may
need to prepare a month-end summary. If the task is straightforward, you can
develop a macro to do it for you.

« Automate repetitive operations: If you need to perform the same action in 12
different workbooks, you can record a macro while you perform the task
once —and then let the macro repeat vour action in the ather workbooks.

» (Create a custom command: For example, you can combine several of Excel’s
menu commands so that they are executed from a single keystroke or from a
single mouse click.

» (Create a custom toolbar button: You can customize Excel’s toolbars with
your own buttons to execute macros that you write.

= (reate a simplified “front end” for users who don’t know much about
Excel: For example, you can set up a foolproof data entry template.
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« Develop a new worksheet function: Although Excel includes a wide
assortment of built-in functions, you can create custom functions that greatly
simplify your formulas.

* Create complete, turnkey, macro-driven applications: Excel macros can
display custom dialog boxes and add new commands to the menu bar.

» Create custom add-ins for Excel: Most of the add-ins that are shipped with
Excel were created with Excel macros. [ used VBA exclusively to create my
Power Utility Pak.

Two Types of VBA Macros

Before getting into the details of creating macros, you need to understand a key
distinction. A VBA macro (or procedure) can be one of two types: a subroutine or
a function. The next two sections discuss the difference.

VBA Subroutines

You can think of a subroutine macro as a new command that can be executed by
either the user or another macro. You can have any number of subroutines in an
Excel workbook.

Figure 35-1 shows a simple VBA subroutine. When this subroutine is executed,

VBA inserts the current date into the active cell, formats it, and then adjusts the
column width.

urrentDate

Sul CurrentDate (]

' Inserts ch® curysnr date ionta tha h1 cell
AoniveCell.Value = Now (!
ActiveCell.NunberFormat = “memmen o, vyyy™

AggiveCell. Coluwmns  kutaFitc
End Sl

Figure 35-1: A simple VBA subroutine.

Subroutines always start with the keyword Sub, the macro’s name (every macro
must have a unique name), and then a pair of parentheses. (The parentheses are
required; they are empty unless the procedure uses one or more arguments.) The
End Sub statement signals the end of a subroutine. The lines in between comprise
the procedure’s code.
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The subroutine shown in Figure 35-1 also includes a comment. Comments are simply
notes to yourself, and they are ignored by VBA. A comment line begins with an
apostrophe. You can also put a comment after a statement. [n other words, when
VBA encounters an apostrophe, it ignores the rest of the text in the line.

You execute a subroutine in any of the following ways:

Choose Tools« Macro and then select the subroutine’s name from the list.
Press the subroutine’s shortcut key combination (if it has one).

If the Visual Basic Editor is active, move the cursor anywhere within the
subroutine and press F5.

Refer to the subroutine in another VBA procedure.

Subroutines are covered in detail later in this chapter.

VBA Functions

The second type of VBA procedure is a function. A function always returns a single
value (just as a worksheet function always returns a single value). A VBA function
can be executed by other VBA procedures or used in worksheet formulas, just as
you would use Excel’s built-in worksheet functions.
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Figure 35-2 shows the listing of a custom worksheet function and shows the
function in use in a worksheet. This function is named CubeRgot and requires a
single argument. CubeRoct calculates the cube root of its argument. A function
looks much like a subroutine. Notice, however, that function procedures begin
with the keyword, Function, and end with an End Function statement.

[~ Book1 - Modulel (Code]

emveral)

Funstiagn CukaRoot (num)

’ Beourng the ocdve root of & awdien
CukeRoot = mnum * (L / 3]

End Ffunction

Figure 35-2: This VBA function retumns the cube root of
its argument.

Creating VBA functions that you use in worksheet formulas can simplify your for-
mulas and enable you to perform calculations that otherwise may be impossible.
VBA functions are discussed in greater detail in Chapter 36.

Creating VBA Macros

Excel provides two ways to create macros:

» Turn on the macro recorder and record your actions

» Enter the code directly into a VBA module

The following sections describe both of these methods.

Recording VBA Macros

The basic steps that you take to record a VBA macro are described in this section.
In most cases, you can record your actions as a macro and then simply replay the
macro; you needn’t look at the code that’s generated. If this is as far as you go with
VBA, vou don’t need ta be concerned with the language itself (although a basic
understanding of how things work doesn’t do any harm).
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Recording Your Actions to Create
VBA Code: The Basics

Excel’s macro recorder translates your actions into VBA code. To start the macro
recorder, choose Tools* Macro* Record New Macro. Excel displays the Record
Macro dialog box, shown in Figure 35-3.

The Record Macro dialog box presents several options:

» Macrao name: The name of the macro. By default, Excel proposes names such
as Macrol, Macro2, and so on.

» Shortcut key: You can specify a key combination that executes the macro.
You can also press Shift when you enter a letter. For example, pressing Shift
while you enter the letter H makes the shortcut key combination Ctrl+Shift+H.

» Store macro in: The location for the macro. Your choices are the current
workbook, vour Personal Macro Workbook (described later in this chapter),
or a new workbook.

» Description: A description of the macro. By default, Excel inserts the date and
your name. You can add additional information if yvou like.

To begin recording your actions, click OK. Excel displays the Stop Recording
toolbar, which contains two buttons: Stop Recording and Relative Reference. After
you finish recording the macro, choose Tools* Macro« Stop Recording (or click
the Stop Recording button on the toolbar).

Recording your actions always results in @ new subroutine procedure. You can't
. create a function procedure by using the macro recorder. Function procedures
must be created manually.
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Recording a Macro: An Example

This example demonstrates how to record a macro that changes the formatting for
the current range selection. The macro makes the selected range use Arial 16-point
type, boldface, and the color red. To create the macro, follow these steps:

1. Enter a value or text into a cell—anything is okay. This gives you something
to start with.

2, Select the cell that contains the value or text that you entered in the
preceding step.

3. Select Tools» Macro+ Record New Macro. Excel displays the Record Macro
dialog box.

4. Enter a new name for the macro, to replace the default Macrol name. A good
name is FormattingMacro.

5. Assign this macro to the shortcut key Ctrl+Shift+F by entering F in the edit
box labeled Shortcut key.

6. Click OK. This closes the Record Macro dialog box. Excel displays a toolbar
called Stop Recording.

7. Select Format+ Cells and then click the Font tab. Choose Arial font, Bold, and
16-point type, and make the color red. Click OK to close the Format Cells
dialog box.

8. The macro is finished, so click the Stop Recording button on the Stop
Recording toolbar (or select Tools+ Macros+ Stop Recording).

Examining the Macro

The macro was recorded in a new module named Modulel. To view the code in this
module, you must activate the Visual Basic Editor (VBE). You can activate the VBE
in either of two ways:

» Press Alt+F11

*« Choose Tools* Macro+ Visual Basic Editor

Figure 35-4 shows the VBE window. Although the module is stored in the Excel
workbook, you can view the module only in the VBE window.

The Project window displays a list of all open workbooks and add-ins. This list is
displayed as a tree diagram, which can be expanded or collapsed. The code that
you recorded previously is stored in Modulel in the current workbook. When you
double-click Modulel, the code in the module is displayed in the Code window.
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Activate the module and examine the macro. It should consist of the following code:

Sub FormattingMacro Macro()

FormatCells Macro
Macro recorded by John Walkenbach

. e 4 e ow o=

Keyboard Shortcut: Ctri+Shift+f

With Selection.Font

.Name = "Arial"
JFontStyle = "Bold”
.Size = 16

.Strikethrough = False
.Superscript = False
.Subscript = False
.QutlineFont = False
.Shadow = False
JUnderline = xTUnderlineStyleNone
.ColorIndex = 3
End With
End Sub

The macro recorded is a subroutine (it begins with a Sub statement) that is named
FormattingMacro. The statements tell Excel what to do when the macro is executed.

Notice that Excel inserted some commments at the top of the subroutine. This is the
information that appeared in the Record Macro dialog box. These comment lines
{which begin with an apostrophe) aren’t really necessary, and deleting them has
no effect on how the macro runs.

You may notice that the macro recorded some actions that you didnt take. For
example, it sets the Strikethrough, Superscript, and Subscript properties
to False. This is just a byproduct of the methad that Excel uses to translate
actions into code. Excel sets the properties for every option in the Font tab of the
Format Cells dialog box, even though you didn’t change all of them.

Testing the Macro

Before you recorded this macro, you set an option that assigned the macro to the
Ctrl+Shift+F shortcut key combination. To test the macro, return to Excel by using
either of the following methods:

» Press Alt+F11
» (Click the View Microsoft Excel button on the VBE toolbar
When Excel is active, activate a worksheet (it can be in the workbook that contains

the VBA module or in any other workbook). Select a cell or range, and press
Ctrl+Shift+F. The macro immediately changes the formatting of the selected cell(s).
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Continue testing the macro with other selections. You'll find that the macro always
applies exactly the same formatting.

In the preceding example, notice that you selected the cell to be formatted before
you started recording your macro. This is important. If you select a cell while the
mactro recorder is turned on, the actual cell that you selected will be recorded into
the macro. In such a case, the macro would always format that particular cell, and
it would not be a “general-purpose” macro.

Editing the Macro

After you record a macro, you can change it (although you must know what yvou're
doing). Assume that you discover that yvou really want to make the text 14 point
rather than 16 point. You could rerecord the macro, but this is a simple modification,
so editing the code is more efficient. Just activate Modulel, locate the statement that
sets the font size, and change 16 to 14. You can also remove the following lines:

.Strikethrougn = False

.Superscript = False
.Subscript = False
.QutlineFont = Falsa
.Shadow = False

Underline = x1None

Removing these lines causes the macro to ignore the properties that are referred
to in the statements. For example, if the cell has underlining, the underlining isn’t
affected by the macro.

The edited macro appears as follows:

Sub FormattingMacro()
With Selection.Font
hame = "Arial"”

.FontStyle = "Bold"

.Size = 14
ColorIndex = 3
End With
End Sub

Test this new macro, and you see that it performs as it should. Also, notice that
it doesn’t remove a cell’s underlining, which occurred in the original version of
the macro.

Another Example

This example shows you how to record a slightly more complicated VBA macro that
converts formulas into values. Converting formulas into values is usually a two-step
process in Excel:
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1. Copy the range to the Clipboard.

2. Choose Edit* Paste Special (with the Values option selected) to paste the
values over the formulas.

This macro combines these steps into a single command.

Furthermore, you want to be able to access this command by pressing a shortcut
key combination {Ctrl+Shift+V). Take the following steps to create this macro:

1. Enter a formula into a cell. Any formula will do.

2. Select the cell that contains the formula.

3. Choose Tools* Macro+ Record New Macro. Excel displays the Record Macro
dialog box.

4, Complete the New Macro dialog box so that it looks like Figure 35-6. This
assigns the macro the name FormulaConvert. It also gives it a Ctrl+Shift+V
shortcut key.

Macro reccrded 12/25/93 by John Walkenbach

Figure 35-6: How the Record Macro
dialog box should look when
recording the sample macro.

5. Click OK to begin recording.

6. With the range still selected, choose Edit+ Copy to copy the range to the
Clipboard.

7. Select Edit+ Paste Special, click the Values option, and then click OK to close
the dialog box.

8. Press Esc to cancel Paste mode. (Excel removes the moving border around
the selected range.)

9. Click the Stop Recording button (or choose Tools» Macro+« Stop Recording).

To test the macro, activate a worksheet, enter some formulas, and then select the
formulas. You can execute the macro in two ways:

» Press Ctrl+Shift+V
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« Choose Tools+ Macro+ Macros command and double-click the macro name
(FormulaConvert)

Excel converts the formulas in the selected range to their values —in a single step
instead of two.

Be careful when you use this macro, because you can't undo the conversion of for-
mulas to values. Actually, you can edit the macra so that its results can be undone,
but the procedure is beyond the scope of this discussion.

The shortcut key combination (Ctrl+Shift+V) is valid only when the workbook is
open. When you close the workbook, pressing Ctrl+Shift+V has no effect.

The recorded macro appears as follows:

FormulaConvert Macro
Macro recorded by John Walkenbach

Keyboard Shortcut: Ctrl+Shift+V

Sub ConvertFormulas{)
Selection.Copy
Selection.PasteSpecial Paste:=x1Values, Opesration:=x1None, _
SkipBlarks:=False, Transpose:=False
Application.CutCopyMode = False
End Sub

Again, Excel added some comment lines that describe the macro. The actual
macro begins with the Sub statement. The subroutine has three statements. The
first simply copies the selected range. The second statement, which is displayed
on two lines (the underscore character means that the statement continues on
the next line), pastes the Clipboard contents to the current selection. The second
statement has several arguments, representing the options in the Paste Special
dialog box. The third statement cancels the moving border around the selected
range. (I generated the statement by pressing Esc after the paste operation.)

If you prefer, you can delete the underscore character in the second statement and
combine the two lines into one (a VBA statement can be any length). This action
may make the macro easier to read.

More About Recording VBA Macros

If yvou followed along with the preceding examples, you should have a better feel for
how to record macros. If vou find the VBA code confusing, don’t worry —you don’t
really have to be concerned with it as long as the macro that you record works
correctly. If the macro doesn’t work, rerecording the macro rather than editing the
code often is easier.
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A good way to learn about what gets recorded is to set up your screen so that you
can see the code that is being generated in the Visual Basic Editor windows. Figure
35-7 shows an example of such a setup. While you're recording your actions, make
sure that the VBE window is displaying the module in which the code is being
recorded (you may have to double-click the module name in the Project window).
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record your actions.

if you want to view the code as it's being recorded, using a high-resolution video
display really helps, such as 1024 x 768. Otherwise, you may find that fitting the
windows of both Excel and VBE onscreen is very difficult.

Absolute Versus Relative Recording

If yvou're going to work with macros, you need to understand the concept of relative
versus absolute recording. Normally, when you record a macro, Excel stores exact
references to the cells that you select (that is, it performs absolute recording). If you
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select the range B1:B10 while you’re recording a macro, for example, Excel records
this selection as

Range("B1:B10").Selact

This means exactly what it says: “Select the cells in the range B1:B10.” When you
invoke this macro, the same cells are alwavs selected, regardless of where the
active cell is located.

You may have noticed that the Stop Recording toolbar has a tool named Relative
Recording. When you click this tool while recording a macro, Excel changes its
recording mode from absolute (the default) to relative. When recording in relative
mode, selecting a range of cells is translated differently, depending on where the
active cell is located. For example, if you're recording in relative mode and cell Al
is active, selecting the range B1:B10 generates the following statement:

ActiveCell.0ffset(0, 1).Range("ALl:A10") Select

This statement can be translated as “From the active cell, move 0 rows and 1 column,
and then treat this new cell as if it were cell Al. Now select what would be AL:A10.” In
other words, a macro that is recorded in relative mode starts out by using the active
cell as its base and then stores relative references to this cell. As a result, you get
different results, depending on the location of the active cell. When you replay this
macro, the cells that are selected depend on the active cell. It selects a range that is
10 rows by 1 column, offset from the active cell by 0 rows and 1 column.

When Excel is recording in relative mode, the Relative Reference toolbar button
appears depressed. To return to absolute recording, click the Relative Reference
button again (and it displays its normal, undepressed state).

The recording mode — either absolute or relative — can make a major difference in
how your macro performs. Therefore, understanding the distinction is important.

In previous version of Excel, recording commands such as Shift+Ctrl+right-arrow
key or Shift+Ctrl+down-arrow key (commands that extend the selection to the
end of a block of cells) were not recorded correctly. The macro recorder always
recorded the exact cells that were selected. The problem is fixed in Excel 2000, so
recording these types of selection commands produces macros that work properly.

Storing Macros in the Personal Macro Workbook

Most macros that are created by users are designed for use in a specific workbook,
but you may want to use some macros in all of your work. You can store these
general-purpose macros in the Personal Macro Workbook, so that they are always
available to you. The Personal Macro Workbook is loaded whenever you start Excel.
The file, personal xls, is stored in the XlStart folder, which is in your Excel folder.
This file doesn’t exist until you record a macro, using Personal Macro Workbook as
the destination.
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The Personal Macro Workbook normally is in a hidden window (to keep it out of
the way).

To record the macro in your Personal Macro Workbook, select the Personal
Macro Workbook option in the Record Macro dialog box before you start recording.

If you store macros in the Personal Macro Workbook, vou don’t have to remember
to open the Personal Macro Workbook when you load a workbook that uses macros.

When you want to exit, Excel asks whether you want to save changes to the Personal
Macro Workbook.

Assigning a Macro to a Toolbar Button

When you record a macro, you can assign it to a shortcut key combination. After
you record the macro and test it, you may want to assign the macro to a toolbar
button. You can follow these steps to do so:

1. If the macro is a general-purpose macro that you plan to use in more than one
workbook, make sure that the macro is stored in your Personal Macro
Workbook.

2, Select View* Toolbars+» Customize. Excel displays its Customize dialog box.

3. Click the Toolbars tab in the Customize dialog box and make sure that the
toolbar is visible that is to contain the new button.

4. Click the Commands tab in the Customize dialog box.
5. Click the Macros category.
6. In the Cormmands list, drag the Custom Button icon to the toolbar.

7. Right-click the toolbar button and select Assign Macro from the shortcut
menu. Excel displays its Assign Macro dialog box.

8. Select the macro name from the list and click OK.

9. At this point, you can right-click the button again to change its name and
button image.

10. Click Close to exit the Customize dialog box.

See Chapter 33 for details about customizing toolbars.

Writing VBA Code

As demonstrated in the preceding sections, the easiest way to create a simple
macro is to record your actions. To develop more complex macros, however, vou
have to enter the VBA code manually —in other words, write a program. To save
time, you can often combine recording with manual code entry.
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Before you can begin writing VBA code, you must have a good understanding of
topics such as abjects, properties, and methods—and it doesn’t hurt to be familiar
with common programming constructs, such as looping and [ f-Then statements.

This section is an introduction to VBA programiming, which is essential if you want
to write (rather than record) VBA macros. This is not intended to be a complete
instructional guide. My book titled Excel 2000 Power Programming with VBA (IDG
Books Worldwide, Inc.) covers all aspects of VBA and advanced spreadsheet
application development.

The Basics: Entering and Editing Code

Before you can enter code, you must insert a module into the workbook. If the
workbook already has a module sheet, you can use the existing module sheet for
your new code,

Use the following steps to insert a new module:
1. Press Alt+F11 to activate the Visual Basic Editor window. The Visual Basic Editor

window is a separate application, although it works very closely with Excel.

2, The Project window displays a list of all open workbooks and add-ins. Locate
the workbook that you are currently working in, and select it (see Figure 35-8).

3. Choose Insert+ Module. VBA inserts a new (empty) module into the
workbook and displays it in the Code window.

A VBA module, which is displayed in a separate window, works like a text editor.
You can move through the sheet, select text, insert, copy, cut, paste, and so on.
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Figure 35-8: The Project window displays all open workbooks and add-ins.
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How VBA Works

VBA is by far the most complex feature in Excel, and you can easily get
overwhelmed. To set the stage for the details of VBA, here is a concise summary
of how VBA works:

+ You perform actions in VBA by writing (or recording) code in a VBA module
sheet and then executing the macro in any one of various ways. VBA modules
are stored in an Excel workbook, and a workbook can hold any number of
VBA modules. To view or edit a VBA module, you must activate the Visual
Basic Editor window (press Alt+F11 to toggle between Excel and the VBE
window).

« A VBA maodule consists of subroutine procedures. A subroutine procedure
is basically computer code that performs some action with objects. The
following is an example of a simple subroutine called ShowSum (it adds 1 + 1
and displays the result):
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Sub ShowSum()

Sum = 1 + 1

MsgBox “"The answer is " & Sum
End Sub

» A VBA module also can store function procedures. A function procedure
performs some calculations and returns a single value. A function can be
called from another VBA procedure or can even be used in a worksheet
formula. Here’s an example of a function named AddTwo (it adds two values,
which are supplied as arguments):

Furiction AddTwo(argl, arg2)
AddTwo = argl t arg?
End Function

» VBA manipulates objects. Excel provides well over 100 objects that vou can
manipulate. Examples of objects include a workbook, a worksheet, a range on
a worksheet, a chart, and a drawn rectangle.

« Objects are arranged in a hierarchy, and can act as containers for other
objects. For example, Excel itself is an object called AppTicatior, and it
contains other objects such as Workhook objects. The Workbook object can
contain other objects, such as Worksheet objects and Chart objects. A
Worksheet object can contain objects such as Range objects, PivotTable
objects, and so on. The arrangement of these objects is referred to as an
object model. Excel’s object model is depicted in the online Help system
(see Figure 35-9).

» Objects that are alike form a collection. For example, the Worksheets
collection consists of all worksheets in a particular workbook. The
CommandBars collection consists of all CommandBar objects (that is, menu
bars and toolbars). Collectians are objects in themselves.

* You refer to an object in vour VBA code by specifying its position in the object
hierarchy, using a period as a separator.

For example, you can refer to a workbook named Bookl xls as
Application.Workbooks{"Bookl")

This refers to the Bookl .xls workbook in the Workbooks collection. The
Workbooks collection is contained in the Application object (that is, Excel).
Extending this to another level, you can refer to Sheetl in Bookl as follows:

Application.Workbooks{"Bookl") . Worksheets{"Sheetl™)
You can take it to still another level and refer to a specific cell as follows:

Application.Workbooks("Bookl™) . Worksheets("Sheetl").
Range("Al"™)
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Figure 35-9: A depiction of part of Excel’s object model.

» If vou omit specific references, Excel uses the active objects, If Bookl is the
active workbook, the preceding reference can be simplified as follows:
Worksheets("Sheetl™ ), Rangae("AL")

If vou know that Sheet! is the active sheet, you can simnplify the reference
even more:
Range("Al"™)

* Objects have properties. A property can be thought of as a setting for an
object. For example, a range object has properties such as Yalue and Hame.
A chart object has properties such as HasTitle and Type. You can use VBA
both to determine object properties and to change them.
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* You refer to properties by combining the object with the property, separated
by a period. For example, you can refer to the value in cell Al on Sheetl as
follows:

Worksheets("Sheetl” ). Rarge("Al").Value

» You can assign values to variables. To assign the value in cell Al on Sheetl to
a variable called Interest, use the following VBA statement:

Inleresl = Worksheels({"Sheell"),Range("Al") Value

* Objects have methods. A method is an action that is performed with the
object. For example, one of the methods for a range object is ClearContents.
This method clears the contents of the range.

* You specify methods by combining the object with the method, separated by
a period. For example, to clear the contents of cell Al, use the following
statement:

Worksheets("Sheetl™).Range("Al:C12" ). ClearContents
» VBA also includes all the constructs of modern programming languages,
including arrays, looping, and so on.

Believe it or not, this describes VBA in a nutshell. Now you just have to learn the
details, some of which are covered in the rest of this chapter.

Objects and Collections
VBA is an object-oriented language, which means that it manipulates objects, such as
ranges, charts, drawing objects, and so on. These objects are arranged in a hierarchy.
The Application object (which is Excel) contains other objects. For example, the
Application object contains a number of objects, including the following:

» Addlns (& collection of Addin objects)

« Windows (a collecticon of Window objects)

* WorksheetFuncticn

* Workbooks (a collection of Workbook objects)
Most of these objects can contain other objects. For example, a Workbook object
can contain the following objects:

+ Charts (a collection of Chart objects)

» hames (a collection of Name objects)

= Styles (a collection of SLy1e objects)

« Windows (a collection of Window objects in the workbook)

* Worksheets (a collection of Worksheet objects)
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Each of these objects, in turn, can contain other objects. A Worksheet object, for
example, can cantain the following objects:

» ChartObjects (acollection of all ChartObjact objects)
« PageSetup
» PivotTables (acollection of all PivotTable objects)

= Kange

A collection consists of all like objects. For example, the collection of all Workbook
objects is known as the Workbooks collection. You can refer to an individual object
in a collection by using an index number, or a reference. For example, if a workbook
has three worksheets (named Sheetl, Sheet2, and Sheet3), vou can refer to the first
object in the Worksheets collection in either of these ways:

Worksheets(l)
Worksheets("Sheetl™)

Properties

The abjects that you work with have properties, which you can think of as
attributes of the objects. For example, a range object has properties such as
Column, Row, Width, and Value. A chart object has properties such as Legend,
ChartTitle, and so on. ChartTitle is also an object, with properties such as
Font, Orientation, and Text. Excel has many objects, and each has its own set of
properties. You can write VBA code to do the following:

» Examine an object’s current property setting and take some action based on it

» Change an object’s property setting

You refer to a property in your VBA code by placing a period and the property
name after the object’s name. For example, the following VBA statement sets the
Value property of a range named frequency to 15 (that is, it causes the number 15
to appear in the range’s cells):

Range (" frequency”).Value = 15

Some properties are read-only, which means that you can examine the property, but
yvou can’t change the property. For a single-cell range object, the Row and Column
properties are read-only properties: You can determine where a cell is located (in
which row and column), but you can’t change the cell’s location by changing these
properties.

A range object also has a Formula property, which is not read-only; that is, you can
insert a formula into a cell by changing its Formula property. The following statement
inserts a formula into a cell named total by changing the cell’'s Formula property:

Range("total™).Farmula = "=SUM{AL:A10)"
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Contrary to what you may think, Excel doesnt have a Ca11 object. When you want
to manipulate a single cell, you use the Range object (with only one cell in it).

You need to be aware of the AppTication object, which is actually Excel, the
program. The Application object has several useful properties:

» Application.Activelorkbook: Returns the active workbook {(a Workbook
object) in Excel.

« Application.ActiveSheet: Returns the active sheet (a Sheet object) of the
active workbook.

« Application.ActiveCell: Returns the active cell (a Range object) object of
the active window.

« Application.Selecticn: Returns the object that is currently selected in the
active window of the AppTlication object. This can be a range, a chart, a
shape, or some other selectable object.

You also should understand that properties can return objects. In fact, that’s
exactly what the preceding examples do. The result of AppTlication.Activelell,
for example, is a Range object. Therefore, you can access properties by using a
statement such as the following:

Application.ActiveCell.Font.Size = 15

In this case, Application.ActiveCell . Font is an object, and Size is a property
of the object. The preceding statement sets the Size property to 15; that is, it
causes the font in the currently selected cell to have a size of 15 points.

Because Application properties are so commonly used, you can omit the
object qualifier (App1 icat i on). For example, to get the row of the active cell, you
can use a statement such as the following:

ActiveCell.Row

Many different ways to refer to the same object may exist. Assume that you have a
workbook named Sales xls and it’s the only workbook open. Furthermore, assume
that this workbook has one worksheet, named Summary. Your VBA code can refer
to the Summary sheet in any of the following ways:

Workbooks("Sales, xT1s" ), Worksheets("Summary")
Workbooks(1l).Workshesets(l)
Workbooks(1).Sheets (1)
Application.ActiveWorkbook. ActiveSheet
ActiveWorkbook.ActiveSheet

ActiveSheet
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The method that you use is determined by how much you know about the
workspace. For example, if more than one workbook is open, the second or third
method is not reliable. If you want to work with the active sheet (whatever it may be),
either of the last three methods would work. To be absolutely sure that yvou're refer-
ring to a specific sheet on a specific workbook, the first method is vour best choice.

Methods

Objects also have nrethods. You can think of a method as an action taken with an
object. For example, range objects have a Clear method. The following VBA
statement clears the range named total, an action that is equivalent to selecting the
range and then choosing Edit+ Clear+ All:

Range("total™).Clear

In VBA code, methods look like properties, because they are connected to the
object with a “dot.” However, methods and properties are different concepts.

Variables

Like all programming languages, VBA enables you to work with variables. In VBA
(unlike in some languages), you don’t need to declare variables explicitly before
you use them in your code (although it’s definitely a good practice).

In the following example, the value in cell Al on Sheetl is assigned to a variable
named rate:

rate = Worksheets("Sheetl").Range("Al").vValue

You then can work with the variable rate in other parts of vour VBA code. Note
that the variable rale is not a named range, which means that you can’t use it as
such in a worksheet formula.

Controlling Execution

VBA uses many constructs that are found in most other programming languages.
These constructs are used to control the flow of execution. This section introduces
a few of the more common programming constructs.

The H-Then construct

One of the most important control structures in VBA is the I f-Then construct. This
common command gives your applications decision-making capability. The basic
syntax of the [ f-Then structure is as follows:

If condition Then statements [Else elsestatements]
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The following is an example (which doesn’t use the optional E1 se clause). This
subroutine checks the active cell. If it contains a negative value, the cell’s color is
changed to red. Otherwise, nothing happens.

Sub CheckCell()
If ActiveCell.Value < 0 Then ActiveCell.,Font,ColorlIndex = 3
End Sub

For-Next loops

For example, you can use a For-Hext loop to process a series of items. Its syntax is
as follows:

For counter = start To end [Step stepvall
[statements]
[Exit Forl
[statements]

Next [counter]

The following is an example of a For-Next loop:

Sub Sumiquared()

Total = 0
For Num =1 To 10
Tctal = Totel + (Num ~ 2)
NextT hum
MsgBox lotal
End Sub

This example has one statement between the For statement and the Next statement.
This single statement is executed ten times. The variable Num takes on successive
values of 1, 2, 3, and so on, up to 10. The variable Total stares the sum of Num
squared, added to the previous value of Total. The result is a value that represents
the sum of the first ten integers squared. This result is displayed in a message box.

The With-End With construct

Another construct that you encounter if you record macros is the With-End With
construct. This is a shortcut way of dealing with several properties or methods of
the same object. The following is an example:

Sub AlignCells(}

With Selection
HordzonbalAlignmenl = x1Cenler
MerticalAlignment = x1Center
MWrapText = False
.Crientation = xlHorizontal

End With

End Sub
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The following subroutine performs exactly the same operations, but doesn’t use the
With-End With construct:

Sub AlignCells(:
Selection.HorizontalAlignment = x1Center
Selection.VerticalAlignment = x1Center

5 on.WrapText = False

ccLion.Orientalion = xTHorizonlal

End Sub

The Select Case construct

The Select Case construct is useful for choosing among two or more options. The
syntax for the Select Case structure is as follows:

Select Case testexpression
[Case expressionlist-n
[slalemenls-n]]
[Case Else
[elsestatements]]
End Select

The following example demonstrates the use of a Select Case construct. In this
example, the active cell is checked. If its value is less than 0, it’s colored red. if it’s
equal to 0, it’s colored blue. If the value is greater than 0, it’s colored black.

Sub CheckCell ()
Select Case ActiveCell.Value
Case Is < 0
ActiveCell . Font.ColorIndex
Case 0
ActiveCell Font.Colorindex
Case Is > 0
ActiveCell.Font.ColorIndex
End Select
End Sub
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Any number of statements can go below each Case statement, and they all get
executed if the case is true. If you use only one statement, as in the preceding
example, you may want to put the statement on the same line as the Case
statement.

A Macro That Can't Be Recorded

The following is a VBA miacro that can’t be recorded, because it uses an [ - I'hen
structure. This macro enables you to identify quickly cells that exceed a certain
value. When you run this macro, it prompts the user for a value and then evaluates
every cell in the selection. If the cell’s value is greater than the value that is entered
by the user, the macro makes the cell bold and red.
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Sub SelectiveFormat()
"I'his procedure selectively shades cells greater than
'‘a specified target value
*Gal target value from user
Message = "Change attributes of values greater than or

equal_to. ..
Target = InputBox{(Message]
larget=Val{larget)
'Evaluate each cell in the selection
For Each ltem In Selection
If [sNumeric{ltem) Then
If Ttem.Value >= Target Then
With [tem
.Font.Bold = True
.fFont.ColorIndex = 3 'Red
End With
End If
End If
Next [tem
End Sub

Although this macro may look complicated, it’s fairly simple when you break
it down.

First, the macro assigns text to a variable named Message. It then uses the
InputBox function to solicit a value from the user. The InputBox function has a
single argument (which is the Message variable), and returns a string— which is
assigned to the Target variable. Next, the Val function is used to convert this
string to a value.

The For-Next loop checks every cell in the selected range. The first statement
within the loop uses the IsNumeric function to determine whether the cell can be
evaluated as a number. This is important, because a cell without a value would
generate an error when the Value property is accessed in the next statement. If the
cell is numeric, it is checked against the target value. If it’s greater than or equal to
the target value, the Bold and ColorIndex properties are changed. Otherwise,
nothing happens and the loop is incremented.

After entering this macro, named SelectiveFormat, into a module sheet, you can
provide a shortcut key to access it. Choose Tools+ Macro* Macros to display the
Macros dialog box. Select the macro from the list, and click Options. Excel displays
a new dialog box (see Figure 35-10) that enables you to specify a shortcut key
combination to execute the macro.
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Figure 35-10: You can execute
this macro by pressing Ctrl+S.

pples selective Farmatting

Figure 35-11 shows the macro in action. Note that you must select the range before
you execute the macro.

e R sheet

Figure 35-11: The macro uses the InputBox function to prompt the user for
a value.

As macros go, this example is not very good. It’s not very [lexible and doesn’t
include any error handling. For example, if a nonrange object (such as a graphic
object) is selected, the macro halts and displays an error message. To avoid this
errar message and abort the macro if anything except a range is selected, you can
insert the following statement as the first statement in the procedure (directly
below the Sub statement):

If TypeName(Selection} <> "Range” Then Exit Sub

This causes the macro to halt if the selection is not a Range object.
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Notice also that the macro is executed even if you click Cancel in the input box.
To avoid this problem, enter the following statement directly above the
Target=Val{Target) statement:

If Target = "" then Exit Sub
This aborts the subroutine if Target is empty.

A much more versatile version of this utility is part of the Power Utility Pak (see
Figure 35-12). The shareware version is available from this book’s Web site.
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Figure 35-12: The Select By Value utility in
the Power Utility Pak is a more versatile
version of this macro.

Learning More

This chapter barely scratches the surface of what you can do with VBA. If this is
your first exposure to VBA, vou're probably a bit overwhelmed by objects,

properties, and methods. [ don’t blame you. If you try to access a property that an
object doesn’t have, you get a run-time error, and your VBA code grinds to a
screeching halt until you correct the problem. Fortunately, several good ways are
available to learn about objects, properties, and methods.

Read the Rest of the Book

This book has three more chapters that are devoted to VBA. Chapter 36 covers VBA

functions, Chapter 37 describes custom dialog hoxes, and Chapter 38 consists of
usetul (and informative) VBA examples.

Record Your Actions

The best way — without question —to become familiar with VBA is to turn on the

macro recorder and record actions that you make in Excel. This learning technique
is even better if the VBA module in which the code is being recorded is visible while

you're recording.
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Use the Online Help System

The main source of detailed information about Excel’s objects, methods, and
procedures is the online Help system. Help is very thorough and easy to access.
When you’re in a VBA module, just move the cursor to a property or method and
press F1. You get help that describes the word that is under the cursor.

Buy Another Book

Okay, I promise. This is the last plug for my other book, Excel 2000 Power
Programming With VBA. I've received feedback from hundreds of previous-edition
readers who claim that it's the best Excel/VBA book available. You be the judge.

Summary

This chapter introduces VBA, one of two macro languages included with Excel. If
you want to learn macro programming, VBA is the language to use. In this chapter,
you learn that a VBA module can contain subroutine procedures and function
procedures, and that VBA is based on objects, properties, and methods. You also
learn how to use the macro recorder to translate your actions into VBA code and
write simple code directly in a VBA module. Three other chapters in this book
provide additional information about VBA.

* SESE0NSISS 558000008
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Creating Custom
Worksheet
Functions

As mentioned in the preceding chapter, you can create
two types of VBA procedures: subroutines and
functions. This chapter focuses on function procedures.

Overview of VBA Functions

Function procedures that you write in VBA are quite versatile.
You can use these functions in two situations:

» As part of an expression in a different VBA procedure

* On formulas that you create in a worksheet

In fact, you can use a function procedure anywhere that you
can use an Excel worksheet function or a VBA built-in
function. Custom functions also appear in the Paste Function
dialog box, so they appear to be part of Excel.

Excel contains hundreds of predefined worksheet functions.
With so many from which to choose, you may be curious as to
why anyone would need to develop additional functions. The
main reason is that creating a custom function can greatly sim-
plify your formulas by making them shorter —and shorter for-
mulas are more readable and easier to work with. For exam-
ple, you can often replace a complex formula with a single
function. Another reason is that you can write functions to
perform operations that would otherwise be impossible.

This chapter assumes that you are familiar with entering
and editing VBA code in the Visual Basic Editor (VBE). Refer
to Chapter 35 for an overview of the VBE.
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An Introductory Example

The process of creating custom functions is relatively easy, once you understand
VBA. Without further ado, here’s an example of a VBA function procedure. This
function is stored in a VBA module, which is accessible from the VBE.

A Custom Function

This example function, named NumSi gn, uses one argument. The function returns
a text string of Positive if its argument is greater than zero, Negative if the argu-
ment is less than zero, and Zero if the argument is equal to zero. The function is
shown in Figure 36-1.

odulel (Code]

BookZ - M

Funcrhion Num3ign{InVal)
Select Case InVal
Cage I < 0: NumSign "Hegative™
Caseae NumSign "Zero®
Ca ¢ » O NwnSign "Pogitive™
Tiad Balaot
End Funcetion

Figure 36-1: A custom function.

You could, of course, accomplish the same effect with the following worksheet
formula, which uses a nested 1F function:

=[F{ALl=0,"Zero™ ,IF(AL>0,"Positive™, "Negative™))

Many would agree that the custom function solution is easier to understand and to
edit than the worksheet formula.

Using the Function in a Worksheet

When you enter a formula that uses the NumSign function, Excel executes the func-
tion to get the result (see Figure 36-2). This custom function works just like any
built-in worksheet function. You can insert it in a formula by using the Insert-
Function command, which displays the Paste Function dialog box (custom func-
tions are located in the User Defined category). You also can nest custom functions
and combine them with other elements in your formulas.
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Fositive
233 | Fositive
-223| Megative
0iZero
332 |Pasitive
-323 | Neqative
~S98|Fositve |

Figure 36-2: Using a custom function in a worksheet
formula.

Using the Function in a VBA Subroutine

The following VBA subroutine procedure, which is defined in the same module as
the custom NumS1ign function, uses the built-in MsgBox function to display the
result of the NumSign function:

Sub ShowSign()
CellValue = ActiveCell.Value
MsgBox NumSign{(CellValue)
End Sub

In this example, the variable Cel1Value contains the value in the active cell (this
variable could contain any value, not necessarily obtained from a cell). Cel1Value
is then passed to the function as its argument. Figure 36-3 shows the result of
executing the NumSi gn subroutine.
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Fositive
Pasitive
-323 ! Menative
0iZero
Pasitive
3! Negative
Fositive |

Figure 36-3: Using a custom function in a VBA subroutine.

Analyzing the Custom Function

This section describes the NumS1 gn function. Here again is the code:

Function NumSign{Inval)
Select Case InVal
Case Is < 0: NumSign = "hegative”

Case 0: NumSign = "Zero”
Case Is > 0: NumSign = "Positive"
End Select

End Function

Notice that the procedure starts with the keyword Function rather than Sub,
followed by the name of the function (NumS1ign). This custom function uses one
argument (InValJ; the argument’s name is enclosed in parentheses. InVal is the
cell or variable that is to be processed. When the function is used in a worksheet,
the argument can be a cell reference (such as Al) or a literal value (such as -123).
When the function is used in another procedure, the argument can be a numeric
variable, a literal number, or a value that is obtained from a cell.

The NumSign function uses the Select Case construct (described in Chapter 35)
to take a different action, depending on the value of In¥al.If InVal is less than
zero, KumS ign is assigned the text Negativea. If InVal is equal to zero, NumSiyn is
Zeyo. lf InVal is greater than zero, NumSign is Positive. The value returned by a
function is always assigned to the function’s name.

The procedure ends with an End Function statement.
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About Function Procedures

A custom function procedure has a lot in common with a subroutine procedure,
covered in the preceding chapter. Function procedures have some important
differences, however, which are discussed in this section.

Declaring a Function

The syntax for declaring a function is as follows:

[Public | PrivatellStaticl Function name [(arglist)]lAs typel
[statements]
[name = expression]
[Exit Functionl]
[statements]
[name = expression]
End Function

These elements are defined as follows:
« Public: Indicates that the function is accessible to all other procedures in all
other modules in the workbook. (Optional)

» Private: Indicates that the function is accessible only to other procedures in
the same module. Private functions can’t be used in worksheet formulas and
do not appear in the Paste Function dialog box. (Optional)

« Static: Indicates that the values of variables declared in the function are
preserved between calls, rather than being reset. (Optional)

* Function: A keyword that indicates the beginning of a function procedure.
(Required)

« name: Any valid variable name. When the function finishes, the single-value
result is assigned to the function’s name. (Required)

« arglist: Alist (one or more) of variables that represent arguments passed to
the function. The arguments are enclosed in parentheses. Use a comma to
separate arguments. (Optional)

» type: The data type that is returned by the function. (Optional)
= slalemenls: Valid VBA statements. (Optional)

= Exit Function: A statement that causes an immediate exit from the function.
{Optional)

» End Function: A keyword that indicates the end of the function. (Required)

Keep in mind that a value is assigned to the function’s name when a function is
finished executing.
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To create a custom function, follow these steps:

1. Activate the Visual Basic Editor (or press Alt+F11).
2., Select the workbook in the Project window.

3. Choose Insert+» Module to insert a VBA module (or you can use an existing
module).

4. Enter the keyword Function followed by the function’s name and a list of the
arguments (if any) in parentheses.

5. Insert the VBA code that performs the work— and make sure that the variable
corresponding to the function’s name has the appropriate value (this is the
value that the function returns).

6. End the function with an End Function statement.
Function names must adhere to the same rules as variable names, and vou can’t

use a name that looks like a worksheet cell (for example, a function named J21 isn’t
accepted).

Executing Function Procedures

Although many ways exist to execute a subroutine procedure, you can execute a
function procedure in just two ways:

» Call it from another procedure

« Use it in a worksheet formula
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Calling custom functions from a procedure

You can call custom functions from a procedure just as vou call built-in VBA
functions. For example, after vou define a function called Calc i'ax, you can enter a
statement such as the following:

Tax = CalcTax{Amount, Rate)

This statement executes the Cal cTax custom function with Amount and Rate as its
arguments. The function’s result is assigned to the Tax variable.

Using custom functions in a worksheet formula

Using a custom function in a worksheet formula is like using built-in functions. You
must ensure that Excel can locate the function procedure, however. If the function
procedure is in the same workbook, you don’t have to do anything special. If the
function is defined in a different workbook, vou may have to tell Excel where to find
the function. The following are the three ways in which vou can do this:

» Precede the function’s name with a file reference. For example, if you want
to use a function called CountNames that’s defined in a workbook named
MyFunctions, you can use a reference such as the following:

=MyFunctions.xIs!{CountNames(ALl:AL00D)

If vou insert the function with the Paste Function dialog box, the workbook
reference is inserted automatically.

* Set up areference to the workbook. If the custom function is defined in a
reference workbook, you don't need to precede the function name with the
workbaook name. You establish a reference to another workbook with the
Tools+ References command (in the Visual Basic Editor). You are presented
with a list of references that includes all open workbooks. Place a check mark
in the item that refers to the workbook that contains the custom function (use
the Browse button if the workbook isn't open).

Create an add-in. When vou create an add-in from a workbook that has function
procedures, you don’t need to use the file reference when you use one of the
functions in a formula; the add-in must be installed, however. Chapter 40
discusses add-ins.

if you plan on developing custom worksheet functions, make sure that you heed
the warning in the sidebar, “What a Function Can’t Do’

Your function procedures don't appear in the Macros dialog box when you select
Tools+ Macro, because you can't execute a function directly. As a result, you need
to do extra, up-front work to test your functions as you're developing them. One
approach is to set up a simple subroutine that calls the function. If the function is
designed to be used in worksheet formulas, you can enter a simple formula to test
it as you're developing the function.
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Function Procedure Arguments

Keep in mind the following about function procedure arguments:

» Argumnents can be variables (including arrays), constants, literals, or
expressions.

* Some functions do not have arguments.
« Some functions have a fixed number of required arguments (from 1 to 60).

* Some functions have a combination of required and optional arguments.

The following section presents a series of examples that demonstrate how to use
arguments effectively with functions. Coverage of optional arguments is beyond the
scope of this book.

Example: A Function with No Argument

Like subroutines, functions don’t necessarily have to use arguments. Excel, for
example, has a few built-in worksheet functions that don’t use arguments. These
include RAND, TODAY, and NOW.

The following is a simple example of a function that has no arguments. This func-
tion returns the UserName property of the Application object, which is the name
that appears in the Options dialog box (General tab). This example is simple, but it
can be useful, because no other way is available to get the user’s name to appear in
a worksheet formula.

Function User()

' Returns Lhe name of Lhe currenl user
User = Application.UserName

End Function

When you enter the following formula into a worksheet cell, the cell displays the
namme of the current user:

=User()

As with Excel’s built-in functions, when you use a function with no arguments, you
must include a set of emnpty parentheses.

The following example is a simple subroutine that uses the User custom function as
an argument for the MsgBox function. The concatenation operator (&) joins the
literal string with the result of the User function.

S5ub Showlser()

MsgBox ("The user is " & User())
End Sub
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Example: A Function with One Argument

This section contains a more complex function that is designed for a sales manager
who needs to calculate the commissions that are earned by the sales force. The
cormmission rate is based on the amount sold —those who sell more earn a higher
commission rate, The function returns the commission amount, based on the sales
made (which is the function’s only argument — a required argument). The
calculations in this example are based on the following table:

Monthly Sales Commission Rate

$10,000 — §19,999 10.5%

$40,000+ 14.0%

Several ways exist to calculate commissions for various sales amounts that are
entered into a worksheet. You could write a formula such as the following:

=[F{AND{AL1>=0,A1<=9999.99),A1*0.08,IF(AND(AL1>=10000,A1<=19999.9
93, AL*0.105

L, IF{AND(AL>=20000,A1<=39999.99) ,AL*0.12,IF(AL>=40000,A1*0.14,0)
1)}

This is not the best approach, for a couple of reasons. First, the formula is overly
complex and difficult to understand. Second, the values are hard coded into the
formula, making the formula difficult to modify if the commission structure
changes.

A better approach is to use a lookup table function to compute the commissions;
for example:

=VLOOKUP(ALl,Table,2)*Al

Using the VLGOOKUP function requires that you have a table of commission rates set
up in your worksheet.
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An even better approach is to create a custom function, such as the following:

Function Commission(Sales)
* Calculates sales commissions

Tierl = 0.08
Tier2z = 0.105
Tier3 = 0.12
Tierd = 0.14

Select Case Sales
Case 0 To 9999.99: Commission = Sales * Tierl
Case 1000 To 19999.99: Commission = Sales * Tier?
Case 20000 To 39999.99:; Commission = Sales * Tier3
Case lg >= 40000: Commission = Sales * l|ier4
End Select
End Function

After you define the Commission function in a VBA module, you can use it in a
worksheet formula or call it from other VBA procedures.

Entering the following formula into a cell produces a result of 3,000 (the amount,
25,000, qualifies for a commission rate of 12 percent):

=Commission(25000)

Even if you don’t need custom functions in a worksheet, creating function proce-
dures can make your VBA coding much simpler. If your VBA procedure calculates
sales commissions, for example, you can use the Commission function and call it
from a VBA subroutine. The following is a tiny subroutine that asks the user for a
sales amount and then uses the Commi ssian function to calculate the commission
due and to display it:

Sub CalcComm()

Sales = InputBox{"Enter Sales:")

MsgBox "The commission is ™ & Commission(Sales)
End Sub

The subroutine starts by displaving an input box that asks for the sales amount.
Then. the procedure displays a message box with the calculated sales commission
for that amount. The Commi ss ion function must be available in the active work-
book; otherwise, Excel displays a message saying that the function is not defined.

Example: A Function with Two Arguments

This example builds on the previous one. Imagine that the sales manager imple-
ments a new policy: The total commission paid is increased by one percent for
every year that the salesperson has been with the company. For this example, the
custom Commi sson function (defined in the preceding section) has been modified
so that it takes two arguments — both of which are required arguments. Call this
new function CommissionZ:
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Function Commission2{5Sales, Years)

* Calculates sales commissions based on years in service
Tierl = .08
Tier2 = 0.10%
Tier3 = 0.12

Il

Tierd 0.14

Select Case Sales
Case 0 o 9999.99: CommissionZ = Sales * [ierl
Case 1000 To 19999.99: CommissionZ = Sales * Tier?Z
Case 20000 To 39999.99: CommissionZ = Sales * Tier3
Case Is >= 40000: Commission2 = Sales * [ier4

End Select

CommissionZ = CommissionZ2 + (CommissionZ * Years / 100)

End Function

The modification was quite simple. The second argument (Years) was added to the
Function statement and an additional computation was included that adjusts the
commission, before exiting the function.

The following is an example of how you write a formula by using this function (it
assumes that the sales amount is in cell Al, and the number of years that the
salesperson has worked is in cell B1):

=Commission2{(Al,B1)

Example: A Function with a Range Argument

The example in this section demonstrates how to use a worksheet range as an
argument. Actually, it’s not at all tricky; Excel takes care of the details behind the
scenes.

Assume that you want to calculate the average of the five largest values in a range
named Data. Excel doesn’t have a function that can do this, so you can write the
following formula:

=({LARGE(Data,l1)+LARGE(Data,2)+LARGE(Data,3 ) +LARGE{Data, 4)+LARGE
(Data,b))/n

This formula uses Excel’s LARGE function, which returns the nth largest value in a
range. The preceding formula adds the five largest values in the range named Data
and then divides the result by 5. The formula works fine, but it’s rather unwieldy.
And, what if you need to compute the average of the top six values? You would
need to rewrite the formula— and make sure that all copies of the formula also get
updated.

Wouldn't it be easier if Excel had a function named TopAvyg? For example, you could
use the following (nonexistent) function to compute the average:

=TopAvg(Dala,5)
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This is an example of when a custom function can make things much easier for you.
The following is a custom VBA function, named TopAvyg, which returns the average
of the top n values in a range:

Function TopAvg(InRange, Num)
' Returns the average of the highest Num values in InRange

Sum = 0
For i =1 To Num
Sum = Sum + WorkshestFunction.Large{InRange, i)

Next i
TopAvg = Sum / Num
End Function

This function takes two arguments: InRange (which is a worksheet range) and
Num (the number of values to average). The code starts by initializing the Sum
variable to (. It then uses a For-Next loop to calculate the sum of the nth largest
values in the range. Note that Excel’s LARGE function is used within the loop. You
can use an Excel worksheet function in VBA if you precede the function with
WorksheetFunct ion and a period. Finally, TopAvg is assigned the value of Sum
divided by Num.

You can use all of Excel’s worksheet functions in your VBA procedures, except those
that have equivalents in VBA. For example, VBA has a Rnd function that returns a
random number. Therefore, you can’t use Excel’s RAND function in a VBA procedure.

Debugging Custom Functions

Debugging a function procedure can be a bit more challenging than debugging a
subroutine procedure. If you develop a function to use in worksheet formulas, an
error in the function procedure simply results in an error display in the formula cell
(usually #VALUE!). In other words, you don’t receive the normal run-time error
message that helps you to locate the offending statement.

When you are debugging a worksheet formula, using only one instance of the
function in your worksheet is the best technique. The following are three methods
that you may want to use in yvour debugging:

* Place MsgBox functions at strategic locations to monitor the value of
specific variables. Fortunately, message boxes in function procedures pop
up when the procedure is executed. But, make sure that vou have only one
formula in the worksheet that uses your function; otherwise, the message
boxes appear for each formula that’s evaluated.

» Test the procedure by calling it from a subroutine procedure. Run-time
errors display normally, and you can either fix the problem (if vou know what
it is) or jump right into the debugger.

* Set a breakpoint in the function and then use Excel’s debugger to step
through the function. You then can access all the normal debugging tools.
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Pasting Custom Functions

Excel’s Paste Function dialog box is a handy tool that enables you to choose a
worksheet function; you even can choose one of your custom worksheet functions.
The Formula Palette prompts you for the function’s arguments.

Function procedures that are defined with the Private keyword do not appear in
the Paste Function dialog box.

You also can display a description of your custom function in the Paste Function
dialog box. To do so, follow these steps:

1. Create the function in a module by using the VBE.

2. Activate Excel.

3. Choose the Tools* Macro* Macros command.

Excel displays its Macro dialog box (see Figure 36-4).

Figure 36-4: Excel’s Macro dialog box doesn't
list functions, so you must enter the function
name yourself,

4. In the Macro dialog box, type the name of the function in the box labeled
Macro Name. Notice that functions do not normally appear in this dialog box,
s0 you must enter the function name yourself.

5. Click the Options button.
Excel displays its Macro Options dialog box. (See Figure 36-5.)
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i Returns the average of the nth fargest values inthe

I PR L
Figure 36-5: Entering a description
for a custom function. This description
appears in the Paste Function

dialog box.

6. Enter a description of the function and then click OK. The Shortcut key field is
irrelevant for functions,

The description that you enter appears in the Paste Function dialog hox.

Custom functions are listed under the User Defined category, and no straightfor-
ward way exists to create a new function category for your custom functions.

Figure 36-6 shows the Paste Function dialog box, listing the custom functions that
are in the User Defined category. In the second Function Wizard dialog box, the user
is prompted to enter arguments for a custom function — just as in using a built-in
worksheet function.

Lookup & Reference
| Datzbase
| Teut

Logical

Figure 36-6: Using the Paste Function dialog
box to insert a custom function.
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When you access a built-in function from the Paste Function dialog box, the Formula
Palette displays a description of each argument. Unfortunately, yvou can’t provide
such descriptions for custom functions.

Learning More

The information in this chapter only scratches the surface when it comes to
creating custom functions. It should be enough to get you started, however, if
you're interested in this topic. Refer to Chapter 38 for more examples of useful
VBA functions. You may be able to use the examples directly or adapt them for
your needs.

Summatry

In this chapter, you read about how to create and use custom VBA functions. These
functions can be used in worksheet formulas and in other VBA procedures. Several
examples are provided, and you can refer to Chapter 38 for more examples.

*  RHRSSEONEEE  NRSONINNEE
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Creating Custom
Dialog Boxes

Yc)u can’t use Excel very long without being exposed to
dialog boxes. Excel, like most Windows programs, uses
dialog boxes to obtain information, clarify commands, and
display messages. lf you develop VBA macros, you can create
your own dialog boxes that work just like those that are built
into Excel. This chapter introduces vou to custom dialog boxes.

Beginning with Excel 97, Microsoft introduced a new
method for creating custom dialog boxes. Therefore, the
information in this chapter does not apply to versions of
Excel prior to Excel 97.

Why Create Custom Dialog Boxes?

Some macros that you create behave exactly the same every
time that you execute them. For example, you may develop a
macro that enters a list of your employees into a worksheet
range. This macro always produces the same result and
requires no additional user input. You may develop other
macros, however, that you want to behave differently under
different circumstances, or that offer some options for the
usetr. In such cases, the macro may benefit from a custom
dialog box.

The following is an example of a simple macro that makes each
cell in the selected range uppercase (but it skips cells that
have a formula). The subroutine uses VBA’s built-in StrConv
function.

Sub ChangeCase(;
For Each cell In Selection
If hot cell.HasFormula Then
cell . Value = StrConvicell.Value,
vhbUpperCase)
End If
Next cell
End Sub
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This macro is useful, but it could be even more useful. For example, the macro would
be more helpful if it could also change the cells to lowercase or initial capitals (only
the first letter of each word is uppercase). This modification is not difficult to make,
but if you make this change to the macro, vou need some method of asking the user
what type of change to make to the cells. The solution is to present a dialog box like
the one shown in Figure 37-1. This dialog box is a UserForm that was created by using
the Visual Basic Editor, and it is displayed by a VBA macro.

Figure 37-1: A custom
dialog box that asks the
user for an option.

Another solution would be to develop three macros —one for each type of text
case change. Combining these three operations into a single macro and using a
dialog box represents a more efficient approach, however. This example, including
how to create the dialog box, is discussed later in the chapter.

Custom Dialog Box Alternatives

Although developing custom dialog boxes isn’t difficult, sometimes using the tools
that are built into VBA is easier. For example, VBA includes two functions (InputBox
and MsgBox) that enable you to display simple dialog boxes, without having to create
a UserFormin the VBE. These dialog boxes can be customized in some ways, but
they certainly don’t offer the options that are available in a custom dialog box.

The InputBox Function

The InputBox function is useful for obtaining a single input from the user. A simpli-
fied version of the function’s syntax follows:

InputBox(promptl,titliell,defaultl)
The elements are defined as follows:

« prompt: Text that is displayed in the input box. (Required)
» title: Text that appears in the input box’s title bar. (Optional)

» default: The default value. (Optional)
The following is an example of how vou can use the Input3ox function:

Rate = InputBox("Commission rate?”,"Commission Worksheet®)
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When this VBA statement is executed, Excel displays the dialog box that is shown
in Figure 37-2. Notice that this example uses only the first two arguments and does
not supply a default value. When the user enters a value and clicks OK, the value is
assigned to the variable Rate.

=l { 38 : T fepE Jelil
Figure 37-2: This dialog box is displayed by
VBA's InputBox function.

VBA's InputBox function always returns a string, so you may need to convert the
results to a value. You can use the Va1l function te convert a string to a value, as
follows:

Rate = Val(InputBox("Commission rate?","Commission Worksheet"))

The MsgBox Function

VBA's MsgBox function is a handy way to display information and to solicit simple
input from users. [use VBA's MsgBox function in many of this book’s examples, to
display a variable's value. A simplified version of the MsgBox syntax is as follows:

MsgBox(promptl,buttons][,titlel)
The elements are defined as follows:

» prompt: Text that is displayed in the message box. (Required)
* buttons: The code for the buttons that are to appear in the message box.
(Optional)

« titl]e: Text that appears in the message box's title bar. (Optional)

You can use the MsgBox function by itself or assign its result to a variable. If you use
it by itself, don’t include parentheses around the arguments. The following example
displays a message and does not return a result:

Sub MsgBoxDemo(}
MsgBox "Click OK to continue”
End Sub
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Figure 37-3 shows how this message box appears.

Figure 37-3: Asimple
message box, displayed
with VBA's MsgBox function.

To get a response from a message box, you can assign the result of the MsgBox
function to a variable. The following code uses some built-in constants (described
later) to make it easier to work with the values that are returned by MsgBox:

Sub GetAnswer()
Ans = MsgBox("Continua?", vbYesNo)
Select Case Ans
Case vbYes
*...[code if Ans is Yes]l...
Case vhbNo
...Lcode if Ans is Nol. ..
End Select
End Sub

When this procedure is executed, the Ans variable contains a value that corresponds
to vbYes or vbho. The Select Case statement determines the action to take based
on the value of Ans.

You can easily customize your message boxes, because of the flexibility of the
buttons argument. Table 37-1 lists the built-in constants that you can use for the
button argument. You can specify which buttons to display, whether an icon
appears, and which button is the default.

Constant Value Description

' vhOKCancel 1 Display OK and Cancel buttons

vhbYesNoCancel 3 Display Yes, No, and Cancel buttons

ncel 5 Display Retry and Cancel buttons

vhRetryCa
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Constant

e Description

vbexclamation 438 Display Warning Message icon

vhDefault3uttonl 1] First button is default

vhDefault3utton3 512 Third button is default

The following example uses a combination of constants to display a message box
with a Yes button, a No button (vbYesNo), and a question mark icon (vhQuestion):
the second button is designated as the default button (vbDefaulLBulLon2)—
which is the button that is executed if the user presses Enter. For simplicity, these
constants are assigned to the Config variable and Config is then used as the
second argument in the MsgBox tunction.

Sub GetAnswer()
Config = vbYesNo + vbQuestion + vbDefaultButtonZ
Ans = MsgBox("Process the monthly report?", Config)
If Ans vbYes Then RunReport
If Ans = vbNo Then End

End Sub

I

Figure 37-4 shows how this message box appears when the GetAnswer subroutine is
executed. If the user clicks the Yes button (or presses Enter), the routine executes
the procedure named RunRepcr . (which is not shown). If the user clicks the No
button, the routine is ended with no action. Because the title argument was omitted
in the MsgBox function, Excel uses the default title (“Microsoft Excel™).

Micrasoft Excal Figure 37-4: The second
argument of the MsgBox
function determines what
appears in the message box.
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The routine that follows is another example of using the MsgBox function:

Sub GetAnswer2(;

Msg = "Do vou want to process the monthly report?”
Msg = Msg & vbLf & vbLf
Msg = Msg & "Processing the monthly report will take

approximately "

Msg = Msg & "1% minutes. It will gensrate a 30-page report
for all "

Msg = Msg & "sales offices for the current month."

Title = "XYZ Marketing Company”

Config = vbYesNo + vbhQuestion

Ans = MsgBox(Msg, Config, litle)

If Ans = vhYes Then RunRepart

If Ans = vbNo Then End
End Sub

This example demonstrates an efficient way to specify a longer message in a mes-
sage box. A variable (Msq) and the concatenation operator (&) are used to build the
message in a series of statements. In the second statement, vbLf is a constant that
represents a line feed character (using two line feeds inserts a blank line). The title
argument is also used to display a different title in the message box. Figure 37-5
shows how this message box appears when the procedure is executed.

¥YZ Marketing Company

Figure 37-5: A message box with a longer message and a title.

Creating Custom Dialog Boxes: An Overview

The InputBex and MsgBox functions do just fine for many cases, but if you need to
obtain more information, then vou need to create a custom dialog box. A custom
dialog box is created on a UserForm in the Visual Basic Editor.

The following is a list of the general steps that you typically take to create a custom
dialog box:

1. Determine exactly how the dialog box is going to be used and where it is to fit
into yvour VBA macro.

2, Activate the Visual Basic Editor and insert a new UserForm (select Insert»
UserForm).
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3. Add the appropriate controls to the dialog hox.

4. Create a macro to display the dialog box.

5. Create “event-handler” VBA subroutines that are executed when the user
manipulates the controls (for example, clicks the OK button).

The following sections provide more details on creating a custom dialog box.

Working with UserForms

Excel stores custom dialog boxes on UserForms (one dialog box per form). To
create a dialog box, you must first insert a new UserForm in the Visual Basic
Editor window.

To activate the Visual Basic Editor, select Tools« Macro * Visual Basic Editor (or
press Alt+F11). Make sure that the current workbook is selected in the Project
window and then select Insert+« UserForm. The Visual Basic Editor displays an
empty form, as shown in Figure 37-6. When you activate a form, the Visual Basic
editor displays the Toolbox, which is used to add controls to the dialog box.

Figure 37-6: An empty form.

Adding Controls

The Toolbox, shown in Figure 37-7, contains various ActiveX controls that you can
add to your dialog box.
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Figure 37-7: The Toolbox
contains the controls that
you add to your dialog box.

When you move the mouse pointer over a control in the Toolbox, the control’s
narne is displayed. To add a control, click and drag it in the form. After adding a
control, you can move it or change its size.

Table 37-2 lists the Toolbox controls.

Control Description

Label Adds a label

ComboBox Adds a combo box

CheckBox Adds a check box

It
ToggleButton Adds a toggle button

SpinButton Adds a spin button

RefEdit Adds a reference edit control (lets the user select a range)

You can also place some of these controls directly on your worksheet Refer to
Chapter 38 for details.
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Changing the Properties of a Control

Every control that you add to a UserForm has several properties that determine
how the control looks and behaves. You can change some of these properties (such
as Heighl and Width) by clicking and dragging the control’s border. To change
other properties, use the Properties window.

To display the Properties window, select View s Properties Window (or press F4).
The Properties window displays a list of properties for the selected control (each
control has a different set of properties). If vou click the form itself, the Properties
window displays properties for the form. Figure 37-8 shows the Properties window
for a CommandButton control.
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Height 24
HelpConkextID 0
Left 18
Locked Faise
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Picture ]
PickurePosition |7 - frPicturePositionvboveCenter
TabIndex a
TabStep  (True
T20 e -
TakeFocusOnClick Trus
Top ia
Visible True
Width 78
Waordivrap

Figure 37-8: The Properties window
for a CommandButton control.

To change a property, select the property in the Property window and then enter a
new value. Some properties (such as BEackColor) enable you to select a property
from a list. The top of the Properties window contains a drop-down list that enables
you to select a control to work with. You can also click a control to select it and
display its properties.
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When you set properties by using the Property window, you're setting properties at
design time. You can also use VBA to change the properties of controls while the
dialog box is displayed (that is, at run time).

A complete discussion of all the properties is well beyond the scope of this book.
To find out about a particular property, select it in the Property window and press
F1. The online Help for UserForm controls is extremely thorough.

Handling Events

When you insert a UserForm, that form can also hold VBA subroutines to handle
the events that are generated by the form. An event is something that occurs when
the user manipulates a control. For example, clicking a button is an event. Selecting
an item in a list box cantrol is an event. To make a dialog box useful, you must write
VBA code to do something when an event occurs.

Event-handler subroutines have names that combine the control with the event.
The general form is the control’s name, followed by an underscore, and then the
event name. For example, the subroutine that is executed when the user clicks a
button named MyButton is MyButton_CTick.

Displaying Custom Dialog Boxes

You also need to write a subroutine to display a custom dialog box. You use the
Show method of the UserForm object. The following procedure displays the dialog
box that is located on the UserForml form:

Sub ShowDialog(;
UserForml.Show
End Sub

This subroutine should be stored in a regular VBA module (not the code module for
the UserForm).

When this subroutine is executed, the dialog box is displayed. What happens next
depends on the event-handler subroutines that you create.

A Custom Dialog Box Example

The preceding section is, admittedly, rudimentary. However, this section demon-
strates how to develop a custom dialog box. This example is rather simple. The
UserForm displays a message to the user—something that could be accomplished
more easily by using the MsgBox function. However, the custom dialog box gives
you a lot more flexibility in terms of formatting and layout of the message.
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Creating the Dialog Box

If vou're following along on your computer, start with a new workbook. Then, follow
these steps:

1. Choose Tools = Macro+ Visual Basic Editor (or press Alt+F11) to activate the
VBE window.

2. In the VBE window, choose Insert s UserForm.
The VBE adds an empty form named UserForm1 and displays the Toolbox.

3. Press F4 to display the Properties window and then change the following
properties of the UserForm object:

Property Change To
hame AboutBox
Caption About This Workboak

4. Use the toolbar to add a Label object to the dialog box.

w1

. Select the Label object. In the Properties window, enter any text that you want
for the label's Caption.

6. In the Properties window, click the Fort property and adjust the font. You can
change the typeface, size, and so on. The changes then appear in the form.
Figure 37-9 shows an example of a formatted Label control.

| & Bookl - AboutBox (UsesForm] - - |

Figure 37-9: A Label control, after changing its Font
properties.
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7. Add a CommandButton object to the dialog box, and change the following
properties for the CommandButton:

Property Change To
hame OKButton
Caption oK

Default True

8. Make other adjustments so that the form looks good to you. You can change
the size of the form, or move or resize the controls.

Testing the Dialog Box
At this point, the dialog box has all the necessary controls. What’s missing is a way
to display the dialog box. This section explains how to write a VBA subroutine to
display the custom dialog box.

1. Insert a module by selecting Insert« Module.

2. In the empty module, enter the following code:

Sub ShowAboutRBox({)
AboulBox.Show
End Sub

3. Activate Excel.
4. Choose Taols+ Macro+ Macros (or press Alt+F8).

5. In the Macros dialog box, select ShowAboutBox from the list of macros and
click OK.

The custom dialog box then appears.
If you click the OK button, notice that it doesn’t close the dialog box as you may

expect. This button needs to have an event-handler subroutine. You can dismiss the
dialog box by clicking the close button in its title box.

Creating an Event-Handler Subroutine

An event-handler subroutine is executed when an event occurs. In this case, you
need a subroutine to handle the Click event that’s generated when the user clicks
the OK button.

1. Activate the Visual Basic Editor (pressing Alt+F11 is the fastest way).

2. Activate the AboutBox form by double-clicking its name in the Project
window.

3. Double-click the OKButton control.
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4, VBE activates the module for the UserForm and inserts some code, as shown
in Figure 37-10.
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Figure 37-10: The module for the UserForm.

5. Insert the following statement hefore the End Sub statement:

Unioad AboutBox

This statement simply dismisses the UserForm. The complete event-handler sub-
routine is listed below:

Private Sub OKButton_Click()
Unload AboutBox
End Sub

Attaching the Macro to a Button

This section describes how to attach the ShowAboutBox subroutine to a Button
object on a worksheet. Follow these steps:

1. Activate Excel.

2. Right-click any toolbar and select Forms from the shortcut menu.
The Forms toolbar is displayed.

3. Click the Button tool on the Forms toolbar.

4. Drag the Button tool into the worksheet to create a Button object.

When yvou release the mouse button, Excel displays its Assign Macro dialog
box (see Figure 37-11).
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Figure 37-11: The Assign Macro dialog box.

5. Select the ShowAboutBox macro from the list.
6. Click OK to close the Assign Macro dialog box.
7. Change the caption of the button to About...

After you perform these steps, click the button to execute the ShowAboutBox
subroutine — which displays your custom dialog box.

Another Custom Dialog Box Example

The example in this section is an enhanced version of the ChangeCase example
presented at the beginning of the chapter. Recall that the original version of this
macro changes the text in the selected cells to uppercase characters. This modified
version asks the user what type of case change to make: uppercase, lowercase, or
initial capitals.

This workbook is available on the companion CD-ROM.

Creating the Dialog Box

This dialog box needs one piece of information from the user: the type of change to
make to the text. Because only one option can be selected, OptionButton controls
are appropriate. Follow these steps to create the custom dialog box. Start with an
empty workbook:

1. Choose Tools+ Macro+ Visual Basic Editor (or press Alt+-F11) to activate the
VBE window.

2. In the VBE window, choose Insert+ UserForm.

VBE adds an empty form named UserForml and displays the Toolbox.
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3. Press F4 to display the Properties window and then change the following
properties of the UserForm object:

Property Change To
hame CaseChangerDialog
Caption Case Changer

4. Add a CommandButton object to the dialog box and then change the following
properties for the CommandButton:

Property Change To
hame OKButton
Caption aK
Default True

5. Add another CommandButton object and then change the following properties:

Property Change To
hame CancelButton
Caption Cancel
Cancel True

6. Add an OptionButton control and then change the following properties (this
option is the default, so its Value property should be set to True):

Property Change To
hame OptionUpper
Caption Upper Case
Value True

7. Add a second OptionButton control and then change the following properties:

Property Change To
hame UptionLower
Caption Lower Case

8. Add a third OptionButton control and then change the following properties:

Property Change To
hame OptionProper
CapLion Proper Case

9. Adjust the size and position of the controls and the form until your screen
resembles Figure 37-12. Make sure that the controls do not overlap.

CiM Ex. 1054 Page 151



Figure 37-12: The dialog box after adding controls and
adjusting some propetties.

The Visual Basic Editor provides several useful commands to help you size and
align the controls. Select the controls that you want to work with, and then choose
a command from the Format menu. These commands are fairly self-explanatory,
and the online Help has complete details.

Testing the Dialog Box

At this point, the dialog box has all the necessary controls. What’s missing is a way
to display the dialog box. This section explains how to write a VBA subroutine to
display the custom dialog box. Make sure that the VBE window is activated.

1. Insert a module by selecting Insert+ Module.

2, In the empty module, enter the following code:

Sub ChangeCase()
CaseChangerDialoy.Show
End Sub

3. Select Run+ Sub/UserForm (or press Fb).

The Excel window is then activated, and the new dialog box is displayed, as shown
in Figure 37-13. The OptionButtons work, but clicking the OK and Cancel buttons
has no effect. These two buttons need to have event-handler subroutines. Click the
Close button in the title bar to dismiss the dialog box.
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Figure 37-13: Displaying the custom dialog box.

Creating Event-Handler Subroutines

This section explains how to create two event-handler subroutines: one to handle the
Click event for the CancelButton CommandButton and the other to handle the Click
event for the OKButton CommandButton. Event handlers for the OptionButtons are
not necessary. The VBA code can determine which of the three OptionButtons is
selected.

Event-handler subroutines are stored in the form module. To create the subroutine
to handle the Click event for the CancelButton, fallow these steps:

1. Activate the CaseChangerDialog form by double-clicking its name in the
Project window.
2. Double-click the CancelButton control.

3. VBE activates the module for the form and inserts some code, as shown in
Figure 37-14.

4. Insert the following statement before the End Sub statement:
Unload CaseChangerDialog
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Figure 37-14: VBE sets up an empty subroutine to handle the
Click event for the CancelButton control.

That's all there is to it. The following is a listing of the entire subroutine:

Private Sub CancelButton_Click()
UnTcad CaseChangerDialog
End Sub

This subroutine is executed when the CancelButton is clicked. It consists of a single
statement that unloads the CaseChangerDialog form.

The next step is to add the code to handle the Click event for the OKButton control.
Follow these steps:

1. Select OKButton from the drop-down list at the top of the module. VBE begins
a new subroutine called JKButton_Click.

2, Enter the following code (the first and last statements have already been
entered for you by VBE):

Privale Sub OxBullon_Click()
Application.ScreenUpdating = False
Exit if a range is not selected
If TypeName(Seleclion) <> "Range" Then Exil Sub
) Upper case
If OptionUpper Then

For Each cell In Selection

If Not cell.HasFormula Then

cell.Value = Strlonv(cell.Value, vbUpperCase)

.

End If
Next cell
End If

Lower case

If OptionLower Then
For Each cell In Selection
If Nol cell.HasFormula Then
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cell . Value = Strlonvi{cell.Value, vblLowerCase)

End If
Next cell
End If

Proper case
If OptionProper Then
For Each cell In Selection
[f Not c¢ell.Hastormula Ihen
cell.Value = StrConv{cell.Value, bProperCase)

End If
Next cell
End If
Unload CaseChangerDialog

End Sub

The macro starts by turning off screen updating (this makes the macro run faster).
Next, the code checks the type of the selection. If a range is not selected, the
procedure ends. The remainder of the subroutine consists of three separate blocks.
Only one block is executed, determined by which OptionButton is selected. The
selected OptionButton has a value of True. Finally, the UserForm is unloaded
(dismissed).

Testing the Dialog Box

To try out the dialog box, follow these steps:

1. Activate Excel.

2. Enter some text into some cells.

3. Select the range with the text.

4. Choose Tools+* Macro+ Macros (or press Alt+F8).

5. In the Macros dialog box, select ChangeCase from the list of macros and then
click OK. The custom dialog box appears.

6. Make your choice, and click OK.

Try it with a few more selections. Notice that if you click Cancel, the dialog box is
dismissed and no changes are made.

Making the Macro Available from a Toolbar Button

At this point, evervthing should be working properly. However, you have no quick
and easy way to execute the macro. A good way to execute this macro would be
from a toolbar button. You can use the following steps:

1. Right-click any toolbar, and select Customize frorm the shorteut menu.

Excel displays its Customize dialog box.
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2. Click the Commands tab and then select Macros from the Categories list.

3. Click the Custom Button in the Commands list and drag it to a toolbar.

4. Right-click the new toolbar button and then select Assign Macro from the
shortcut menu.

5. Choose ChangeCase from the list of macros, and click OK.

You can also change the button image and add a tool tip by using other com-
mands that are on the shortcut menu.

6. Click Close to close the Customize dialog box.

After performing the preceding steps, clicking the toolbar button executes the
mactro and displays the dialog box.

if the workbook that contains the macro is not open already, it is opened. You may
want to hide the workbook window (select Window+ Hide) so that it isn't dis-
played. Another option is to create an add-in. See Chapter 40 for specifics.

More on Creating Custom Dialog Boxes

Creating custom dialog boxes can make your macros much more versatile. You can
create custom commands that display dialog boxes that look exactly like those that
Excel uses. This section contains some additional information to help you develop
custom dialog boxes that work like those that are built into Excel.

Adding Accelerator Keys

Dialog boxes should not discriminate against those who want to use the keyboard
rather than a mouse. All of Excel’s dialog boxes work equally well with a mouse and
a keyboard, because each control has an associated accelerator key. The user can
press Alt plus the accelerator key to work with a specific dialog box control.

Adding accelerator keys to your custom dialog boxes is a good idea. You do this in
the Properties window by entering a character for the Accelerator property.

Obviously, the letter that you enter as the accelerator key must be a letter that is
contained in the caption of the object. It can be any letter in the text (not necessar-
ily the first letter). You should make sure that an accelerator key is not duplicated
in a dialog box. If you have duplicate accelerator keys, the accelerator key acts on
the first control in the “tab order” of the dialog box (explained shortly).

Some controls (such as edit boxes) don’t have a caption property. You can assign
an accelerator key to a label that describes the control. Pressing the accelerator
key then activates the next control in the tab order (which should be the edit box).

CiM Ex. 1054 Page 156



Controlling Tab Order

The previous section refers to a dialog box’s tab order. When you're working with a
dialog box, pressing Tab and Shift+Tab cycles through the dialog box’s controls.
When you create a custom dialog box, you should make sure that the tab order is
correct. Usually, this means that tabbing should move to the controls in a logical
sequence.

To view or change the tab order in a custom dialog box, use the Properties window.
If the TabStcp property is True, the selected control is selectable when the user
clicks Tab. Change the value of the TabIndex property. These values range from 0
(first in the tab order) to 1 less than the number of controls that have a lablndex
property. When you change the TabIndex, VBE automatically adjusts the TabIndex
of all subsequent controls in the tab order.

Learning More

Mastering custom dialog boxes takes practice. You should closely examine the
dialog boxes that Excel uses; these are examples of well-designed dialog boxes.
You can duplicate nearly every dialog box that Excel uses.

The best way to learn more about creating dialog boxes is by using the online Help
system.

Summary

This chapter describes how to create dialog boxes and use them with vour VBA
macros. It also covers two VBA functions — InputBox and MsgBox—which can
sometimes take the place of a custom dialog box. The chapter includes several
examples to help you understand how to use this feature.

S SEBEEISEIES SESSEIIISES
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Using Dialog
Box Controls in
Your Worksheet

‘ hapter 37 presented an introduction to custom dialog

boxes. If you like the idea of using dialog box controls —
but don’t like the idea of creating a dialog box —this chapter
is for you. It explains how to enhance your worksheet with a
variety of interactive controls, such as buttons, ListBoxes,
and OptionButtons.

Why Use Controls on a Worksheet?

The main reason to use dialog box controls on a worksheet is to
make it easier for the user to provide input. For example, if you
create a model that uses one or more input cells, you can create
controls to allow the user to select values for the input cells.

Adding controls to a worksheet requires much less effort than
creating a dialog box. In addition, you may not have to create
any macros, because you can link a control to a worksheet
cell. For example, if you insert a CheckBox control on a work-
sheet, you can link it to a particular cell. When the CheckBox
is selected, the linked cell displays TRUE. When the CheckBox
is not selected, the linked cell displays FALSE.

Figure 38-1 shows a simple example that uses OptionButtons
and a ScrollBar control.
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Flgure 38-1: Th|s worksheet uses dialog box controls.

Controls That Are Available to You

Adding controls to a worksheet can be a bit confusing, because these controls have
twa sources. The controls that you can insert on a worksheet come from two
toolbars:

» Forms toolbar: These controls are insertable objects (and are compatible with

Excel 5 and Fxcel 95).

» Control Toolbox toolbar: These are ActiveX controls. These controls are a
subset of those that are available for use on UserForms. These controls work
only with Excel 97 and Excel 2000, and are not compatible with Excel 5 and
Excel 95.

To add to the confusion, most of the controls are available on both toolbars. For
example, the Forms toolbar and the Control Toolbox toolbar both have a control
named ListBox. However, these are two entirely different controls. In general, the
ActiveX controls (those on the Control Toolbox toolbar) provide more flexibility,
and vou should use those controls. However, if you need to save your workbook
so that it can be opened by Excel 5 or Excel 95, vou should use the controls that
are on the Forms toolbar.

This chapter focuses exclusively on the controls that are available in the Control
Toolbox toolbar, as shown in Figure 38-2.
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Figure 38-2: The
Control Toolbox toolbar.

Button What It Does

Properties Displays the Properties window

CommandButton Inserts a CommandButton control

ListBox Inserts a ListBox control

ToggleButton Inserts a ToggleButton control

ScrollBar Inserts a ScrollBar control

Image Inserts an Image control

Using Controls

Adding ActiveX controls in a worksheet is easy. After you add a control, you can
adjust its properties to modify the way that the control looks and works.
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Adding a Control

To add a control to a worksheet, make sure that the Control Toolbox toolbar is
displayed — and don’t confuse it with the Forms toolbar. Then, click and drag the
control that you want to use into the worksheet to create the control. You don't
need to be too concerned about the exact size or position, because you can modity
these properties at any time.

About Design Mode

When you add a control to a worksheet, Excel goes into design mode. In this mode,
you can adjust the properties of any controls on your worksheet, add or edit macros
for the control, or change the control’s size or position.

When Excel is in design mode, you can’t try out the controls. To test the controls,
you must exit design mode by clicking the Exit Design Mode button on the Control
Toolbox toolbar.

Adjusting Properties

Every control that vou add has various properties that determine how it locks and
behaves. You can adjust these properties only when Excel is in design mode. When
you add a control to a worksheet, Excel enters design mode automatically. If you
need to change a control after you exit design mode, simply click the Design Mode
button on the Control Toolbox toolbar.

To change the properties for a control, select the control and then click the Froper-
ties button on the Control Toolbox toolbar. Excel displays its Properties window, as
shown in Figure 38-3, The Properties window has two tabs. The Alphabetic tab dis-
plays the properties in alphabetical order. The Categorized tab displays the proper-
ties by category. Both tabs show the same properties; only the order is different.
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To change a property, select it in the Properties window and then make the change.
The manner in which you change a property depends on the property. Some proper-
ties display a drop-down list that lets you select from a list of options. Others (such
as Font) provide a button that, when clicked, displays a dialog box. Other proper-
ties require you to type the property value. When you change a property, the change
takes effect immediately.

To learn about a particular property, select the property in the Properties window
and press F1.

3
Common Properties

Each control has its own unique set of properties. However, many controls share
properties. This section describes some of the properties that are common to all
or many controls, as set forth in Table 38-2.
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Property Description

AutoSize If True, the control resizes itself automatically, based on the text in
its caption.

BackStyle The style of the background (either transparent or opaque).

LinkedCell A warksheet cell that contains the current value of a control.

Value The control’s value.

Name The name of the control. By default, a control’'s name is based on the
control type. You can change the name to any valid name. However,
each control’s name must be unique on the worksheet.

Linking Controls to Cells

Often, you can use ActiveX controls in a worksheet, without using any macros. Many
of the controls have a LinkedCel1 property, which specifies a worksheet cell that is
“linked” to the control.

For example, you might add a SpinButton control and specify Bl as its LinkedCeT]
property. After doing so, cell B1 contains the value of the SpinButton, and clicking
the SpinButton changes the value in cell Bl (see Figure 38-4). You can, of course,
use the value contained in the linked cell in your formulas.
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Figure 38-4: The SpinButton’s LinkedCell property is
set to cell B1, enabling the user to change the cell’s
value by using the SpinButton control.

Creating Macros for Controls

To create a macro for a control, you must use the Visual Basic Editor (VBE). The
macros are stored in the code module for the sheet that contains the control. Each
control can have a macro to handle any of its events. For example, a CommandButton
control can have a macro for its C11ck event, its Db1C11 ck event, and various other

events.

The easiest way to access the code module for a control is to double-click the
control while in design mode. Excel displays the VBE and creates an empty macro
for the control's C11ck event. (See Figure 38-5.)

The control’s name appears in the upper-left portion of the code window, and the
event appears in the upper-right area. lf you want to create a macro that executes
when a different event occurs, select the event from the list in the upper-right area.

The following steps demonstrate how to insert a CommandButton and create a sim-

ple macro that displays a message when the button is clicked:

1. Make sure that the Control Toolbox toolbar is displayed.
2. Click the CommandButton tool in the Control Toolbox.

3. Click and drag in the worksheet to create the button.

4. Double-click the button. The VBE window is activated, and an empty subrou-

tine is created.

5. Enter the following VBA statement before the End Sub statement:
MsgBox "You clicked on the command button.”

6. Press Alt+F11 to return to Excel.

7. Adjust any other properties for the CommandButton.
8. Click the Exit Design Mode button in the Control Toslbox toolbar.
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Figure 38-5: Double-clicking a control in design mode activates the Visual Basic Editor.

After perfaorming the preceding steps, click the CommandButton to display the
message box that is shown in Figure 38-6.

3‘5heeu il I ikl R i
Figure 38-6: This message box is displayed by a simple macro.

When you use a CommandButton on a worksheet, setting its TakeFocus-
OnC11ick property to False is recommended. Otherwise, you may run into prob-
lems if the macro tries to select cells on the worksheet. If the CommandButton has
the focus, the cells can’t be selected!
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The Controls Toolbox Controls

The sections that follow describe the ActiveX controls that are available on the
Controls Toolbox toolbar.

The companion CD-ROM contains a file that includes examples of all the ActiveX
controls.

| CheckBox Control

A CheckBox control is useful for getting a binary choice: yes or no, true or false, on
or off, and so on. Figure 38-7 shows some examples of CheckBox controls. Each of
these controls displays its value in a cell (in Al:A4).

Figure 38-7: CheckBox controls on a worksheet.

The following is a description of the most useful properties of a CheckBox control:

» Accelerator: A letter that enables the user to change the value of the control
by using the keyboard. For example, if the accelerator is A, pressing Alt+A
changes the value of the CheckBox control.

» LinkedCell: The worksheet cell that’s linked to the CheckBox. The cell
displays TRUE if the control is checked or FALSE if the control is not checked.

ComboBox Control

A ComboBox control is similar to a ListBox control. A ComboBox, however, is a drop-
down box, and it displays only one item at a time. Another difference is that the user
may be allowed to enter a value that does not appear in the list of items.

Figure 38-8 shows a few ComboBox controls. One of these controls uses two columns
for its ListFill range.
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Figure 38-8: ComboBox controls.

The following is a description of the most useful properties of a ComboBox control:
+ BoundColummn: If the list contains multiple columms, this property determines
which column contains the returned value.
+ ColumnCount: The number of columns in the list.
» LinkedCell: The worksheet cell that displays the selected item.
» ListFillRange: The worksheet range that contains the list iterns.
» ListRows: The number of items to display when the list drops down.
« ListStyle: Determines the appearance of the list items.

» MultiSelect: Determines whether the user can select multiple items from
the list.

» Style: Determines whether the control acts like a drop-down list or a
ComboBox. A drop-down list doesn’t allow the user to enter a new value.

if you use a multiselect ListBox, you cannot specify a LinkedCell; you need to write
a macro to determine which items are selected.

CommandButton Control

A CommandButton is useless if you don’t provide a macro to execute when the but-
ton is clicked. Figure 38-9 shows a worksheet that uses several CommandButtons.
One of these CommandButtons uses a picture.
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Figure 38-9: CommandButtons on a worksheet.

When a button is clicked, it executes a macro with a name that is made up of
the CommandButton’s name, an underscore, and the word Click. For example, if
a CommandButton is named MyButton, clicking it executes the macro named
MyButton_Click.

Image Control

An Image control is used to display an image that is contained in a file. This control
offers no significant advantages over using standard imported images (as described
in Chapter 14).

Label Control

A Label control simply displays text. This is not a useful control for use on work-
sheets, and a standard TextBox AutoShape gives you more versatility.

ListBox Controls

The ListBox control presents a list of items, and the user can select an item (or mul-
tiple items). Figure 38-10 shows a worksheet with several ListBox controls. As you
can see, you have a great deal of control over the appearance of ListBox controls.
One of the ListBoxes uses two colummns as its ListFill range.
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Figure 38-10: ListBox controls on a worksheet.

You can specify a range that holds the ListBox items, and this range can consist of
multiple columns.

The following is a description of the most useful properties of a ListBox control:
* BoundColumn: If the list contains multiple columns, this property determines
which column contains the returned value.
» ColumnCount: The number of columns in the list.

« IntegralHeight: This is True if the height of the ListBox adjusts automatically
to display full lines of text when the list is scrolled vertically. If False, the
ListBox may display partial lines of text when it is scrolled vertically.

» LinkedCell: The worksheet cell that displays the selected item.

» ListFillRange: The worksheet range that contains the list items.

» ListStyle: Determines the appearance of the list items.

« MultiSelect: Determines whether the user can select multiple items from

the list.

if you use a multiselect ListBox, you cannot specify a LinkedCell; you need to write
a macro to determine which items are selected.

OptionButton Controls

OptionButtons are useful when the user needs to select from a small number of
items. OptionButtons are always used in groups of at least two. Figure 38-11
shows two sets of OptionButtons. One set uses graphic images (set with the
Picture property).
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Figure 38-11: Two sets of OptionButtons.

The following is a description of the most useful properties of an OptionButton
control:

» Accelerator: A letter that lets the user select the option by using the keyboard.

For example, if the accelerator for an OptionButton is C, pressing Alt+C selects
the control.

» GroupName: A name that identifies an OptionButton as being associated with
other OptionButtons with the same GroupName property.

» LinkedCell: The worksheet cell that’s linked to the OptionButton. The cell
displays TRUE if the control is selected or FALSE if the control is not selected.

if your worksheet contains more than one set of OptionButtons, you must change
the GroupName property for all OptionButtons in a particular set. Otherwise, all
OptionButtons become part of the same set.

ScrollBar Control

The ScrollBar control is similar to a SpinButton control (discussed next). The
difference is that the user can drag the ScrollBar’s button to change the control’s
value in larger increments. Figure 38-12 shows a worksheet with three ScrollBar
controls. These ScrollBars are used to change the color in the rectangle objects.
The value of the ScrollBars determines the red, green, or blue component of the
rectangle’s color. This example uses a few simple macros to change the colors.
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Figure 38-12: This worksheet has several ScrollBar controls.

The following is a description of the most useful properties of a ScrollBar control:

« Value: The current value of the control.

* Min: The minimum value for the control.

» Max: The maximum value for the control.

» LinkedCell: The worksheet cell that displays the value of the control.

* SmallChange: The amount that the control’s value is changed by a click.

« LargeChange: The amount that the control's value is changed by clicking either

side of the button.

The ScrollBar control is most useful for selecting a value that extends across a wide
range of possible values.

SpinButton Control

The SpinButton control lets the user select a value by clicking the control, which has
two arrows (one to increase the value and the other to decrease the value). Figure
38-13 shows a worksheet that uses several SpinButton controls. Each control is linked
to the cell to the right. As you can see, a SpinButton can display either horizontally or
vertically.

The following is a description of the most useful properties of a SpinButton control:

* Value: The current value of the control.

« Min: The minimum value of the control.

» Max: The maximum value of the control.

* LinkedCell: The worksheet cell that displays the value of the control.

* SmallChange: The amount that the control’s value is changed by a click. Usu-
ally, this property is set to 1, but you can make it any value.
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Figure 38-13: SpinButton controls in a warksheet.

If you use a linked cell for a SpinButton, you need to understand that the worksheet
is recalculated every time the value of the control is changed. Therefore, if the user
changes the value from 0 to 12, the worksheet gets calculated 12 times. If your work-
sheet takes a long time to calculate, you may want to reconsider using this control.

TextBox Controls

On the surface, a TextBox control may not seem useful. After all, it simply contains
text—you can usually use worksheet cells to get text input. In fact, TextBox controls
are useful not so much for input control but for output control. Because a TextBox
can have ScrollBars, you can use a TextBox to display a great deal of information in
a small area.

Figure 38-14 shows an example of a TextBox that is used to provide help information.
The user can use the ScrollBar to read the text. The advantage is that the text uses
only a small amount of screen space. The example in this ligure uses three controls:
the TextBox, a Label control, and a disabled CommandButton control (which pro-
vides a backdrop for the other two controls).

The following is a description of the most useful properties of a TextBox control:
« AutoSize: Determines whether the control adjusts its size automatically,

depending on the amount of text.

« IntegralHeight: If True, the height of the TextBox adjusts automatically to dis-
play full lines of text when the list is scrolled vertically. If False, the ListBox
may display partial lines of text when it is scrolled vertically.

= MaxLength: The maximum number of characters allowed in the TextBox.
If 0, no limit exists on the number of characters.

» MultiLine: If I'rue, the TextBox can display more than one line of text.

« TextAlign: Determines how the text is aligned in the TextBox.
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« WordWrap: Determines whether the control allows word wrap.

* ScrollBars: Determines the type of ScrollBars for the control: horizontal, verti-
cal, both, or none.

Figure 38-14: This worksheet uses a TextBox to display
help information.

ToggleButton Control

A ToggleButton control has two states: on or off. Clicking the button toggles
between these two states, and the button changes its appearance. Its value is
either True (pressed) ar False (not pressed). You can often use a ToggleButton
in place of a CheckBox control.

Summary

This chapter describes how to add ActiveX controls to a worksheet and how to use
these controls to enable users easily to provide data that’s used in a worksheet.

& CORRIRARNRES  SRsESRINERS
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VBA
Programming
Examples

My philosaphy about learning to write Excel macros
places heavy emphasis on examples. I've found that

a wellthought-out example often communicates a concept
much better than a lengthy description of the underlying the-
ory. In this book, I chose to avoid a painstaking description
of every nuance of VBA. [ take this approach for two reasons.
First, space limitations prohibit such a discussion. But more
to the point, the VBA language is described very well in
Excel’s online Help system.

This chapter consists of several examples that demonstrate
common VBA techniques. You may be able to use some of the
examples directly, but in most cases, you must adapt them to
your own needs. These examples are organized into the follow-
ing categaries:

» Working with ranges

« Changing Excel’s settings

« Working with graphic objects

» Working with charts

* Learning ways to speed vour VBA code

All subroutines and functions in this chapter can be found in a
workbook that’s included on the companion CD-ROM.

Working with Ranges

Most of what you do in VBA probably involves worksheet
ranges. When yvou work with range objects, keep the follow-
ing points in mind:
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« Your VBA code doesn’t need to select a range to do something with the range.

+ If your code does select a range, its worksheet must be active.

» The macro recorder doesn’t always generate the most efficient code. Often,
you can use the recorder to create your macro and then edit the code to make
it more efficient.

» Using named ranges in your VBA code is recommended. For example, a refer-
ence such as Range (“Total”) is better than Range (*D45”). [n the latter case,
you need to modify the macro if you add a row above row 45.

*» When you record macros that select ranges, pay close attention to “relative
vs. absolute” recording mode. The recording mode that you choose can
drastically affect the way the macro operates.

« If you create a macro that loops through each cell in the current range selec-
tion, be aware that the user can select entire columns or rows. In most cases,
you don’t want to loop through every cell in the selection. You need to create
a subset of the selection that consists only of nonblank cells.

» Be aware that Excel allows multiple selections. For example, you can select a
range, press Ctrl, and then select another range. You can test for this in your
macro and take appropriate actions.

The examples in the following sections demonstrate these points.

Copying a Range

Copying a range is a frequent activity in macros. When you turn on the macro
recorder (using absolute recording mode) and copy a range from Al:A5 to B1:B5,
you get a VBA macro like this:

Sub CopyRange()
Range{"Al:A5").Select
Selection.Copy
Range{("B1l").Select
ActiveSheet.Paste
Application.CutCopyMode = Fals

End Sub

[yv]

This macro works, but it’s not the most efficient way to copy a range. You can
accomplish exactly the same result with the following one-line macro:

Sub CopyRange2(
Range("Al:A5").Copy Range("Bl")
End Sub

This takes advantage of the fact that the Copy method can use an argument that
specifies the destination. [nformation such as this is available in the online Help
system.
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The example demonstrates that the macro recorder doesn’t always generate the
most efficient code. As you see, you don’t have to select an object to wark with it.
Note that Macro2 doesn't select a range; therefore, the active cell doesn’t change
when this macro is executed.

Copying a Variable-Size Range

Often, you want to copy a range of cells in which the exact row and calumn dimen-
sions are unknown.

Figure 39-1 shows a range on a worksheet. This range consists of a number of rows,
and the number of rows can change daily. Because the exact range address is
unknown at any given time, writing a macro to copy the range can be challenging.

ng Calls Orders
01402/39 452 94
01/09/33 248 {32
01/15/99 £a7 144
01/23/99 733 193
01/30/89 E32 113
0205499 708 93
02413/99 €13 203
02/20/99 £32 183
02/27/95 £34 187
03/05/99 E54 103
02/13/99 770 an

hsheet1
Figure 39-1: This range can consist of any number of rows.

The macro that follows demonstrates how to copy this range from Sheetl to Sheet2
(beginning at cell Al). It uses the CurrentRegion property, which returns a Range
object that corresponds to the active block of cells. This is equivalent to choosing
Edit* Go To, clicking the Special button, and then selecting the Current Region
option.

Sub CopyCurrentRegion()
Range("Al").CurrentRegion.Copy
Sheets{"Sheet2”).Select
Range{"Al").Select
ActiveSheat.Paste
Sheets("Sheetl”™).Select
Application.CutCopyMode = False

End Sub
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Selecting to the End of a Row or Column

You probably are in the habit of using key combinations, such as Ctrl+Shift+right-
arrow key and Ctrl-Shift+ down-arrow key, to select from the active cell to the end of
a row or column. When you record these actions in Excel (using relative recording
mode), you'll find that the resulting code works as you would expect it to.

In previous versions of Excel, the macro recorder always recorded absolute cell
addresses when making these types of selections. This problem has been fixed in
Excel 2000.

The following VBA subroutine selects the range that begins at the active cell and
extends down to the last cell in the column (or to the first empty cell, whichever
comes first). When the range is selected, you can do whatever you want with it —
copy it, move it, format it, and so on.

Sub SeleclDown(;
Range{ActiveCell, Activelell.End(x1Down)).Select
End Sub

This example uses the End method of the Range object, which returns a Range
object. The End method takes one argument, which can be any of the following
constants: x1Up, x1Down, x1TolLefL, or x1ToRighL.

Selecting a Row or Column

The macro that follows demonstrates how to select the column of the active cell. It
uses the EntireColumn property, which returns a range that consists of a column.

Sub SelectColumn{)
ActiveCell.tntireColumn.Select
End Sub

As you may suspect, an EntireRow property also is available, which returns a range
that consists of a row.

If you want to perform an operation on all cells in the selected column, vou don’t
need to select the column. For example, the following subroutine makes all cells
bold in the row that contains the active cell:

Sub MakeRowBold()
ActiveCell . EntireRow.Font.Bold = True
End Sub
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Moving a Range

Moving a range consists of cutting it to the Clipboard and then pasting it to
another area. If you record your actions while performing a move operation,
the macro recorder generates code as follows:

Sub MoveRange()
Range{"Al:C6").5elect
Seleciion.Cul
Range{"A10").Select
ActiveSheetl.Paste

End Sub

As demonstrated with copying earlier in this chapter, this is not the most efficient
way to move a range of cells. In fact, you can do it with a single VBA statement,
as follows:

Sub MoveRangeZ()
Range("Al:C6").Cut Range("AlQ0")
End Sub

This statement takes advantage of the fact that the Cul method can use an argument
that specifies the destination.

Looping Through a Range Efficiently

Many macros perform an operation on each cell in a range, or they may perform
selective actions based on the content of each cell. These operations usually
involve a For-Next loop that processes each cell in the range.

The following example demonstrates how to loop through all the cells in a range.
In this case, the range is the current selection. In this example, Ce11 is a variable
name that refers to the cell being processed. Within the For-Next loop, the single
statement evaluates the cell and changes its font color if the cell value is negative
{vbRed is a built-in constant that represents the color red).

Sub ProcessCells{)
For Each Cell In Selectian
If Cell.Value < 0 Then Cell.Font.Color = vbRed
Next Cell

End Sub

The preceding example works, but what if the selection consists of an entire col-
umn or an entire range? This is not uncommeoen, because Excel lets you perform
operations on entire columns or rows. But in this case, the macro seems to take
forever, hecause it loops through each cell— even those that are blank. What’s
needed is a way to process only the nonblank cells.
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This can be accomplished by using the SelectSpecia’l method. In the following
example, the SelectSpecial method is used to create two new objects: the subset
of the selection that consists of cells with constants, and the subset of the selection
that consists of cells with formulas. Each of these subsets is processed, with the net
effect of skipping all blank cells.

Sub SkipBlanks(}
* Ignore errors
On Error Resume Nexl

' Process the constants
Set ConstantCells = Selection.SpecialCells(x1Constants, 237
For Each c¢ell In Constantlells
If cell.Value > 0 Then cell.Font.Color = vbRed
Nexl cell

Process the formulas
Sel FormulaCells = Seleclion.SpecialCells{xlFormulas, 23)
For Each ¢ell In FormulaCells
If cell.value > 0 Then cell.Font.Color = vbRed
Next cell
End Sub

The SkipBlanks subroutine works fast, regardless of what is selected. For example,
you can select the range, select all columns in the range, select all rows in the range,
or even select the entire worksheet. In all of these cases, only the cells that contain
constants or values are processed. This is a vast improvement over the
ProcessCells subroutine presented earlier.

Notice that the following statement is used in the subroutine:
On Error Resume Next

This statement causes Excel to ignore any errors that occur and simply to process
the next statement. This is necessary because the Speciaiells method produces
an error if no cells qualify. Normal error checking is resumed when the subroutine
ends. To tell Excel explicitly to return to normal error-checking mode, use the
following statement:

On Error GoTo O

Prompting for a Cell Value

As discussed in Chapter 37, you can take advantage of VBA's TnpulBex function to
solicit a value from the user. Figure 39-2 shows an example.

You can assign this value to a variable and use it in your subroutine. Often, however,
you want to place the value into a cell. The following subroutine demonstrates how
to ask the user for a value and place it into cell Al of the active worksheet, using only
one statement:
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Sub GetValue()
Range("Al").Value = InputBox("Enter the value for cell AL"™)
End Sub

i

138 s, St et 1SRRI R RO S M B R T AR A
Figure 39-2: Using VBA's InputBox function to get a value from the user.

Determining the Type of Selection

[f vour macro is designed to work with a range selection, you need to determine
that a range is actually selected. Otherwise, the macro most likely fails. The follow-
ing subroutine identifies the type of object that is currently selected:

Sub SelectionType()
MsgBox TypeName(Selection)
End Sub

If a Range object is selected, the MsgBox displays Range. If your macro is designed
to work only with ranges, you can use an [T statement to ensure that a range is
actually selected. The following is an example that beeps, displays a message, and
exits the subroutine if the current selection is not a Ranges object:

Sub CheckSelection()
If TypeName(Selection) <> "Range”™ Then

Beep
MsgBox "Select 3 range.”
Exit Sub
End If
' ... [Other statements go here]
End Sub
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Another way to approach this is to define a custom function that returns True if
the selection is a Range object, and False otherwise. The following function does
just that:

Function IsRange{sel) As Boolean

[sRange = False

If TypeNamei(sel) = "Range” Then I[sRange = True
End Function

If you enter the IsRange function in your module, vou can rewrite the
CheckSelection subroutine as follows:

Sub CheckSelection()

If IsRange(Salection) Then

' ... [OLher stalemznls go herel
Else

Beep

MsgBex "Select a range."

Exit Sub

End If
End Sub

Identifying a Multiple Selection

As you know, Excel enables yvou to make a multiple selection by pressing Ctrl
while you select objects or ranges. This can cause problems with some macros;
for example, you can’t copy a multiple selection that consists of nonadjacent
ranges. The following macro demonstrates how to determine whether the user
has made a multiple selection:

Sub MultipleSelection()
If Selection.Areas.Count > 1 lhen
MsgBox "Multiple selections not allowed.”
Exit Sub
End If
* ... [Other statements go here]
End Sub

This example uses the Areas method, which returns a collection of all objects in
the selection. The Count property returns the number of objects that are in the
collection.

The following is a VBA function that returns True if the selection is a multiple
selection:

Function IsMultiple(sel) As Boolean

IsMultiple = False

If Selection.Areas.Count > 1 Then IsMultiple = True
End Function

CiM Ex. 1054 Page 182



Changing Excel’s Settings

Some of the most useful macros are simple subroutines that change one or more
of Excel’s settings. For example, it takes quite a few actions simply to change the
Recalculation mode from automatic to manual.

This section contains two examples that demonstrate how to change settings in
Excel. These examples can be generalized to other operations.

Boolean Settings

A Boolean setting is one that is either on or off. For example, you may want to cre-
ate a macro that turns on and off the row and column headings. If you record your
actions while you access the Options dialog box, you find that Excel generates the
following code if you turn off the headings:

ActiveWindow.DisplayHeadings = False
It generates the following code if you turn on the headings:
ActiveWindew.DisplayHeadings = True

This may lead you to suspect that the heading display requires two macros: one to
turn on the headings and one to turn them off. Actually, this isn’t true. The follow-
ing subroutine uses the Not operator effectively to toggle the heading display from
Trueto False and from False to True:

Sub ToggleHeadings()
If TypeName(ActiveSheet) <> "Worksheet™ Then EXit Sub
ActiveWindow.DisplayHeadings = Not
ActiveWindow.DisplayHeadings
End Sub

The first statement ensures that the active sheet is a worksheet; otherwise, an
error occurs (chart sheets don’t have row and column headers). This technique
can be used with any other settings that take on Boolean (Trueg or False) values.
For example, you can create macros to toggle sheet tab display, gridlines, and so
on. The best way to find out which properties control these items is to turn on the
macro recorder while you change them. Then, examine the VBA code.

Non-Boolean Settings

For non-Boolean settings, you can use the following Select Case structure. This
example toggles the Calculation mode and displays a message indicating the
current mode:
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Sub ToggleCalcMaoda()
Select Case Application.Calculation
Case xI1Manual
Application.Calculation = xTAutomatic
MsgBox "Automatic Calculation Mode”
Case xTAutomatic
Application.Calculation = x1Manual
MsgBox "Manual Calculation Mode”
End Select
End Sub

Working with Graphic Objects (Shapes)

VBA subrautines can work with any type of Excel object, including graphic objects
that are embedded on a worksheet’s draw layer. This section provides a few exam-
ples of using VBA to manipulate graphic objects.

Creating a Text Box to Match a Range

The following example creates a text box that is positioned precisely over the
selected range of cells. This is useful if you want to make a text box that covers
up a range of data.

Sub CreateTextBox()

If TypeName(Selection) <> "Range"™ Then Exit Sub
Sel RangeSeleclion = Seleclion

Get coordinates of range selection

SellLeft = Selection.left

SelTop = Selection.Top

SellWidth = Selection.Width

SelHeight = Selection.Height

Creale a LexlL box

ActiveSheet.Shapes, AddTexthox(msoTextOriantationHorizontal, _
Sellefl, SelTop, SelWidlh, SelHeighl),Select
RangeSelection.Select
End Sub

The macro first checks to make sure that a range is selected. If not, the subroutine
is exited with no further action. If a range is selected, the coordinates (Left, Top,
WidLh, and Heighl) are assigned to four variables. These variables are then used
as the arguments for the AddTextbox method of the Shapes collection.

The following is a more sophisticated version of this macro that works with a multi-
ple selection of cells. The subroutine creates a text box for each area in the multiple
selection. It uses a For-Next loop to ¢ycle through each area in the range selection.
If the range has only one area (not a multiple selection), the For-Next loop is acti-
vated only one time.
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Sub CreateTextBox2()
If lypeName(Selection) <> "Range” lhen Exit Sub
Set RangeSelection = Selection
For Each Part In Selectian.Areas
' Get coordinates of range selection
SelLeft = Part.Left
SelTop = Part.Top
SelWidth = Part.Width
SelHeight = Part.Height
' Creste a text box

ActiveSheet.Shapes. AddTextbox(msoTextOrientationHeorizontal,

SelLeft, Sellop, SelWidth, SelHeight).Select
Next Fart
RangeSelection.Select
End Sub

Drawing Attention to a Range

The example in this section is a macro that draws an AutoShape around the selected
range. Figure 39-3 shows an example.

H b\ Sheet & il

Figure 39-3: A macro draws the AutoShape around
a selected range of cells.

Sub AddExplosion()

If TypeName(Seleclion) <> "Range” Then Exil Sub
Selleft = Selection.Left - (Selection.Width * €.2)
SelTaop = Selection.Tap - (Selection.Height * 0.5)
SelWidth = Selection.Width + {(Selection.Width * 0.4)
SelHeight = Selection.Height + Selection.Height
ActiveSheet.Shapes.AddShape (msoShageExplosianl

Selleft, SelTop, SzalWidth, SelHeight).Select

Selection.ShapeRange.Fill.Visible = msoFalse

End Sub

ER—
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The macro begins by determining the location and size of the shape, using the
selected range. The shape needs to be larger than the selected range and must be
offset to the left and to the top. Therefore, the macro performs some calculations to
determine the left, top, width, and height of the shape. In this example, the shape’s
height is twice as large as the height of the selection and 40 percent wider than the
width of the selection. These calculations were determined by trial and error. In
most cases, the shape is drawn in such a way that the contents of the underlying
cells are completely visible. In other cases, slight adjustments are required.

After the parameters are calculated, the AutoShape is added to the active
sheet. The AutoShape that’s drawn by the macro is identified by a constant
(msoShapetxplosionl). The final statement makes the shape transparent.

Working with Charts

Manipulating charts with VBA can be confusing, mainly because of the large
number of objects involved. To get a feel for this, turn on the macro recorder,
create a chart, and perform some routine chart editing. You may be surprised by
the amount of code that's generated.

After you understand the objects in a chart, however, you can create some useful
macros. This section presents a few macros that deal with charts. When you write
macros that manipulate charts, you need to understand some terminology. An
embedded chart on a worksheet is a ChartObject object. Before you can do any-
thing to a Chart0Object, you must activate it. The following statement activates
the Chart0hject named Chart 1.

ActiveSheet.CnartObjects{"Chart 1"} Activate

After you activate the ChartObject, vou can refer to it in your VBA code as the
ActiveChart. If the chart is on a separate chart sheet, it becomes the active chart
as soon as the chart sheet is activated.

Modifying the Chart Type

The following example changes the chart type of every embedded chart on the
active sheet. It makes each chart an area chart by adjusting the I'ype property of
the ActiveChart object. A built<in constant, x1Area, represents an area chart.

Sub ChartType()
For Each cht [n ActivaSheat.ChartObjects
chl.Aclivale
ActiveChart.Type = xlArea
Next cht
End Sub
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The preceding example uses a For-haxt loop to cycle through all the ChartObject
objects on the active sheet. Within the loop, the chart is activated and then the
chart type is assigned a new value.

The following macro performs the same function but works on all chart sheets in
the active workbook:

Sub Chartlype2(}
For Each cht In ThisWorkbook.Charts
cht.Activate
ActiveChart,lype = xlArea
Next cht
End Sub

Modifying Properties

The following example changes the legend font for all charts that are on the active
sheet. [t uses a For-Next loop to process all ChartObject objects, and uses the On
Error statement to ignore the error that occurs if a chart does not have a legend.

Sub LegendMod()
On Error Resume Next
For Each chl In AcLivsSheel.CharlObjecls
cht,Activate
With ActiveChart.lLegend.Font

Name = "Arial”
.FantStyle = "Bold"”
.Size = 8§
End With
Next cht
End Sub

Applying Chart Formatting

This example applies several different formatting types to the active chart. A chart
must be activated before executing this macro. You activate an embedded chart by
selecting it. Activate a chart on a chart sheet by activating the chart sheet.

Sub ChartMods ()
Un Error Resume Next
With AcliveChartl
Type = xTArea
.ChartArea.Font.Name = "Arial™"
.CharlArea,Fonl.FonltSLyle = "Regular"
.ChartArea.Font.Size = 9
.PlotArea.Interior.Colaorindex = xINone
JAxes(x1Value) . . TickLabels.Fonl.Bold = True
JAxes(x1Category).TickLabels.Font.Bold = True
.Legend.Position = x1Bottom
End Wilh
End Sub
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I created this macro by recording my actions as [ formatted a chart. Then, [ cleaned
up the recorded code by removing irrelevant lines.

VBA Speed Tips

VBA is fast, but it’s often not fast enough. This section presents some programming
examples that you can use to help speed your macros.

Turning Off Screen Updating

You've probably noticed that when vou execute a macro, vou can watch everything
that occurs in the macro. Sometimes this is instructive, but after you get the macro
working properly, it can be annoying and slow things considerably.

Fortunately, a way exists to disable the normal screen updating that occurs when
you execute a macro. Insert the following statement to turn off screen updating:

Application.ScreenlUpdating = False

If, at any point during the macro, you want the user to see the results of the macro,
use the following statement to turn back on screen updating:

Application.Screenlpdating = True

Preventing Alert Messages

One of the benefits of using a macro is that you can perform a series of actions
automatically. You can start a macro and then get a cup of coffee while Excel does
its thing. Some operations cause Excel to display messages that must be attended
to, however. For example, if your macro deletes a sheet, you see the message that is
shown in the dialog box in Figure 39-4. These types of messages mean that you
can’t execute vour macro unattended.

HMicrasaft Excel

Figure 39-4: You can instruct Excel not
to display these types of alerts while a
macro is running.
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To avoid these alert messages, insert the following VBA statement:

Application.DisplayAlerts = False

When the subroutine ends, the DisplayAlerts property is automatically reset to
True (its normal state).

Simplifying Object References

As you probably have discovered, references to objects can get very lengthy
especially if your code refers to an object that’s not on the active sheet or in the
active workbook. For example, a fully qualified reference to a Range object may
look like this:

Workbooks("MyBook™) . Worksheets("Sheetl") . Range("IntRate™)

If your macro uses this range frequently, you may want to create an object variable
by using the Sel command. For example, to assign this Range object to an object
variable named Rate, use the following statement:

Set Rate = Workbooks("MyBook").Worksheets("Sheetl"). _
Range{"IntRate")

After this variable is defined, you can use the variable Rate instead of the lengthy
reference.

Besides simplifying your coding, using object variables also speeds your macros
quite a bit. ['ve seen some macros execute twice as fast after creating object
variables.

Declaring Variable Types

Usually, you don’t have to worry about the type of data that’s assigned to a
variable. Excel handles all these details behind the scenes. For example, if you have
a variable named MyVar, vou can assign a number or any type to it. You can even
assign a text string to it later in the procedure.

But if you want your procedures to execute as fast as possible, you should tell Excel
in advance what type of data is going be assigned to each of your variables. This is
known as declaring a variables type.

Table 39-1 lists all the data types that are supported by VBA. This table also lists the
number of bytes that each type uses and the approximate range of possible values.
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Data Type Bytes Used Approximate Range of Values

Boolean 2 True or False

Double (double-precision 8 —1.7E308 to —4.9E-324 for negative values;
floating-point) 1 4.9E-324 to .7E308 for positive values

Decimal 14 +/-7.9E28 with no decimal point

gth
string

Va“r

length

If yvou don’t declare a variable, Excel uses the Variant data type. In general, the
best technique is to use the data type that uses the smallest number of bytes yet
can still handle all the data assigned to it. When VBA works with data, execution
speed is a function of the number of bytes that VBA has at its disposal. In other
words, the fewer bytes that are used by data, the faster VBA can access and manip-
ulate the data.

To declare a variable, use the D m statement before you use the variable for the first
time. For example, to declare the variable Uni{s as an integer, use the following
statement:

Dim Urits as Integer
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To declare the variable UsarName as a string, use the following statement:

Dim UserName as String

If vou know that UserName can never exceed 20 characters, you can declare it as a
fixed-length string, as follows:

Dim UserName as String * 20

If you declare a variable within a procedure, the declaration is valid only within that
procedure. If you declare a variable outside of any procedures (but before the first
procedure), the variable is valid in all procedures in the module.

[f yvou use an object variable (as described previously), vou can declare the variable
as an object data type. The following is an example:

Dim Rate as Range
Set Rate = Workbooks("MyBook").Worksheets("Sheetl").
Range("IntRate"}

To force yourself to declare all the variables that you use, insert the following state-
ment at the top of your module:

Option Explicit

If you use this statement, Excel displays an error message if it encounters a variable
that hasn’t heen declared.

Summary

This chapter presents several examples of VBA code that work with ranges, Excel’s
settings, graphic objects, and charts. It also discusses techniques that vou can use
to make your VBA macros run faster.
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Creating Custom
Excel Add-Ins

For developers, one of the most useful features in Excel is
the capability to create add-ins. This chapter discusses
this concept and provides a practical example of creating an
add-in.

What Is an Add-In?

Generally speaking, a spreadsheet add-in is something that’s
added to the spreadsheet to give it additional functionality.
Excel 2000 has several add-ins, including the Analysis
ToolPak, AutoSave, and Solver. Some add-ins (such as the
Analysis ToolPak, discussed in Chapter 28) provide new
worksheet functions that can be used in formulas. Usually,
the new features blend in well with the original interface,

so they appear to be part of the program.

Excel’'s approach to add-ins is quite powerful, because any
knowledgeable Excel user can create add-ins from XLS work-
books. An Excel add-in is basically a different form of an XLS
workbook file. Any XLS file can be converted into an add-in,
but not every workbook is a good candidate for an add-in.
Add-ins are always hidden, so vou can’t display worksheets
or chart sheets that are contained in an add-in. But, you can
access its VBA subroutines and functions and display dialog
boxes that are contained on dialog sheets.

The following are some typical uses for Excel add-ins:

+ To store one or more custom worksheet functions.
‘When the add-in is loaded, the functions can be used like
any built-in worksheet function.

» To store Excel utilities. VBA is ideal for creating general-
purpase utilities that extend the power of Excel. The
Power Utility Pak that I created is an example of such
a function.
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« To store proprietary macros. If you don’t want end users to see (or modify)
your macros, store the macros in an add-in. The macros can be used, but they
can’t be viewed or changed.

As previously noted, Excel ships with several useful add-ins (see the sidebar “Add-Ins
That Are Included with Excel”), and you can acquire other add-ins from third-party
vendors or the Internet. In addition, Excel includes the toaols that enahble you to create
your own add-ins. This process is explained later in the chapter, but first, some back-
ground is required.

Working with Add-Ins

The best way to work with add-ins is to use Excel’s add-in manager, which you access
by selecting Tools+ Add-Ins. This command displays the Add-Ins dialog box, shown
in Figure 40-1. The list box contains all the add-ins that Excel knows about. Those that
are checked are currently open. You can open and close add-ins from this dialog box
by selecting or deselecting the check boxes.

Accesslinks &dd-In
Anzlyis ToolPak
Anclysis ToolPak - YBA
AutoSave

Conditfonal Sum Wizard
File Conversion Wizard

Micrasoft Bookshelf Integration il
M5 Query Add-in For Excal & Carnpatib

Z

Most add-in files can also be opened by selecting File « Open. You'll find that after
an add-in is opened, however, you can't choose File= Close to close it. The only
way to remove the add-in is to exit and restart Excel or to write a macro to close
the add-in.

When an add-in is opened, you may or may not notice anything different. [n nearly
every case, however, some change is made to the menu— either a new menu or
one Or more new menu items on an existing menu. For example, when you open
the Analysis ToolPak add-in, a new menu item appears on the Tools menu: Data
Analysis. When you open my Power Utility Pak add-in, you get a new Utilities
menu, which is located between the Data and Window menus.
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Why Create Add-Ins?

Most Excel users have no need to create add-ins. But if you develop spreadsheets for
others —or if you simply want to get the most out of Excel —you may be interested
in pursuing this topic further.

The following are several reasons why you may want to convert your XLS
application to an add-in:

+ To prevent access to your VBA code. When you distribute an application as
an add-in, the end users can’t view the sheets in the workbook. If you use pro-
prietary techniques in your VBA code, this can prevent it from being copied
(or at least make it more difficult to copy).

» To avoid confusion. If an end user loads your application as an add-in, the
file is not visible and, therefore, is less likely to confuse novice users or get
in the way. Unlike a hidden XLS workbook, an add-in can’t be unhidden.

» To simplify access to worksheet functions. Custom worksheet functions that
are stored in an add-in don’t require the workbook name qualifier. For example,
if you have a custom function named MOVAVG stored in a workbook named
Newfuncxls, you would have to use a syntax such as the following to use this
function in a different workbook:

=NEWFUNC.XLSIMOVAVG(AL:ASD)

But if this function is stored in an add-in file that’s open, the syntax is much
simpler, because you don'’t need to include the file reference:

=MOVAVG(AL:AL0)

» To provide easier access, After you identify the location of your add-in, it
appears in the Add-Ins dialog box with a friendly name and a description of
what it does.

» 'To permit better control over loading. Add-ins can be opened automatically
when Excel starts, regardless of the directory in which they are stored.

* To omit prompts when unloading. When an add-in is closed, the user never
sees the Save change in...? prompt.

Creating Add-Ins

Although any workbook can be converted to an add-in, not all workbooks benefit
by this. In fact, workbooks that consist only of worksheets (that is, not macros or
custom dialog boxes) become unusable, because add-ins are hidden.

To convert a workbook to an add-in, the workbook must have at least one work-
sheet. Therefore, if your workbook consists only of Excel 5/95 dialog sheets or
Excel 4 macro sheets, you can't convert it to an add-in.

.
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The only types of workbooks that benefit from conversion to an add-in are those with
macros. For example, you may have a workbook that consists of general-purpase
macros (subroutines and functions). This type of workbook makes an ideal add-in.

Creating an add-in is quite simple. These steps describe how to create an add-in
from a normal workbook file:

1. Develop your application and make sure that everything works properly. Don't
forget to include a methaod to execute the macro or macros. You may want to
add a new menu item (described later in the chapter).

2, Test the application by executing it when a different workbook is active. This
simulates its behavior when it’s an add-in, because an add-in is never the
active workbook. You may find that some references no longer work. For
example, the following statement works fine when the code resides in the
active workbook, but fails when a different workbook is active:

x = Worksheels{("Dala").Range("Al")

You could qualify the reference with the name of the workbook object,
like this:

x = Workbooks ("MYBOOK,XLS") . Worksheets("Data™).Range("ALl")

This method is not recommended, because the name of the workbook changes
when it’s converted to an add-in. The solution is to use the | hisWorkbook qual-
ifier, as follows

x = ThisWorkbook.Worksheets("Data").Range("AL")

3. Select File* Summary Info, enter a brief descriptive title in the Title field,
and then enter a longer description in the Comments field. This step is not
required, but it makes using the add-in easier.

4. Lock the project. This is an optional step that protects the VBA code and
UserForms from being viewed. You do this in the Visual Basic Editor, using
the Tools+ Properties command. Click the Protection tab and make the
appropriate choices.

5. Save the workbook as an XLA file by selecting File* Save As. Select Microsoft
Excel Add-In from the Save as type drop-down list.

After you create the add-in, you need to test it. Select Tools+ Add-Ins and use the
Browse button in the Add-Ins dialog box to locate the XLA file that you created in
Step 5. This installs the add-in. The Add-Ins dialog box uses the descriptive title
that you provided in Step 3.

You can continue to modify the macros and UserForms in the XLA version of your
file, and save your changes in the Visual Basic Editor. In versions prior to Excel 97,
the changes have to be made to the XLS version and then the workboack has to be
resaved as an add-in.
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An Add-In Example

This section discusses the steps that are used to create a useful add-in that dis-
plays a dialog box (see Figure 40-2) in which the user can quickly change several
Excel settings. Although these settings can be changed in the Options dialog box,
the add-in makes these changes interactively. For example, if the Grid Lines check
bozx is deselected, the gridlines are removed immediately.

Figure 40-2; This dialog box
enables the user to change
various Excel settings
interactively.

This file is available on the companion CD-ROM. The file is not locked, so you have
full access to the VBA code and UserForm.

Setting Up the Workbook

This workbook consists of one worksheet, which is empty. Although the worksheet is
not used, it must be present, because every workbook must have at least one sheet.

Use the Visual Basic Editor to insert a VBA module (named Modulel) and a UserForm
(named UserForml).

Module1

The following macro is contained in the Madulel module. This subroutine ensures
that a worksheet is active. If the active sheet is not a worksheet, a message box is
displaved and nothing else happens. If a worksheet is active, the subroutine displays
the dialog box that is contained in UserForml.

Sub ShowToggleSettingsDialag)
IT TypeName(ActiveShezt) <> "Worksheet" Then
MsgBox "A worksheel musl he aclive.", vbInformalion
Else
UserForml.Show
End If
End Sub
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ThisWorkbook

The ThisWorkbock object contains a macro that adds a menu item to the Tools
menu when the workbook {(add-in) is opened. Another macro removes the menu
item when the workbook (add-in) is closed. These two subroutines, which appear
in the following syntax, are explained next:

Private Sub Workbook_Open()
Set NewMenultem = Application.CommandBars _
("Worksheet Menu Bar").Controls("Tools").Controls.Add
With hewMenultem
.Caption = "Toggle Settings...”
.BeginGroup = True
.GnAction = "ShowToggleSettingsDialog”
End With
End Sub

Private Sub Workbook_BeforeClose(Cancel As Boolean)
On Error Resume Next
Application.CommandBars("Worksheet Menu Bar"). _
Controls{"Tools").Controls("Toggle Settings...").Delete
End Sub

The Workbock_0Open subroutine adds a menu item (Toggle Settings) to the bottom
of the Tools menu on the Worksheet Menu Bar. This subroutine is executed when
the workbook (or add-in) is opened.

The Workbecok_BeforeClose subroutine is executed when the add-in is closed. This
subroutine removes the Toggle Settings menu item from the Tools menu.

UserForm1

Figure 40-3 shows the UserForml form, which has ten controls: nine check boxes and
one command button. The controls have descriptive names, and the Accaleralor
property is set so that the controls display an accelerator key (for keyboard users).
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Figure 40-3: The custom dialog box.

The UserForml object contains the event-handler subroutines for the objects that are
on the form. The following subroutine is executed before the dialog box is displayed:

Private Sub UserForm_Initialize()

chGridlines =

ActiveWindow.DisplayGridlines

cbHeaders = ActiveWindow.DisplayHeadings

chVerticalScrollbar = ActiveWindow.DisplayVerticalScrollBar

cbHerizontalScrollbar =
ActiveWindow.DisplayHorizontalScrollBar
cbFormulaView = ActiveWindow.DisplayFormulas

cbSheetTahs = ActiveWindow.DisplayWorkbookTabs
Application.DisplayStatusBar

cbStatusBar =

cbFarmulaBar

chPageBreaks
End Sub

The Userform_Initialize subroutine adjusts the settings of the CheckBox con-
trols in the dialog box to correspond to the current settings. For example, if the
worksheet is displaying gridlines, ActiveWindow.DisplayGridlines returns
True. This value is assigned to the ¢cbGr idl ines CheckBox—which means that

Application.DisplayFormulaBar
ActiveSheet.DisplayPageBreaks

the CheckBox is displayed with a check mark.

Each CheckBox also has an event-handler subroutine, listed in the following code,
that is executed when the control is clicked. Each subroutine makes the appropriate
changes. For example, if the Grid lines CheckBox is selected, the DisplayGridlines

property is set to correspond to the CheckBox.
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Private Sub cbGridlines_Click on{)
ActiveWindow.DisplayGridlines = chGridlines
End Sub

Private Sub ¢bHeaders_Click on()
ActiveWindow.DisplayHesadings = cbhHeaders
End Sub

Private Sub c¢bVerticalScrollbar_Click on()
ActiveWindow,DisplayYerticalScrollBar = cbVerticalScrollbar
knd Sub

Private Sub c¢bHorizontalScrollbar_Click on()
ActiveWindow.DisplayHorizontalScrollBar =

chHorizontalScrollbar

End Sub

Private Sub c¢hFormulaView Click on()
ActiveWindow.DisplayFormulas = chFormulaView
End Sub

Private Sub c¢bhSheetTabs_Click on()
ActiveWindow.DisplayWorkbocklabs = ¢cbSheetlabs
End Sub

Private Sub c¢bStatusBar_Click on()
Application.DisplayStatusBar = cbStatusBar
End Sub

Private Sub c¢hbFormulaBar_Click on()
Application.DisplayFormulaBar = cbFormulaBar
End Sub

Private Sub c¢bPageBreaks_Click on()
ActiveSheet.DisplayPageBreaks = cbhPageBreaks
End Sub

The UserForml object has one additional event-handler subroutine for the Exit
button. This subroutine, listed as follows, simply closes the dialog box:

Private Sub ExitButton_Click on()
Unlcad Userforml
End Sub

Testing the Workbook

Before you convert this workbook to an add-in, you need to test it. You should test it
when a different workbook is active, to simulate what happens when the workbook
is an add-in. Remember, an add-in is never the active workbook and it never displays
any of its worksheets.
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To test it, [ saved the workbook, closed it, and then reopened it. When the workbook
was opened, the Workbock_Open subroutine was executed. This subroutine added
the new menu item to the Tools menu. Figure 40-4 shows how this looks.

Figure 40-4: The Tools menu displays a new menu item, Toggle Settings.

Selecting Tools s Toggle Setting displays the dialog box that is shown in Figure 40-5.

Figure 40-5: The custom dialog box, in action.
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Adding Descriptive Information

This step is recornmended but not necessary. Choose File+ Properties to bring up
the Properties dialog box. Then, click the Summary tab, as shown in Figure 40-6.

Togale Settings_xls Properties

Figure 40-6: Use the Properties dialog box to
enter descriptive information about your add-in.

Enter a title for the add-in in the Title field. This is the text that appears in the Add-
Ins dialog box. In the Comments field, enter a description. This information appears
at the bottom of the Add-Ins dialog box when the add-in is selected.

Protecting the Project

One advantage of an add-in is that it can be protected so that others can’t see the
source code. If you want to protect the project, follow these steps:
1. Activate the Visual Basic Editor.
2. In the Project window, click the project.
3. Select Tools+ [project name] Properties.
VBE displays its Project Properties dialog box.
4. Click the Protection tab (see Figure 40-7).
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5. Select the Lock project for viewing check box.
6. Enter a password (twice) for the project.
7. Click OK.

ToggleSettings - ct Properties

Creating the Add-In

To save the workbook as an add-in, activate Excel, make sure the workbook is active,
and then choose File+ Save As. Select Microsoft Excel Add-In (* xla) from the Save as
Type drop-down list. Enter a name for the add-in file and then click OK.

Opening the Add-In

To avoid confusion, close the XLS workbook before you open the add-in that was
created from it. Then, select Tools + Add-Ins. Excel displays its Add-Ins dialog box.
Click the Browse button and locate the add-in that you just created. After you do
so, the Add-Ins dialog box displays the add-in in its list. Notice that the information
that you provided in the Properties dialog box appears here (see Figure 40-8). Click
OK to close the dialog box and open the add-in.
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Repart Manager

Solver Add-In

Template Utilities

Ternplske Wizard with Data Tracking
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Figure 40-8: The Add-Ins dialog box,
with the new add-in selected.

When the add-in is open, the Tools menu displays a new menu item (Toggle Settings)
that executes the ShowToggleSettingsDialog subroutine in the add-in.

If you activate the VBE window, you find that the add-in is listed in the Project
window. However, you can’t make any modifications unless you provide the
password.

Summary

This chapter discusses the concept of add-ins —files that add new capabilities to
Excel — and explains how to work with add-ins and why you may want to create
custom add-ins. The chapter closes with an example of an add-in that enables
users easily to toggle on and off several Excel settings.
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Using Online
Help: A Primer

Excel’s online Help system has always been good. But
the Help available with Excel 2000 is better than ever.
However, the online Help system can be a bit intimidating
for beginners, because you can get help in many ways. This
appendix assists you in getting the most out of this valuable
resource.

Why Online Help?

In the early days of personal computing, software programs
usually came bundled with bulky manuals that described how
to use the product. Some products included rudimentary help
that could be accessed online. Over the years, that situation
gradually changed. Now, online help is usually the primary
source of documentation, which may be augmented by a
written manual.

After you become accustomed to it, you'll find that online help
(if it’s done well) offers many advantages over written manuals:

* You don’t have to lug around a manual — especially
important for laptop users who do their work on the road.

* You don’t have te thumb through a separate manual,
which often has a confusing index.

* You can search for specific wards and then select a topic
that’s appropriate to your question.

» In some cases (for example, writing VBA code), you can
copy examples from the Help window and paste them
into your application.

» Help sometimes includes embedded buttons that you
can click to go directly to the command that you need.
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Types of Help

Excel offers several types of online Help:

» Tooltips: Move the mouse pointer over a toolbar button and the button’s
name appears.

« Office Assistant: The animated Office Assistant monitors your actions while
you work. If a more efficient way to perform an operation exists, the Assistant
can tell you about it.

* Dialog box help: When a dialog box is displayed, click the Help button in the
title bar (it has a question mark on it) and then click any part of the dialog
box. Excel pops up a description of the selected control. Figure A-1 shows an
example.

Figure A-1: Getting a description of a dialog box control.
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« “What’s This” help: Press Shift+F1, and the mouse pointer turns into a
question mark. You can then click virtually any part of the screen to get a
description of the object.

* 1-2-3 help: The Help+ Lotus 1-2-3 Help command provides help designed for
those who are familiar with 1-2-3’s commanads.

» Internet-based help: You can access a variety of Internet resources directly
from Excel.

* Detailed help: This is what’s usually considered online help. As you’ll see, you
have several ways to locate a particular Help topic.

Accessing Help

When you work with Excel 2000, yvou can access the online Help system by using
the Help menu, shown in Figure A-2. The various options are described in the
sections that follow.

Figure A-2: The Help menu.

The Office Assistant

Selecting Microsoft Excel Help displays the Office Assistant, shown in Figure A-3.
Type a brief description of the subject about which you want help, and the
Assistant displays a list of Help topics. Chances are good that one of these
topics will lead to the help that you need; click a list itern to view a Help topic.
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Figure A-3: The Office Assistant.

The information that you type doesn’t have to be in the form of a question. Rather,
you can simply enter one or more keywords that describe the topic. For example, if
you want to find out how to turn off gridlines, you can type gridlines off.

You have a great deal of control over the Office Assistant. Right-click the Assistant and
select Options from the shortcut menu. Excel displays the dialog box shown in Figure
A-4. The Gallery tab lets you select a new character for the Assistant. The Options tab
lets you determine whether to use the Assistant and, if you do, how the Assistant
behaves. if you find that the Office Assistant is distracting, remove the check from the
Use the Office Assistant check box. You can turn on the Office Assistant again by
choosing the Show the Office Assistant command on the Help menu.
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Figure A-4: Use this dialog box to control the Office Assistant’s behavior.

The Help Window

;- Whether you use the Office Assistant or turn it off, the Help window appears tiled
to the right of the Excel window (see Figure A-5); all Office 2000 products allow
the Help window to share your monitor space with an Office product.

On most Help topics, you'll find links to related Help topics that look like Web links
(they appear underlined). You'll also see links to the Web. Help text for all Office
products is wyritten in HTML. As you'll read in a moment, navigating through Help
topics is like using a browser.

If you click the Show button in the Help window, the Help window expands to
include two panes; in the right pane, Help topics continue to appear, but in the left
pane, you'll see three tabs. Each of the following tabs provides a different way to
find the information that you need.
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Figure A-5: The Help window tiles to the right of the program window so
that you can view Help while working.

Contents Tab

Figure A-6 shows the Contents tab. This tab is arranged alphabetically by subject;
you can compare the Contents tab to the table of contents in a book, because they
both organize information by similar topic. When you double-click a book icon (or
single-click the plus sign to the left of the book icon), the book expands to show
Help topics (each with a question-mark icon). To close a book, double-click it again
or single-click the minus sign to the left of the book. To display a Help topic, single-
click the topic title.

The Help topic remains onscreen until you either close Help or select another Help
topic.
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Answer Wizard Tab

The Answer Wizard tab works in much the same way as the Office Assistant works.
Type a question or some words related to the subject about which you want help,
and then click the Search button (see Figure A-7). Topics appear at the bottom of
the window. Double-click a topic in the bottom of the window and the Help topic
appears in the right pane of the Help window.
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Figure A-7: The Answer Wizard tab of the Help window.

Index Tab

Figure A-8 shows the Index tab of the Help Topics dialog box. The keywords are
arranged alphabetically, much like an index for a book. You can enter in the box at
the top the first few letters of a keyword for which you’d like to search. Click the
Search button to display related topics at the bottom of the box. Double-click a
topic at the bottom of the box to display it in the right pane of the Help window.
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Figure A-8: The Index tab of the Help topics dialog box.

Mastering Help

After you select a Help topic, vou can navigate through Help in the same way that
you use a browser to navigate on the Web. The Back and Forward buttons let you
view Help topics that you previously viewed, in the order that vou viewed them.
Use the Print button to print a Help topic. Click the Options button to display a
drop-down menu that contains commands that perform the same functions as the
Show, Hide, Back, Forward, and Print buttons. You’ll also find a Stop command and
a Refresh command; you can use these if you connect to the Web for Help and want

to stop loading a page or refresh the Web page you're viewing.

The information provided in this appendix gets you started using Excel's online
Help. Evervone develops his or her own style for using this help, and [ urge you to
explore this resource. Even if you think you understand a topic in Excel fairly well,
you can often discover one or two subtle features that you didn’t know about.

A thorough understanding of how to use the online Help system will definitely

make vou a more productive Excel user.
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Worksheet
Function
Reference

I his appendix contains a complete listing of Excel’s work-
sheet functions. The functions are arranged alphabetically
by categories used by the Paste Function dialog box. Some of
these functions (indicated in the lists that follow) are available
only when a particular add-in is attached.

For more information about a particular function, including
its arguments, select the function in the Function Wizard and
click the Help button.

Function What it Does

DCOUNT Counts the cells containing numbers
from a specified database and criteria

Continued
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Function What It Does

DPRODUCT Multiplies the values in a particular field of records that match
the criteria in a database

DSTDEVP Calculates the standard deviation based on the entire popula-
tion of selected database entries

DVAR Estimates variance based on a sample from selected database
entries

SQL.CLOSE** Terminates a SQL.OPEN connection

SQL.ERROR** Returns error information on SQL* functions

QUERYGETDATA** Gets external data using Microsoft Query

QUERYREFRESH*** Updates a data range using Microsoft Query

SQL.RETRIEVE** Retrieves SQLEXEC.QUERY results

* Available only when the Analysis ToolPak add-in is attached
** Available only when the ODBC add-in is attached
% fyailable only when the MS Query add-in is attached
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Function What It Does

DATEVALUE Converts a date in the form of text to a serial number
DAYS360 Calculates the number of days between two dates, based on a 360-
day year

EOMONTH* Returns the serial number of the last day of the month before or after
a specified number of months

MINUTE Converts a serial number to a minute

NETWORKDAYS*  Returns the number of whole workdays between two dates

SECOND Converts a serial number to a second

TIMEVALUE Converts a time in the form of text to a serial number

WEEKDAY Converts a serial number to a day of the week
WORKDAY* Returns the serial number of the date before or after a specified number
of workdays

YEARFRAC* Returns the year fraction representing the number of whole days between
start_date and end_date

* Available only when the Analysis ToolPak add-in is attached
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Function What It Does

BESSEL* Returns the Bessel function Jn(x)

BESSELY* Returns the Bessel function Yn(x)

Converts a binary number to hexadecimal

DEC2BIN* Converts a decimal number to binary

DEC20CT* Converts a decimal number to octal

ERF* Returns the error function

GESTEP* Tests whether a number is greater than a threshold value

Converts a hexadecimal number to decimal

IMARGUMENT*  Returns the argument theta, an angle expressed in radians

IMCOS* Returns the cosine of a complex number

IMEXP* Returns the exponential of a complex number

IMLOG2* Returns the base-2 logarithm of a complex number
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Function What It Does

IMPRODUCT* Returns the product of two complex numbers

IMSIN*

IMsuB* Returns the difference of two complex numbers

OCT2BIN* Converts an octal number to binary

OCT2HEX* Converts an octal number to hexadecimal

* Available only when the Analysis ToolPak add-in is attached

Function What it Does

Returns the acaued interest for a security that pays interest at maturity

AMORLINC* Returns the depreciation for each accounting period

COUPDAYS* Returns the number of days in the coupon period that contains the settle-
ment date

COUPNCD* Returns the next coupon date after the settlement date

COUPPCD* Returns the previous coupon date before the settlement date

Cantinued
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Function What It Does

DB Returns the depreciation of an asset for a specified period, using the fixed-
declining balance method

DIsC* Returns the discount rate for a security

Converts a dollar price, expressed as a decimal number, into a dollar price,
expressed as a fraction

EFFECT* Returns the effective annual interest rate

eturns the future value of an initial principal after applying a series o
compound interest rates

ISPMT Returns the interest associated with a specific loan payment.

MIRR Returns the internal rate of return where positive and negative cash flows
fi d at different rat

NPER Returns the number of periods for an investment

ODDFPRICE* Returns the price per $100 face value of a security with an odd first period
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Function What it Does

ODDLPRICE* Returns the price per $100 face value of a security with an odd last period

PMT Returns the periodic payment for an annuity

PRICE* Returns the price per $100 face value of a security that pays periodic interest
PRICEMAT* Returns the price per $100 face value of a security that pays interest at
maturity

RATE Returns the interest rate per period of an annuity

SLN Returns the straight-line depreciation of an asset for one period

TBILLEQ* Returns the bond-equivalent vield for a Treasury bill

YIELD* Returns the vield on a security that pays periodic interest

YIELDMAT* Returns the annual vield of a security that pays interest at maturity

* Available only when the Analysis ToolPak add-in is attached
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Function What It Does

ISERR Returns TRUE if the value is any error value except #N/A

ISEVEN* Returns TRUE if the number is even

ISREF Returns TRUE if the value is a reference

N Returns a value converted to a number

TYPE Returns a number indicating the data type of a value

* Available only when the Analysis ToolPak add-in is attached

Function What It Does

NOT Reverses the logic of its argument

TRUE Returns the logical value TRUE
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Function What It Does

AREAS Returns the number of areas in a reference

GETPIVOTDATA  Returns data stored in a PivotTable

HYPERLINK Creates a shortcut that opens a document on your har
the

rive, a server, or

INDIRECT Returns a reference indicated by a text value

ROW Returns the row number of a reference

Function What It Does

ACQOS Returns the arccosine of a number

Returns the arcsine of a

Cantinued

CiM Ex. 1054 Page 225



Function What It Does

ATANZ Returns the arctangent from x and y coordinates

CEILING Rounds a number to the nearest integer or to the nearest multiple of
significance

cos Returns the cosine of a numbe

COUNTIF Counts the number of nonblank cells within a range that meets the given
aiteria

EVEN Rounds a number up to the nearest even integer

FACT Returns the factorial of a number

FLOOR Rounds a number down, toward 0

INT Rounds a number down to the nearest integer

MINVERSE Returns the matrix inverse of an array

MOD Returns the remainder from division

MULTINOMIAL* Returns the multinomial of a set of numbers
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Function What it Does

POWER Returns the result of a number raised to a power

QUQOTIENT* Returns the integer portion of a division

RAND Returns a random number between 0 and 1

ROMAN Converts an Arabic numeral to Roman, as text

SIN “‘AReturns the sine of the given angle

SQRT Returns a positive square roat

SUBTOTAL Returns a subtotal in a list or database

SUMIF Adds the cells specified by a given criteria

SUMSQ Returns the sum of the squares of the arguments

SUMX2PY2 Retumns the sum of the sum of squares of corresponding values in two
arrays

TAN Returns the tangent of a number

TRUNC Truncates a number to an integer

* Available only when the Analysis ToolPak add-in is attached
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Function What It Does

AVERAGE

BETADIST

CHHNV Returns the inverse of the one-tailed probability of the chi-squared
distribution

CONFIDENCE Returns the confidence interval for a population mean

COUNT Counts how many numbers are in the list of arguments

COUNTBLANK Counts the number of blank cells in the argument range

Returns covariance, the average of the products of péired deviations

DEVSQ Returns the sum of squares of deviations

FDIST Returns the F probability distribution

FISHER

FORECAST Returns a value along a linear trend

FTI EST ” Returns the rééult of an F—test
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Function What It Does

GAMMAINV Returns the inverse of the gamma cumulative distribution

GEOMEAN Returns the geometric mean

HARMEAN Returns the harmonic mean

INTERCEPT Returns the intercept of the linear regression line

LOGNORMDIST “éetums the cumulative lognormal distribution

MAXA Returns the maximum value in a list of arguments, including logical values
and text

MIN Returns the minimum value in a list of arguments, ignoring logical values
and text

Returns the normal cumulative distribution

NORMDIST

NORMSDIST Returns the standard normal cumulative distribution

PEARSON Returns the Pearson product moment correlation coefficient

PERCENTRANK  Returns the percentage rank of a value in a data set

Continued
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Function

POISSON

QUARTILE Returns the quartile of a data set

RSQ Returns the square of the Pearson product moment correlation coefficient

SLOPE Returns the slope of the linear regression line

STANDARDIZE Returns a normalized value

STDEVA Estimates standard deviation based on a sample, induding text and
logical values

STDEVPA Calculates standard deviation based on the entire population, including
text and logical values

TDIST Returns the student’s ¢-distribution

TREND Returns values along a linear trend

TTEST Returns the probability associated with a student’s t-Test

VARA Estimates variance based on a sample, including logical values and text

VARPA Calculates variance based on the entire population, including logical
values and text

ZTEST Returns the two-tailed P-value of a z-test
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Function What it Does

CLEAN Removes all nonprintable characters from text

CONCATENATE  Joins several text items into one text item

EXACT Checks to see whether hwo text values are identical

a fixed‘ndinlﬁer‘ of dééimals

MID Returns a specific number of characters from a text string, starting at the

REPLACE Replaces characters within text

RIGHT Returns the rightmost characters from a text value

SUBSTITUTE Substitutes new text for old textin a text string
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Excel’s Shortcut
Keys

I his appendix lists the most useful shortcut keys that are
available in Excel. The shortcuts are arranged by context.

The keys listed assume that you are not using the Transition
Navigation Keys, which are designed to emulate Lotus 1-2-3.
You can select this option in the Transition tab of the Options
dialog box.

Key(s) What If Does

End* Moves to the lower-left cell displayed in the
window

PgUp ' Moves up one screen

Moves down one screen

Alt+PgUp Moves one screen to the left

Ctrl-+Home

Continued
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Key(s) What It Does

F5 Prompts for a cell address to go to

Shift+Fé6 Moves to the previous pane of a workbook that has been split

Ctrl+Shift+Tab ~ Moves to the previous window

*with Scroll Lock on

Key(s) What It Does

Ctri+* Selects the block of data surrounding the active cell

Ctrl+G Prompts for a range of range name to select

Shift+Backspace Selects the active cell in a range selection
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Key(s) What It Does

Citrl+Tab Moves the cell pointer to the next cell range in a nonadjacent selection

Shift+Backspace  Collapses the cell selection to just the active cell

Key(s) What It Does

End Moves the cursor to the end of the line

Ctri+left arrow Moves the cursor one word to the left
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Key(s) What It Does

Ctrl+B Sets or removes boldface

Ctrl+U Sets or removes undetlining

Ctri+Shift+#  Applies the date format {(day, month, vear)

Cri+shift+$  Applies the currency format with two decimal places

Alt+" Selects Format« Style

Key(s) What It Does

Ctrl+; Enters the current date

Ctrl+1 Displays the Format dialog box for the selected object
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Key(s) What It Does

Ctri+8 Toggles the display of cutline symbols

Ctri+A

Ctrl+D Selects Edit+ Fill Left

Ctrl+F Selects Edit+ Find

Ctrl+Insert Selects Edit Copy

Ctrl+N Selects File« New

Ctrl+pP Selects File+ Print

Ctrl+s

Ctrl+Shift+A After typing a valid function name in a formula, inserts the argument names
th i

Delete Selects Edit Clear
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Key(s) What It Does

Shift+F1 Displays the What's This cursor

Shift+F2 Edits a cell comment

Alt+Shift+F2 Issues Save command

Shift+F3 Pastes a function into a formula

Ctri+Shift+F3 Displays the Creates Names dialog box, to create names using row and
column labels

Alt+F4 Exits the program

Shift+F5 Displays the Find dialog box

F6 Moves to the next pane

F7 Issues Spelling command

F8 Extends a selection

Ctri+F8 Resizes the window

CiM Ex. 1054 Page 238



Key(s) What It Does

Calculates the active worksheet

Ctrl+F10 Maximizes or restores the workbook window

Shift+F11 Inserts a new worksheet

Alt+F11 Displays Visual Basic Editor

Ctrl+Shift+F12  Issues Print command

 SOREEEISIEE BRSNS SER
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What's on the
CD-ROM

I his appendix describes the contents of the companion
CD-ROM.

CD-ROM Overview

The CD-ROM consists of four components:

* Chapter Examples: Excel workbooks that were discussed
in the chapter of this book.

» Bonus Files: Additional Excel workbooks and add-ins
that you may find useful or instructive. These were all
developed by the author

* Power Utility Pak: The shareware version of the author’s
popular Excel add-in. Use the coupon in this book to
order the full version, and save $30.

* Sound-Proof: The demo version of the author’s audio
proofreader add-in.

Chapter Examples

Each chapter of this book that contains example workbooks
has its own subdirectory on the CD-ROM. For example, the
example files for Chapter 32 will be found in the following
directory:

chapters\chap32\

Following is a list of the chapter examples that follow a brief
description of each.
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Chapter 3

This workbook contains the end result of the hands on exercise.

handson . x1s

Chapter 6

This workbook contains a variety of custom number formats.

formats.x1s

Chapter 10

This workbook demonstrates the use of PMT, PPMT <« and IPMP functions to calculate
a fixed-rate amortization schedule.

amortize.x1s

This workbook demonstrates the use of the INDEX and MATCH functions to display
the mileage hetween various cities.

mileage.x1s
This workbook demonstrates the use of the INDIRECT function.
indirect.x1s

This workbook demonstrates the use of a lengthy “megaformula”™ to remove the
middle names and middle initials from a list of names.

megaform. x1s

Chapter 11

This workbook contains many examples of cell and range formatting.
fmtexamp.x1s
This workbook contains custom style examples.

styles. xls

Chapter 16

This workbook demonstrates how to create a Gantt chart.

gantt.xls

CiM Ex. 1054 Page 242



This workbook demonstrates how to create a comparative histogram.

comphist.x1s

This workbook contains a chart that updates automatically when you add new data
to the data range.

autochart.x1s

Chapter 18

This budgeting workbook demonstrates the use of row and column outlining.
outline.xls
This workbook demonstrates the use of an outline to display various levels of text.

textout.x1s

Chapter 20

This workbook demonstrates some uses for array formulas.

arrays.xls

Chapter 24

The dBASE file is used for the examples in this chapter.

budget.dbf

Chapter 25

This workbook is used for several pivot table examples.
bankirng.x1s

These four files are used in the pivot table consolidation example.
censolid.oxls, filel.xls, filez.xls, filed.xls

This workbook demonstrates pivot charts.
pivchart x1s

This workbook demonstrates a survey data analysis using pivot tables.

survey.x1s
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This workbook demonstrates a geographic analysis using a pivot table.

geog.x1s
This workbook demonstrates how to group pivot table data by dates.

pivdates.x1s

Chapter 27

This workbook is set up to demonstrate the shipping costs example using Solver.
shipping.x1s

This workbook is set up to demonstrate the staff scheduling example using Salver.
schedule.x1s

This workbook is set up to demonstrate the resource allocation example using
Solver.

allocate.x1s

This workbook is set up to demonstrate the investment portfolio example using
Solver.

invest.x1s

Chapter 32

An Excel version of tick-tack-toe.
tictac.xl1s

An Excel version of the common moving tile puzzle.
mevebile.xls

An Excel version of Keno.
keno.x1s

This workbook calculates the odds of winning in Keno.
kenoodds . xTs

This workbook contains seme animated Shape ohjects.
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animshap.x1s

Create colorful symmetrical patterns in Excel.
pattern.x1s

This workbook displays a guitar fretboard and the notes in various scales and keys.
guitar.x1s

This workbook contains a macro which reverses the text in Excel’s menus.
menushern.x1s

This workbook creates word search puzzles.
wordsrch.x1s

This workbook contains examples of ASCII art.
asciiart.x1s

This workbook lets you play sound files (WAV or MID format).
scunder.xls

This workbook displays interesting charts that use trigonometric functions.
trigfun.xls

This workbook lets you draw simple figures that are actually X-¥ charts.

xysketch.xTs

Chapter 33

This workbook contains a custom toolbar to assist with formatting.

tcolbar.xls

Chapter 36

This workbook contains several examples of custom worksheet functions written

in VBA.

funcs.xls
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Chapter 37

This workbook contains a utility (with a custom dialog box) to make it easy to
change the case of text in cells.

chngcase.x1s

Chapter 38

This workbook contains examples of Excel’'s ActiveX controls.

activex.xls

Chapter 39

This is VBA macros that demonstrate how to copy a range of cells.
rngcopy.xls

This is VBA macros that demonstrate various ways to select a range of cells.
select.xls

This is VBA macros that demonstrate how to loop though a range of cells.
lTcop.xls

This is VBA macros that demonstrate how to prompt for a value and insert the
value into a cell.

Prompt.x1s

This is VBA macros that demonstrate how to determine the type of object that is
selected.

seltype.xls

This is VBA macros that demonstrate how ta create a text box.
textbox.x1s

This is VBA macros that demonstrate how to call attention to a particular cell.
explode.x1s

This is VBA macros that work with chart objects.

chartmacs.x1s
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Chapter 40

This add-in contains a utility to make it easy to toggle various settings in Excel. This
add-in is not protected, so you can view or modify the code.

toggles.xla

Bonus Files

The files contained in the Bonus directory aren’t discussed in the book, but vou
may find them helpful. These files consists of Excel add-ins and standard Excel
workbooks. On the CD-ROM, they appear in the following directories:

becnusiaddins\
bonusiwkbooks\

Add-Ins

This section contains a list of the add-ins on the companion CD-ROM, with a brief
description of each.

To install an add-in, first copy it to a directory on your local hard drive. Then, in
Excel, select Tools « Add-Ins. In the Add-Ins dialog box, click Browse and locate
the *.xla file that you want to install.

The Add-ins dialog box lists all add-ins that Excel knows about. The add-ins that
are checked will be loaded each time Excel starts. To reduce the startup time for
Excel, remove the checkmark from any add-ins that you don't use.

daterept.xla

An add-in that generates a useful report that describes all date cells in a worksheet.
This may help vou identify potential Year 2000 problems.

faceid.xTa

An add-in that makes it very easy for developers to determine the FacelD value for
a CommandBar image. Useful if you develop custom menus in Excel.

dataform,x1a

An add-in that provides an alternative to Excel’s Data * Form command.

Workbooks

Below is a list of workbooks that follow a brief description of each.
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This workbook demonstrates a technique that makes it very easy to create a
custom menu for an Excel workbook or add-in. VBA programming not required!

menumakr . x1s

This workbook demonstrates a technique ta display help topics in Excel.
helpmakr.x1s

This workbook contains an easy-to-use time sheet for tracking daily hours worked.
Cimesht.x1s

This workbook lets you generate and print daily appointment calendar pages.
apptcal.xls

This macro generates all possible permutations of a string. Uses a recursive YBA
subroutine.

permute . x1s

Power Utility Pak

Power Utility Pak is a collection of Excel add-ins developed by the author of this
book. The companion CD-ROM contains a copy of the shareware version of this
product. The shareware version contains a subset of the features.

The CD-ROM contains PUP97. PUP97 works with both Excel 97 and Excel
2000. A significantly enhanced version, PUP2000, was being finalized as this
book went to press. [f you would like to try the shareware version of
PUP2000, download a copy fronx:

hittp://www.j-walk.com/ss/pup

Registering Power Utility Pak

The normal registration fee for Power Utility Pak is $39.95. However, you can use the
coupon in this book to get the full version for only $9.95.

Installing the shareware version

To install the shareware version of Power Utility Pak:

1. Make sure Excel is not running.
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2. Locate the pup97r3.exe file on the CD-ROM. This file is located in the pup\
directory.

3. Double-click pup97r3.exe. This will expand the files to a directory you specify
on your hard drive.

4, Start Excel.

5. Select Tools « Add-Ins and click the Browse button. Locate the power97.xla
file in the directory you specified in Step 3.

6. Make sure Power Utility Pak 97 is checked in the add-ins list.
7. Click OK to close the Add-Ins dialog box.
The procedure described above will install Power Utility Pak, and it will be available

whenever vou start Excel. When the product is installed, you'll have a new menu:
Utilities. Access the Power Utility Pak features from the Utilities menu.

Power utility Pak includes extensive on-line help. Select Utilities « Help to
view the Help file.

To uninstall Power Utility Pak

[f you decide that you don’t want Power Utility Pak, follow these instructions to
remove it:

1. In Excel, select Tools + Add-Ins

2, In the Add-Ins dialog box, remove the checkmark from Power Utility Pak 97.
3. Click OK to close the Add-Ins dialog box

After performing these steps, you can re-install Power Utility Pak at any time by plac-
ing a checkmark next to the Power Utility Pak 97 item in the Add-Ins dialog box.

To permanently remove Power Utility Pak from your system, delete the
directory into which vou originally installed it.

Sound-Proof

Sound-Proof is an Excel add-in, developed by the author of this book. Sound-Proof
uses a synthesized voice to read the contents of selected cells. It’s the perfect
proofreading tool for anyone who does data entry in Excel.

Cells are read back using natural language format. For example, 154.78 is read as
“One hundred fiftyfour point seven eight.” Date values are read as actual dates (for
example, “June fourteen, nineteen ninety-eight™) and time values are read as actual
times (for example, “Six forty-five AM™).
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The companion CD-ROM contains a demo version of Sound-Proof. The full version
is available for $19.95. Ordering instructions are provided in the online Help file.

The only limnitation in the demo version is that it reads no more than 12 cells
at a time.

Installing the demo version

To install the demo version of Sound-Proof:

1. Make sure Excel is not running.
2. Locate the sp.exe file on the CD-ROM. This file is located in the sp\ directory.

3. Double-click sp.exe. This will expand the files to a directory you specify on
your hard drive.

4, Start Excel.

5. Select Tools » Add-Ins, and click the Browse button. Locate the soundpri.xla
file in the directory you specified in Step 3.

6. Make sure Sound-Proof is checked in the add-ins list.

7. Click OK to close the Add-Ins dialog box.
The procedure described above will install Sound-Proof, and it will be available
whenever you start Excel. When the product is installed, you'll have a new menu

command: Tools » Sound-Proof. This command will display the Sound-Proof
toolbar.

To uninstall Sound-Proof

If you decide that you don’t want Sound-Proof, follow these instructions to remove it:

1. In Excel, select Tools + Add-Ins
2. In the Add-Ins dialog box, remove the checkmark from Sound-Proof.
3. Click OK to close the Add-Ins dialog box

After performing these steps, you can re-install Sound-Proof at any time by placing
a checkmark next to the Sound-Proof item in the Add-Ins dialog box.

To permanently remave Sound-Proof from your system, delete the directory
into which vou originally installed it.
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ABS funcliion, 471
absolute cell referencing, 178, 1791806,
181, 151
absolute recording, 768769
acceierator (ho) key, B6, £5, 820, See
aizo shortcut keys
accountiog lormat, 107
ACCRINT function, 660
ALCRENTM function, 660
aciivating worksheets, 122
active area, 264
identifying, 354
active cefl, 48
custom views of, 278
active cell indicator, 26
active obiscts, 774
actlve window, 45
active workbooks, 43
ActiveX controls, 824, See also Control
Toolow toatbar
adding to worksheet, 825.-826
finking 1o cells, REB-B2Y
add-dis, 13, B4, 625, 8B37-8489, Yee also
snalysis ToolPak; Solver
creating, BH0-868

adding descriptive information,

B&T
exampie of, BH2
protecting project, S687-568
reasons for, BE0
sefting up workbook, 862-865
testing workbook, B65-866
custoim, 757
custom functions in, 791
defined, 857
inciaded with Excel, 859
opening, REB-869
uses of, 857858
addition operator, 170, 172
addresses of cells, 48, 138
alternate, 140
AzdTextbnx method, B48
advanced fillering, 522-528
criteria vange, 523524
criteria types, 525528
masttiple oriteria, 523
other operations, 548
alert messages, preventing, 852-853
alignment, 117
cell, 242-246
horizontal, 242-244
text control ontions, 244245
verical, 244

of drawing ohbjects, 331
All references list box {Consoclidate
diglog box), 453
All+Enter, 118
AMORDEGRL functiog, 660
AMORLING function, 660
ampersand (&), 270
Analysis of Variance, 642-643
Analysis ToolPek, 10, 474, 635667, 859
fupctions, 232, 643, 657-662
Date & Time category, 657-858
Engineering category, 658-65%
Financtal category, 650-661
information category, 651-662
Math & Trig category, 662
overview of, §35-640
1ools in, 640657
Analysis of Varlance, 642-643
correlation, 643-644
Covariance, $44
Descriptive Statistics, 545-646

Exponential Smoothing, 646-647

Fourier Analvsis, B48
E-Test (Two-Sample Test for
Variance), 647-648
Histogram, 648-549
Moving Average, 650451
Randomw Number Geperalion,
631652
Rank and Fercentila, 852-653
Regression, 853655
Sampling, 655
658, 657
Test (Two-Bample Test for
Mezns), 656657
analytical tools, 10
AND funetion, 218
AMD operator, 524
auimated GIF files, 320
anbmated meny, 737
animated shapes, 720721
anndation, 10. See also comments
of colls, 147-148
of charts, AutoShapes for, 341
anauily functions, 224-225
application
destination, 500, 668
multiuser, 480
sources, 500, 666
apptication object, 777
April Fool's prank (game), 722-723
area charts, 283, 288, 287, 304
Arezs method, 846
argumenti(s), 201-203

arrors in, 182
expressions as, 202-363
Formuia Palette to specify, 205-206
literal, 202
names as, 202
other functions as, 203
of VBA functions, 792--796
ne argument, 792
one argument, 793-794
range argnment, 795750
two arguments, 794-795
arrayis)y, 457-458
formatting, 464
looping with, 46462
one-dimensional, 457
selecting current, 146
selecting range of, 404
two-dimensional, 457
array constants, 464467
array feature, 10
array formulas, 198, 457478
advantages of, 459
for calendar calewlation, 476-477
for compuiing maxbmum and
minimun changes,
465470
for counting characiers inorangs,
468457
dufined, 458
disadvantages of, 455
in dynamic crosstab table, 475-476
aditing, 483464
entering, 463
exterpal inks stored in, 870
for frequency distributions, 473-474
for identifying value in rangs,
GHT-467
ia ane cell, 461
for ranking, 472473
for returning last value in cobumn,
476
for returning last valoe in row, 476
standard formulas vs,, 459460
for summing digits 1o 2 value,
A70-477,
ior summing nih value in 2 range,
471472
tips for, 477478
arrow keys, durng data endry, 116
ABCH art, 724, 723
~a1” sign (@), 201
attributes, cell, 113
Auditlng toolbar, 703-704
Trace Ervor sutton of, 705
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auditing 1ools, 354, 706707
for tracing cell relationships,
F-708
auditing, worksheet, 10
Australia, map of, 408, 423
AutoCompiete, 117, 514, 710-711
AutoCorrect, 11, F18-1206, 174, 708-710
formula, 700
AutoFHi, 117
1o copy adjacent cells, 153
instead of formulas, 187
AutoFiltering, 517-522
charting list data, 522
custom, 520-521
floalrs of, 518
mudticolumn, 579-520
Top 19, 521
AutoFormat, 32, 33-34, 253256
cvontrolling, 256
using, 2542658
Automatic Calewation mode, 183,
184
automatic menu customization, 55
AutoSave, B4, 859
autosensing, toolbar, 737
AutoBhapes, 327-330
for annotating charts, 341
around range, 849850
calling attention to cell, 336, 337
to change look of cell conuments,
338-333%
changing defanits, 333
examples, 136342
flow diagrams using, 340
formatting objects, 328330
inserting text in, 335
Hinked to cell, 330-340
orgenizational charts using, 338
shadow and 3D effects, 333-334,
336-337
shape categories, 327
AutoBurmn button, 31, 58, 212
AVERAGE function, 208, 229, 4614562
axes on charts, 289, 3685, 367, 372-374
modifying, 372-373
patterns of, 373-374
scales of, 374-376
secondary, 389-390

B
background, 252-253
backing up files, 50
backsolving. See singlecell goal sesking
Backspace key, 101
BAK files, 72, 83
bar charts, 285, 304-305
stacked, 389400

Begins with operator, 549
Bernouill distribastion, 852
BESSEL function, 558
BESSELS functien, 658
BESSFLK funcjon, 638
BESSELY function, 658
bin range, 643
BINZDEC funetion, 658
RBINZHEX function, 658
BINZOCT function, 658
binders, data sharing using, 882
binding constraints, 826
bincimial distribution, 652
birap files, 499
Bitmap images, 321
pasting, 672, 674
Dlack-and-white printing, 272
Dlavk cells, selecting, 146
blanks, skipping when pasting, 160
BMP files, 322
Bomb Hunt, 718-715
book.xlt file, 748, 749
Boojean settings, 847
borders, 113-114, 245-252
skipping when pasting, 159
brackets in formula bar, 4683

brawse button (Consolidate dialog box),

453
browser, defined, 586
bubble chiarts, 285, 312-313
budget spreadsheets, 347
bution coutrols, 63
Button BEditor, 744-745
button(s), tonibar
adding/removing, 738-739
applying styles with, 258
assigning macros io, 770
attaching macros to, 813-814,
B15-820
AutoSum, 31, 58, 212
Bold, 34

changing iunctionality of, 740-741

changing imags of, 740. 744746
Close, 23, 25

on Control Toolbox Tocibarx, 825
Copy, 58

copying ranges using, 145
custom, 756

Maxdmize, 25

Minhmize, 23, 24

Mew Workbook, 74
number{formatiing, 163

Open, 76

option (radio), §5-66

other operations on, 740-741
Print, 263

Restore, 23

tab-scrofling, 122

C

caloudated field, 582-583
calenlated items, 583-585
Calculation modes, (83184, 847-848

calcnlator, Formula Bar as,

walendar calculation, arvay
AT6-477

Canada, map of, 408, 423

case seasitive sort order, 534

Case statement, 780
category axis, 283
category axis title, 369

category, consplidating worksheets by,

452
category flelds, 562

category shading map format, 412-413

DR files, 322
cell{s), 135-168
active, 48
addresses of, 48, 139
alternate, 140
alignment of, 242-246
horizontal, 242244

text control options, 244-245

vertical, 244
annotating, 147-148

arrey formulas in one, 461
AutaShapes Hnked to, 335-340

changing, 607, §14-8135,
color coding of, 703

comments in, i, 147148

AutoShapes to change look of,

338339
pasting, 159

copying ranges to adjacent, 153

defined, 3, 139

deleting contents of, 148
drawing object 1o call attention to,

336, 337

editing contents of, 99-102

erasing contents of, 99,
forcing new line in, 118

hiding betore printing, 280-281
linking dialog box controls 1o,

828829
moving, 134155

mudtiple formatiing worksheets in

one, 441242

names/nuning of, 161158
advantages of, 161

automatic, 1654-168
changing, 168
deleting, 167
manual, 152-164
redefining, 168

tabie of names, 166167

valid, 162
pasting pictures of, 341

~342

196197

forsmatas for,

623

160

162
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preformatting, 108, 353
protection of, 13
re p;a«:mﬂ contents of, 99
ing, during dats emtry, 116
stylistic fovmatiing of, 112-114
alignment, 112
attributes, 113
sorders, 113-112
colorn, 114
iont and text size, 113
pasting, 159
target, 623
tracing relstionships of, 706704
auditing tooks for, 108705
circidar references, 706
Go To Special dislog box,
F1-703
tracing ervor values, 705706
cell dependents, 701, T02--704
CELL function, 219
caell orientation, 245246
cail pointer, 115
cell precedents, 701, 702-704
cell references
absolie, 178, 179184, 181, 191
apgiving names to existing, 194-196
as arguroents, 202
circulay, 184-188, 708
entering forroulas by pointing to,
i75
in formulas, 169
frvadial, 182
mixed, 18181
nonrefative, 181
: 178, 180, 191
t)ut\i[‘t worksieet, 177-178
coil selection, see-through, 17
ceil tracers, 04
centering text, 112
change history, 484
changiog cells, 807, §14-615, 623
CHAR fun ciiO:i, 214
chart(s), 283-316, 363404
activating, 269, 363
automatically updating, 402-403
AutoShapes for annotating, 341
wxes o, 289, 365, 367, 372-37H
maoditying, 372-373
patterns of, 373-374
scales of, 374-378
secondary, 389390
changing location, 300
chart ares, 366, 367368
combination, 388
somparative histograms, 401462
creating, 35-37, 292-299
chart options, 298
“hart placement, 208299

chart type selection, 286-297
with Chart Wizard, 293209
data gelection, 295-256
with one keysiroke, 288-289
range verification and data
orientatian, 287208
customizing, 363364
dara iabels in, 365-366, 384383
data sevies for, 377-388
alding, 578379
changing, 37%-382
covtrolling, by hiding data,
354385
deleting, 378
dara table, 367, 390, 351
cleraents of, 364-385
background, 367-368
deleling, 301
moving, 361

embended, 284, 201, 293, 302, 563,

81
ervor bars in, 3687, 385-384
Fucel bandling of, 289290
Format dialog box, 365-367
formatting of, #51-852
fun with, 725-7T27
gridlines on, 354, 357, 371372
handiing nassing data, 383384
legends, 367, 370371
finked, 587
modifying, 298301
moving, 299
as ohject, 289
organizational, 33%, 481
DVETVIEW, é80-28h
pictare charts, 395-3%8
Clipboard to create, 397
graphic file 1o creste, 357
from pivot tables, BET-588
placement of, 283284
plot area. 367, 368-365
plotting wigonometric functions,
V25728
printing, 302-303
properiies of, 851
resizing, 299
selecting, 286287, 3031
313, 280, 3585, 392-384
modifving, 392
votating, 392-394
irom twodnpul data fables,
HO6~-H0T
titdes, 365, 366-370
erendlines in, 367, 386-388
tricks for making, 394398
changing worksheet value by
draggiag, 354-3%8

uniinking of

3, BH6
types of, 285288, 8

area charis, 285

bar charts. 285, 304
399400

bubbie charis, 285, 312-413

changing, 300-303

changing defawdt, 301302

cohumn charts, 285, 286, 287
28Y, 303304 5

cone charts, 285, 514-315

Custony, 380352

cvhncﬁe? charts, ;:55 314 313’5

ary from data rangs,

x.mmt. 33% 4‘!1

loe chart, 285, 306

ple charts, 285, 287, 283, 307308
% , 214315

radar charts, 285, 311

suriace charts, 285, 311-312
RY {scatter) charts, 285, 308309
WRA programming of, BE0-852
from worksheet outlines, 4440
Chart Data Labeler ulility, 3?3‘}
vhart sheots, 284, 292, 204205
Chart toolbar, 293, 294
Chart Objects mol in, 365
Chart Type tool, 253
x,har\ Wzyas(*, i%b 37, ?5"? 28, 2932495

check box{es), 66
Fized
Precision as Displayed, 100

Check Mark icon, 100

CheckBox control, 831

Civeular Reference tooibar, 185, 186

cirmilar references, 184-188, 706
indivect, 186
inteational, 186188

client-servey moded, 479

Clip Gallery, 318320

Cliphoard
creating pletare charts using,

397 -B0G
daka shariig using, 866608
mnporiing data through, 49
Oifice, 1839 150-151, 497
clearing conteats of, 157
Cifice 2060, 1 385
Windows, 156-151, 158, 497

Chpboard toolbar, 19, 60

Clipboard Viewer, 150, 497, 498, 500

Clips Online, 319

ciosing windows, 47

ciosing workbooks, 87-88
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coae(s)
for CELL laoction, 219
for custom formatting values,
105-111
defined, 759
jormatting, 109-151
for INFO function, 220
for WEERDAY function, 222
CODEL function, 214
coding. See Visual Basic for
Applications (VBAY; VBA,
programming
coefiicient, 622
of correlation, £43
collect and paste, 18-19
coliection
defined, 773
VBA, 775776
color, 114, 246-249, 251
care in using, 353
for value-shading format, 412
color coding of cells, 708
color palette, 251
coluen(s), 48, 133-137
array formulas (or returning last
value in, 476
changing wiiths of, 135-136
dejeting, 135
hiding, 136~137
inserting, 133-135
in lists, 513
preformatiiog, 513
printing headings, 272
selecting complete, 141-142
selecting, for querying, 545
sorting on two or more, 530
widths of
adjusting, in print preview
window, 275
pasting, 152
column charts, 288, 286, 287, 259,
303-304, 356
column differences, selecting cells with,
146
calumn field, 562
columm headings, 28-30, 119, 131
using as names, 195
on workbook window, 28
cohman<chart maps, 416, 417
combination chart, 388
ComboBox control, 831-832
Comma Style button, 103
coramandis). See alio shortcut keys
custom, 756
giving, 51-64
reversing, 53
using menus, 5157
using shorteut keys, 64

using shoricut menus, 57-58
using toolbars, 58-63
help for, 58

T
for annntating cells, 147148
for applying names to cedl

references, 195
far cell or range operations,
154-155
for changing column widths, 136
for vhanging row heighty, 136
for charxts, 30, 302
for consolidating worksheets,
451454
for copying ranges, 151, 153
for creating new workbook, 74
for creating picture of cell or
range, 341
custon: views, 278
for data tables, 390, 599
for deleting cell contents, 99
for emsbedding objects, 680
for freeving/unfreezing panes,
132
Goal Seek, 520
for hiding/unhiding rows and
colwans, 136-137
for hiding/unhiding worksheets,
126
hyperlink, 693
for importing from camera or
svanner, 324
for importing graphics, 320
for inserting cells, 133
for inserting rows and celumns,
134
for tinking, 671
macyrg, 761
for mailing, 487
for maklng selections, 137, 145
for names, 165, 166, 1687, 168
for opening existing workbook,
75
for outlines, 439
for page breaks, 276
{or pasting, 158, 176
for queries, 554
ior saving workbooks, 8
for saving workspace, 88
for splitting panes, 130
for styles, 2559260
for zocming, 127
What's This?, 58
CommandBar. See toolbar(s)
CommandBulion control, 832-833
inserting, 829-830
comma-separaled text files, 496

comnma-saparated value text fide format,
73
comments
it cells, 10, 147148
AutoShapes to change look of,
338-339
pasting, 159
printing, 273
selecting cells with, 146
in VBA programs, 758
conmmisslons, calculating, T93-79%4
comparative histograms, 401407
comparison aperators, 326
compatibitity, file, 7
COMPLEX function, 658
comprded criteria, 525-528
concatenation, 171
concatenation operator, 170, 172, 806
Conditional Formatting, 109
selecting cells with, 147
conditional formatting worksheets,
256-257
Conditional Sum Wizard, 85%
cone cherts, 285, 314-315
conflicts, multiple-user, 454
consistency, cross-platform. 14
consolidating worksheets, 448455
data sources for, 454-455
linking worksheets and, 442
pivot tables for, 585-587
shared workbooks Ior, 481
by using Data @ Coasclidate,
452454
by usiong formaulas, 449451
by using Paste Special, 451
constant(s)
array, 464467
in MsgBox function, B04-805
naming, 19191
selecting cells with, 148
smoothing (damping {actor), 648
congtraints, 623, 825 633-635
bindiny, 826
coutains operator, 549
context menus, See shortcut menus
{eontext meaus)
contiol(s), 12, 13
ActiveX. See ActiveX controls;
Control Toolbox toolbar
buttons, 65
chieck boxes, 66
in Controds Tootbox, 831838
CheckBox, 831
Combolioz, 831-832
CommunandBuatton, 832-833
mage, 833
Label, 833
ListBox, 833-834
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OptionBution, 834-835
SeroliBar, 835836
SpinButton, B36-837
TextBox, 4373348
Togglelutton, 838
custom dialog box, 847-810
properties of, 808-810
defined, 759
dialog hox, 64, 65-88, B23-B38
adding, 826
available, 824825
design mode and, 826
tinking to cells, 828829
macros for. 828830
properties, 8268178
reasons tor using, 823-824
Arop-down boxes, 68
lst-boxes, 67
option buttons, 65-86
range selection boxes, 66, 87
spinners, 6667
Control Tootbax toatbar, 824
CONVERT functipn, 858
copy toal, 157
copy-and-paste technigue, 668, Ser also
Clipboard
copying
budtons, Y3¥
formulas, 197
graghics Images, 667
gueries, b3
ranges, 14%-154, 840841
to adjacent cells, 153
o other sheets, 154
using drag and drop, 152153
ustng menu commands, 151, 153
using shortcu? kevs, 152
asing shortcut menus, 151
using toolbar buttons, 149
rows, 528
worksheets, 125
corpers of 3D charts, 368
CORREL function, 8
Correlation to0l, 643-644
corrupied files, 90
links to meeowver data from, 449
COUNT functicon, 230, 569
COUNTA banetion, 230, 403
COUNTBLANK lunction, 230
COUNTIF function, 225230, 473474
COUPLAYRS function, 660
COUPDAYS function, 660
COUPDAYSNG function, 664
COUPNCD Iunciion, 860
L& tion, 560
IPPCD funciion, 660
COVAR fuaction, 644
Covarianes too], 644

Create Hnks 1o source data chieck bos
{Consalidate dislog box), 453
creaiing
charts, 35-37, 292299
chart aptiong, 288
<hart placement, 288-229
chart type seleciion, 296-297
with Chart Wizard, 293-299
data selection, 295-296
with one keystroke, 288-289
picture charts, 395-399
range verification and data
ovientation, 297258
‘ormulas, 31
maps, 409-417
category shading, 412-413
colwmn-chart maps, 416, 417
combHned formats, 416
data setup, 409
dot density, 413414
formats, 410411
graduated symbod, 4314415, 417
piechart maps, 415-415
walue shading, 411412, 417
named styles, 260
new workbooks, 74-75
sproadsheats, 345358
constdering audiences, 350-351
designing workbook lavout,
351-352
deweloping a plan, 350
entering data and formulas,
352-353
formatiing, 353-354
protection, 355-357
t@sting, 354
Criteria pane, 554, 555
criteria range, 523-524
criteria, validation, 159
croppiog objects, 878
Cropping tool, 878
cross-platform consistency, 14
Curlvtelt/right arrow, 103
citbes, OLAF, 543, 568
CUMIPMT function, 560
CUNPRINCG function, §60
currency. Furo symboils of, 18
curvency fonmat, 107
Currency Style button, 183
current region, selecting cells in, 146
custom ercor bar, 386
custom (ering, 520-521
custom functions, 234, See ulso VBA
functions
custom header/iooter huttons, 270
custom munber formats, 107, 108-112
to Bide cells, 281
Custory Pin Map tool, 420

custom views, 278-279
custom workbook templates, 747,
T50-7
customer geographic analysis, using
pivot tables for, B81-582
customer lists, 481
cugtomizable toutbars, 8
custormization mode, 734
customizing, 731748
fields in pivet tables, 575576
headers/footers, 269-270
maps, 417-418
menus, 17-18
atdomalic, 38
pivol table field, 575--578
shvoricut menss, 788
tocibars, 18, 731~724
adding/removing buttons,
P38-T39
whaaging buitton functionality,
FAG-T4Y
changing bullon page, 740,
T44.-.745
<raating new toolbars, 735,
T43~744
Customize dialog box fur,
134737
mmoving tooibars. V33734
types of, 733
Cut method, 843
cylinder charts, 285, 314-315

B
damping factor {(smoothing constant},
646
dala
aprropriate for pivot tables,
562564
controlling data series by hiding,
384385
defined, 482
dumnay, 354
entering. See data entry
formatiing, 556
handling missing chart, 283-384
mporting. See importing data
“rodsy,” 387
sharing with other Windows
applications, 86581
by Hnking data, 669570
Microsolt Woed, §71-674
using binders, 582
using Clipboards, G666-868
using OLE {oblect Bakdng and
ersbedding), 674681
sorting, 556
soures, 63
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data analysis. See Analysis ToolPak;
pivol tables; single-cell goal
seeking, Solver; whal-it
analyses
data area, 582
data endry, 30, 114-120
arvow keys during, 116
AureComplete featurs, 117
AutoUorrect feature, 119-12CG
Aurofill feature, 117
aytomatic decimal points during,
116
cell pointer movernent during, 115
current dare or tipe, 117
ioreing new Hoe in cell, 118
forms for, 118-119
iractionsg, 118
into Hsts, 514517
with Data Form dialog box, 515
Microsolt Access forms for,
516-517
repeating information, 118
selecting cells before, 116
into spreadsheets, 352-353
validating, 114-115
selecting vells set up for, 147
data fields, 562
cata files, 72
Data nterchange Format (DIF), 73, 486
data labels in charts, 365-366, 382-383
Drata pane, 555
data ranyge
awomatically npdated, 402
anlinking chart frowm, 395, 396
data series, 287, 377388
adding, 378-373
changing, 379-382
Data Scurce dialog box for, 380
dragging range outline, 379-380
editing SERIES formula, 386-381
uaing narmes in SERIES formula,
381382
deleting, 378
points in, 367
selecting, 377
clata tables, 367, 390, 331, 95607
imitations of, 607
one-dnput, 800603
rwo-input, 883607
data types, 93-95
formulas, 95
text, 94
values, 9394, 95
Vi3A, BB4
data-analysis models, 346-348
database{s). Jee afc external data files;
Hst{s}
file Jorinats supported, 4933, 495
OLAP, 343, 586

caleulated fisids and, 582
calculated iteins and, 584
relationad, 542, 556
terminoiogy of, 542
database acceas, spreadshests for, 348
database functions, 231-232, 528-529,
See also specific names of
Ffunctions
with kists, 528-529
statabase managsment, 11
date(s), 37-88
custom formatting codes o,
1I0-111
entering cuyrent, 117
rouping by, 533
i pivot tables, grouping by, 593
sorring and, 335
cate format, 107
DATE functlon, 222
date functions, 221-222. See ulso specific
names of functions
date serial number system, 98
Date & Time category functions,
637658
DAVERAGE function, 529
DAY function, 222
aays, AuteFill 1o croate series of, 187
138 function, 224
dRase file formay, 73
DBF fles, 495, 539
DCOUNT function, 529
DCOUNTA fanction, 529
TDE function, 224
debugging
of formulas. See troubleshooting
of VBA functions, 796
DECZIBIN function, 65%
DECZHEX function, 655
DECOCT funcrion, 659
declmal points, autormatic insartion
during data entry, 116
Dacision Support Bervices (085
analysis, 543
Decrease Decimal bution, 103
defauit(s)
AutoBhapes, vhanging, 333
Hle formats, B6
printing
settings, 263-2064
tempiates to changs, 281
workbook location, 82
default templates, 748, 748-750
workbook, 747, 748-749
<hanging, 748740
resetting, 745
worksheet, 747, 749-750
Delete key, 99, 101
delering
cell contents. 148

elements of charts, 301
nared styles, 261
nammes, 167
queries, H53
rows and columps, 138
toolbars, 735
worksheets, 123
delimited text files, A96, 503
DELTA function, 659
dependent workbook, 441
dependenis, cell, 701, 702704
selecting nells with, 146
depreciation functions, 223
Descriptive Statistics tool, 545-646
design mode, 82§
design thme, B0
destination application, 500, 666
DGET function, 5208
dialog box(es), 6459
Add Constraint, 625
integer option of, £34
Add Scenario, 809810
Add Trendline, 387
Options tab of, 387, 388
Type tab of, 387
Add View, 279
Add-lns, 858, BA1, 869
Advanced Filter, 524, 528
Copy to Another Location
opiion, 528
Unique records option, 528
Advanced Text Jmport Seltings, 507V
Anova: 3ngle Factoy, 842
Apply Names, 195196
Arrange Windows, 45
Assign Hyperlink: Open, 746
Assign Macro, 814
AwtoCorrect, 700-710
AuvtoSave, 84
Buiton Editor, 744, 745
Chart Area, 368
Four taby of, 368
Patterns tab of, 368
Properties tab of, 368
Chart Opticos
Data Labels taby of, 382, 383
Gridiipes rab, 372
Chart Type, 300
Custom Types tab of, 380, 391
Chart Wizarxd, 36, 287-288, 287-209
Clippart, 318
Consolidate, 452-453
controls, 64, 6568, B23-338
adding, 846
available, 824-825
CheckBox, 831
Combobiox, 831-832
ComunandButton, 832833
design mode and, 226
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Image, 833
Label, 833
Hking 1o cells, 828820
ListBox, 833-834
macres for, 829-830
OpticnBuation, 834-833
properties, 826-828
reasons for using, 823-824
ScrollBar, 835836
SpiuBution, 836-837
TextBog, 8337-838
ToggleButton, 838
Correlation, 643
Create Mames, 165
{Ursate New Data Source, 544
custom, 12, 801-821
adding accelerator keys 1o, 820
alternatives 1o, #D2-806
attaching macro to button,
B13-814, B19-820
conirols, 807810
displaying, 810
event handling by, 210, 812813,
B17-819
examples of, 816-820
learning more about, B21
reagong for creating, B01-802
tab order in, 821
testing, 812, 8163817, 819
UserForms for, 807
Custom AutoFiiter, 320821
Customige, 8362, 734737
Commands tab of, 736, 738
Options tab of, 736-737
Tooibars tab of, 735736
Data Analysis, 641
Data Form, 515-516
buttons on, 518
Data Source, 380
Data Validation, 115
Define Name, 182-163, 187, 189-198,
191, 464, 485
Descriptive Btatistics, 545
Edit Buiton, 744, 745
External Data Range Properties,
£51-352, 897
fiie, 18
File in Lise, 480
File Mot Found, 445
File Now Availabie, 481
Find, 79
Format, 365367
Alignment tab of, 370
¥ont tab of, 370
to modify chart tigle properties,
375
Patterns tab of, 370
Format AutcoShape, 328-330

Alignment tab of, 330

Lolors and Lines 1ab of, 328-329

Font tab of, 330
Margins tab of, 330
Properties tab of, 334
Protection tab of, 328-330
Size tab of, 329
Web tab of, 330
Format Axis
Alignment tab of, 373
Fong tab of, 373
Mumber tab of, 373
Patierns tab of, 372, 373374
Seale tal of, 372, 375-376
Format Cells, 68, 104108, 237
MNumber tab of, 105106
Format Data Labels, 383
Format Data SBeries, 377
Axis tab of, 377, 390
Data Labels tab of, 377
Options tab of, 377
Patterns tab of, 377, 397
Series Crder tab of, 377
Shape tab, 377
X Ervor Bars zab of, 377
¥ EBrror Bars tab of, 377, 385
Format Properties
Dot Density Options tab of, 414
Legend Options tab of, 421
Pie Chart Options tab of, 416
Yalue Shading Options tab of,
411-412
FTest, 647
Function Wizard, 641
Go To Bpecial, 145146, 7017083
Goal Seek, 535, 619, 822
Graduated Symbol Options, 414
Grouping, 580
Histogram, 648.649
fmsert, 134
Ingeri Calculated Field, 583
fosert Hyperlink, 693
insert Pictare, 320
invoked through menus, 54
Links, 445, 670
Macre, 797
Map Features, 422
bap Labels, 419
Merge Scenarios. 812
Microsoft Map Contral, 410
Moving Average, 656
Mulliple Maps Available, 409
navigating using keyboard, 85
Mesw, 74, T8
Wew Wab, £95
QObject, 879
Open, 75-78, 493
Options, 133, 184

Chart tab of, 384-385
Custom Lists tah of, 335
Pags Sstup, 264, 266~273
Chart tab of, 303
Header Footer ab of, 269-271
margin adjustments, 268
Margins teb of, 268
page settings, 267
Page tab of, 267
printer-specific options, 273
sheeat optlons, 271-273
Sheet tab of, 271
Paste, 797
Paste Function, 205, 208, 232, 798
Paste Nams, 167, 178, 161
Paste Special, 155, 158, 379, 451,
571672, 673674
PivotTable and PivotChart Wizard,
565563
PivorTable Figld, 576
PivotrTable Options, 572-573
Enabie drilldown opticn, 581
Print, 264266
Opticns button, 273
FProject Properties, 867868
Properiies, 83, 264, 357
Summary fab of, 357
Protect Shest, 355
Query Wizard, 545549
Random Mumber Generation,
651652
Record Macro, 761
Hegression, £54
Resolve Unknown Geographic Data,
426
Sampling, 655
Save As, 37, 38, 81, 82-83, 86, €90
Save Options, 83
Scenario Manager, 609
Scenario Summary, 612-613
Scenario Values, 610
Settings, 438
Shared Workbook, 482, 483
Advanced tab of, 483484
Show Pages, 581582
Sotver Options, 627-628
Solver Parameters, $24
Set Target Cell field of, 625
Solver Results, 626
Sort, 532-533
Sort Options, 533-534
Source Data, 378-379
Bpecify Qecgraphic Data, 424
Spelting, 708
Style, 260, 261
Subtotal, 537
tabbed, 68-68

continiied
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diadog box{es), (cortinuad)
Table, 602
Text hnport Wizard, SIM-508

G54
UserForm, 20
Web Options, 691
WordArl Gallery, 334
Word’s Object, 877
Workshoet Auditing, 708
Zoom, 127
DIB files, 322, 499
Dice Game, 7 T
DiF (Dates Imerchange Format), 73, 496
digital camera, Bnporting graphics from,
324-325
dimmacsions, OLAF, 543, 566
direct precadent, 701
D15 function, 666
discrete distribution, 662
digplay settings, custom views of, 278
distributions, random number, 652
HDIY 0, THG
dividends, 637
division by zero, 182
division operator, 170, 172
DMAX function, 529
DMIN funciion, 529
documenting work, 356-357
documents, on Windows Taskbar, 18
does not begin with operatar, 548
d0oes not contain operator, 549
des nvt end with operator, 548
does not equal operator, 54%
DOLLARDE function, 660
DGLLARFR function, 886
BOS window, copying contents into
Clhipboard, 501-502
dot density map jonmat, 413-414
doughnut charts, 285, 310
down-bars, 367
dowrnlead, defined, 686
DPRODUCT function, 529
dealt quality printing, 272
drag amd drop, copying ranges using,
152183
drag and drop fields, 37
dragging, changing worksheet value by,
354355
draw layer, 93, 323, 325
drawing, sypumetrical pattern, 721
drawing tips, 335336
Drawing tooibar, 325-327
drawing tools, 325-334
AutoShapss, 327-230
for annotating charis, 341
caliing attention to ceil, 335, 337

: Paired Tweo Sample for Means,

1o change look of cell comments,
338-339
changing defauits, 333
axampies, 336-342
flow diagrams using, 340
formatting objects, 328-320
inserting texy in, 335
linked to cell, 339-340
organizational cheris using, 338
shadow and 3D effects, 333334,
336-337
shape categorieg, 327
objects
aligning, 332
changing stack order of, 336-331
grouptng, 331
spacing evenly, 332
pasting pictures of cells, 341-342
Wordbaet, 334-336
drawing tips, 335336
example of, 335
drop-down boxes, 68
drop-down lists, 518
droplines, 367
DRW files, 322
DBS analysis, 543
DSTOEV function, 529
TBTORVP function, 529
DEUM function, 231, 529
vumb terminals, 479
dummy data, 354
DURATION function, 8§66
DVAR function, 529
DVARP function, 529
dynamic crosstab table, array formulas
in, 475476

E
RDATE function, 658
Edit menuy, 52
editing
array formulas, 463-464
cedl contents, 98-102
iormulas, 182~183
selecting characters during, 183
functions, 200
macros, 765
records, 556
SERIES tormula, 380381
using Data Form diaiog box, 516
FFPRECT function, 660
ellipsis, menu items ending with, 84
eanail attachments, workbook malled
as, 485485
eqnail, defined, 686
embedded charts, 284, 261, 283, 302, 363
orgapizational charts, 681

epnbedding objects. See object linking
and smbedding (CLEY
EMF fiies, 322
fEnd key, 101
End method, 342
End Sub keyword, V57
ends with operatar, 540
Engineering category functions, 658659
Enter key, 101
FOMONTH function, 55
EOS files, 322
equal to operator, (V0. 172, 526
egquals operator, 349
erasing cell contents, 99, 10(. See also
deleting
ERF function, 559
ERFC function, 639
exror(s). See also rrouideshooting
returnet by formmulas, 181-182
in spreadsheels, 358-359
syntax, 772
error bars, in chart, 367, 385-386
error values, tracing, 705-705
Euro currency symbols, 19
Ewrope, map of, 408, 423
event handling, 81¢, 812-813, 817819
Fxcol 2, 4
Excel 3, 4
Fxcel 4, 4
Fxoet 5, 4, 86
Faxoel 7 (Fxcel fur Windows 95), 4.5
Excel 8 (Excal 97), 5
Excel 8. See Fared 2000 (highlighted
featuras)
Excel 97, 318
Excel 2000 (highlighted features), 4-5,
1520
active windows (n, 45
adding/removing buttons in, 739
animaied GiF files in, 320
Assign Hyperlink Teature in, 741
antormatio formula sdiustment in, 17
AutoBhapes, 327
changeable range references in, 204
Clip Gallery. 318
Clipboard operations in, 666, 867
Clipboard toojbar in, £0
Clips Onling, 319
default file forinats i, 86
documents on Windows taskbar in,
1%
enhanced Cligboard in, 18-19
Eure currency symbols in, 19
file dialog boxes in, 16
finding jost workbooks in, 79
fonts in, 113
neader/tooter Hmitations in, 271
help system in, 18
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HTML features in, 73, 348, £00
image import options, 19
impuorting inages in, 324
Insert Clip Art and Line Colar in, 327
insialiation improvements in, 15
internet featuras of, 18
acro recorder bug fix in, 769, 842
menus in, 55
modeless UserForms, 20
muitilingual features of, 24
native file format of, 492
Olfice Assistant in, 19-20
Open dialog box in, 75, 76
parts of, 2127
cluse bution, 23
formula bar, 23
mena bar, 23
winimize button, 23
name box, 23
restore button, 23
status bar, 22, 24
title Day, 22
toctbars, 23
window control menu button, 23
of workbook window, 2427
personalized rmenus in, 17-18
Pivot chart reports in, 588
PivatTable enhancement, 17
PivetTable toolbar in, 579
refreshing queries in, 552
see-through cell selection in, 17
“hee-through Yiew” in, 141
Standard and Formatting toolbars
1, B
statistical functions in, 231
templates in, 89
toolbar custoinization in, 18
YBA in, 758
Web page actlvadion from toolbar
button, 746
Web tab feature, 320
Excel 2000 Power Programming with
VBA, 771, 784
Excet (all versions), 3-14
competitors of, &
defined, 3
evolution of, 4-5
features of, 5-14
add-in capability, 13
anzalytical tools, i0
pullt-in functions, 8
charts, 9
cross-platform consistency, 14
customizable toolbars, &
database management, 11
dialog boxes, 12
drawing tools, §
easy-fo-use, 7

e compatibility, 7
integrated mapping, 9
intaractive belp, 7
mnternet support, 14
list management, 7
multiple document interiace, §
multisheer fles (workbooks), 6
OLE support, 13
pivot tables, LU
printing and print preview, 10
protection aptions, 13
seenario management, 11
spell checking and Autolarrect, 1
tempiates, 11, 12
text formatting, ¥
Yext handling, %
Visual Basic for Applications
(VBA), 12
worksheet auditing and
annotation, 10
worksheet controls, 12, 13
worksheet outlining, 10
LM macro compatibility, 11
file compatibility among versions of,
quitting, 38
starting, 21
Expense State temaplate, BY
Exponential Smoothing tool, $46-647
exponentiation opexator. 170, 172
expressions. as arguments, 262-203
externat data files, 339-557
adding and editing records in, 556
for pivot table, 565
gueries on, 540--350
changing, 5533-554
copying or moving, 5563
creating, B54-5565
deleting, 553
external daia ranges, 551554
1o get data, 541
roultiple, 353
operators for, 549
without Query Wizard, 554357
refrashing, 552-553
selecting data source, 542-545
starting, 542
using maltiple database tables,
558
using Query Wizard, 545550
reasons for using, 539-540
axternal relevence formulas, 442-446
for consoiidating workshests,
449451
creating by pasting, 443
<reating by peinting, 443
data recovery using, 449
opening workbook with, 444445

potential problems with, 447-448
syntax for, 442-443

FACTDOUJBLE function, 659
features in Excel 2000, 16

HTML as pnative file format, £80-4691

hyperlinks, 593-694

information available nn, 887

interactivity with Web documents,
691692

imailing lists, 689

newsgroups, 88

terminology of, 686

Web queries, 654-897

Web tooibar, $32~693

fietd(s)

adding, 275
calculared, 582-583
caregory, 562
colurmnn, 562

data, 562

defined, 542

drag and drop, 570
page, 561, 562, 571
vemoviag, 575

row, 563, 574

field butions, 374
file(s?, T1-90. Sez also external data

files; table(s) workbook(s)
add-n, &
Backing up, 90
corrupted, 90, 449
data, 72
defined, 71, 482
display preferences, 7778
manipatation of, 71
mltisheet. See workbook(s)
naming rales for, 82
properties of, Ti-72
read-anly, 480
template. See templateds)
workspace, 58

fie compatibility, 7
file dislog boxes, 16
fite formats, 73, 492-496

database, 493, 495

HTML, 16, 73, 493, 494, 886, 690681
Lotus §-2-3, 493, 454485

othar, 493

Duattre Pro, 73, 453, 495

text, 493, 485436

file reservation, 479-481

File < Save As command, 447
file security, 83

filz servers, 16, 479, 480

backup copies on, 90

CiM Ex. 1054 Page 259



File Transier Protocol (1P), 686
Fili Color too], 301
4H hansdie, 29, 148
filtering
by file type, 77
lists, 317528
advancad, 522528
AntoFiltering, 17522
for gueries. 546
Flnancial category functions, 660-661
financial notions, 223225 See giso
specific names of functions
depreciation, 223-224
ioan and annuity, 224225
financial models, 346-348
finding files, 79
finding lost workbooks, 79
first key sovt order, 533
first page number, 267
fixed vaiue exror har, 385
flpating tooibars, 59
flooyr of 3D charts, 367, 392
fiow diagrams, 340
folder(s)
holding existing workbooks, 77
Personal, 82
wiStert, &80
font(s), 113, 237242
changing, 239-241
clefandt, 238-239
displaying, 736
problems with, 279
i spreadshests, 353
TrueType, 279
footers, 269-271
msttiiine, 271
Form Wizard, 518
formatting
of arrays, 464
of AutoShaps objects, 328330
of ceils, by pasting, 159
of chiaris, 851-852
Conditional, 108
selecting cells with, 147
of data, 556
of ponbers, automatic, 103
of spreadsheet, 353-354
stvlistic. See stylistc formatting
of tables, 31.-34
pivot tables, 376-577
of texts, 9
of valuses, 102-112
automatic, 103
custom, 107, 108112
types of, 104108
nsing shoricut keys, 104
using toclbar, 103104
formatiing codes, 108-111

Formaiting toolbar, 38-89, 103104, 237
forms
data sotry, 118-119
Microscit Access, 3168517
Formns toolbar, 824
toymulals), 169198, Sze aiso arvay
formulas; function(s;
Autolorrect featurs for, 174, 700
AumoFill instead of, 187
autematic adjustment in, 17
calculation of, 183184
cell referencing in
absolute, 178, 179-180, 181, 191
circular, 184188, 706
invatid, 182
nonrelative, 181
relative, 178~178, 184, 181
outside worksheet, 177-178
color eoding of cells with, 783
comsoidating worksheets by using,
449451
converting to values, 197-138
creating, 31
as data type. 95
debugging. See troubleshonting
editing, 182-183
selecting character daring, 183
elements of, 169
entering, 174178
manual, 175
pasting names, 176
by polating, 175-176, 178
in spreadshest, 352-353
error returned by, 181-182
exampies of, 170, 171
expopential smoothing and, 646
external reference, 442446
creating by pasting, 443
creating by pointing, 443
vpening workbook with, 444445
potential problams with,
447-445
syntax {or, 442443
filtered lists and, 519
“hard coding” values in, 194, 358
inserting, 758
intermediary, 232-234, 469
making exact copy of, 197
nares [n, 180156
applied to axisting velerences,
194196
constants, 190-181
multisheet, 189-150
sheet-devel, 188189
narming, 191-192
operators in, 169, 170174
prevedence of, 172-174
outlines and, 434

pasting as valses, 155
perlorming mathematical operations
without, 159160

selecting cells with, 148
summanry, 434
vigwing, 712

Formmla Bar, 23, 97, 100, 101
brackets in, 463
as calculator, 196~197

formmila Hsy, 707

Formula Paiette, 100101, 208
entering formilas using, 175-17¢
for pasting functions, 204209
to specify argumants, 205206

For-hext oop, 743, 779

Fourker Analvais tool, 548

fractions, 118

freezing/unfreezing panes, 131132

“front end” for wusers, 755

frozen panes, custom views of, 275

F-Test (Two-Bample Test for Variance),
BAT-B4%

FTP (File Transfer Protocol}, 686
FTP sites, 686, 887
function{(s), 106, 199-234
Function keyword,
Function list bex (Consolidate dialoy
bax), 452
functions, 8, 174, See also VBA
funciions; specific names of
functions
acd-ing to simplify access o,
Analysis ToolPak, 841, 667-6
Date & Time category, &
Fngineering category, 658-658
Financial category, 660-661
Information category, $61-662
Math & Trig category, 662
arguments of, 261203
expressions g3, 202-203
iiteral, 202
names as, 202
other hunctions as, 203
database. 231232, 528829, See also
specific names of Farceions
with lists, 525-529
date, 221227
defined, 199, 759
editing and, 20¢
entaring, 24
manual, 203-204
by pasting, 204-267
tips for, 208-209
exaippies of, 199-200
financial, 223-225
depreciation, 223-224
foan and annuity, 224-225
informulas, 169
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nformation, 218-221
logical, 216-218
lockup, 225228
mathematical and trigonometric,
209213

nested, 203, 208
reference, 225-229
statistical, 229-231
text, 214-216
time, 221, 223
trigonometric, 725-726
wolatile, 210

Y function, 225

FYSCHEDULE function, 661

G

games, T15-724
Keno, 717
Moving Tie Puzzle, 718
in Power Utitity Pak, 717-720
Bomb Hunt, 718-719
Dice Game, 718, 719
Hangman, 719720
Video Poker, T17-718
Tick-Tack-Toe, 715~7i6
Gantt chart, 399-401
GCD tunction, 6862
general number format, 107
GESTEP function, $52
GIF files, 322
animated, 320
goal seeking, singlecell, 19, 618022
example of, 618619
graphical, 620622
graduated symbol map format, 4144315,
417
grand totals, 562
graphical goal secking, 820622
graphics, 317-325, See alio drawing
toois
bitmap vs. vector lmages, 321
Clip Gallery, 318-320
copying, 567
copying, using Clipboard, 322-323
fite farmats supported, 322
importing, 320-322
from digitel camera or scanner,
324-323
programming, 848850
graphs, See chart(s)
greater than operator, 178, 172, 526
greater than or egual 1o operator, 174
526
gridiines, 364
borders and, 114
on chart, 364, 367, 371872
printing, 272

Eroasng
by dates, 393
drawing ohijects, 331
for outiines, 435430
in pivot table, 562
guitar fret board appiication, 722

H

Hangman, 719-720
hard coding values, 596
hard disk, 71
hard disk faljure, 50
header yow, 813
sorting and, 334
neading(s), 286271
coluan, 119, 131
entering, 28-30
wyadtiling, 271
printing row and columm, 272
ow, 131
using as names, 195
on workbook window, 25
heip
for commands, 58
HTML system, 19
imteractive, 7
otiline, 784
HEXZRIN function, 859
HEXZDEC function, 659
HEX200T function, 658
HGL files, 322
hidden rows and columos, Custom
views of, 278
hiding
of cells belore printing, 280-281
cantrolfing deta serl
items in pivol tables, 876
outline syrabols, 439
rows and coluammns, 136-137
oolbars. 6182, 735
of workshesets, 125
tigh-low dines, 367
Histogram tooi, 474, 648545
histograms, comparative, 401402
HLOOCEUP function, 226
Home key, 161
horizontal cell alignmens, 242-244
horizontal serolibar, on workbook
witdow, 26
hot {accelerator) key, 56, 85, 820, See
aiso shortoat keys
HOUR functioy, 223
HTHL files, 18, 73, 493, 4596, 680691
defined, 886
pasting, 672, 674
“HTML Help” system, 19
HUEY, detined, 886
hyperlinks, 686, §93-694

fcons, large, 736
1043 Books Web site, 659
IF function, 217-218, 462
[F-Then construet, TY8-779
MABS function, 59
image control, 833
image bnport options. 19
inage on tooibar button, 744-745
images. See grapdhics
IMAGIMNARY function, 889
IMARGUMENT function, 652
IMCONJUGATE funetion, 859
IMCOB function, 655
HADIY function, 658
IMEXP function, 559
VLN function, 65%
IMLOGLO function, 859
IMLOGE function, 859
importing data, 491-50%
from another Windows application,
HO~601
through Cliphoard, 497-502
file formats supporied, 492496
database, 493, 485
HTML, 493, 456
Lotas 1-2-3, 493, 494495
other, 483
Quattrs Pro, 493, 485
text, 493, 455456
graphics, 320322
from digitad camera or scaaner,
324328
meihodas of, 4591
from non-Windows application,
501502
overview, 493
from text {iles, DO2-309
using Text Import Wizayd,
£04--509
IMPOWER function, 659
IMPRODUCT function, 659
SMREAL futction, $59
IMSIN funetion, 659
IMSQRT function, 659
IMSUB function, 559
SUM funiction, 859
Increase Decimal bution, 103
meremental values, AutoFil to create,
187
INDEX hunction, 208, 227, 228
indivect circular references, 186
TDIRECT function, 228-228
ingdirect precedent, 701
IO funclion, 220
Information category functions, 661-662
information functions, 218-221, See aiso
specific names of functions
Inputiox funcilon, 802-8(3, 444845
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insert key, 101
inserting. See aiso pasting
butions, 738
CommandBution, 849-830
formulas, 756
page broaks, 276
rows and eolumns, 133-135
text in AutoShapes, 333
text strings, 755
WordArt image. 334
msertion poia, 151
instaliation, 15
INT function, 209
intentional cirewiar references, 186-188
interactive help, 7
ipteriace. maudiipie document, 6
intermediary formulas, 469
intermediary ink, 447
internet, 685857
accessing, 687
defined, 685, 686
internet Assistant Wizard, 859
Internet Explorer, 692
Internet Service Provider {I53P), 687
inteynet support, 14
intersection operator, 192-193
intersection, range, 182, 191-194
iniranet, saving over, 15
INTRATE fuaction, 881
investment portiolio, optimizing,
H36-638
Inveice template, BY
IPMT function, 225
is betwean operator, b49
is greater than operator, 548
is greater tham or egual 1o aperator, 549
iz lews than operatoy, 545
1% less than or egual 1o operatoer, 549
iz not between operator, 549
is not Mull operatos, 549
is not one of eperator, 548
is Mull operator, 549
is one of aperatar, 543
BRLAMK function, 219
ISERR function, 219
ISERROR fuaction, 219, 220221
ISEVEN function, 662
ISLOGICAL function, 219
BNA function, 219
IBNONTEXT, 219
ENUMBER function, 219
BRODD function, B62
I8P {Internel Service Providey), 687
ISPMT funetion, 225
ISREF function, 218
IBTEXT function, 219

itemms
calculated, 383585
i pivot tables, 562, 576
feration setting, circular references
and, 185, 188

J

PG files, 322

K
Kewio, 717
keybhoard
menu maripulation with, 55-56
navigation using
through dialog boxes, 63
through worksheets, 49-50
kevhoard commands
splay shortcut menus, 58
1o manipulate windows, 47
keyhoard shorteuts. See shorteut keys
keys in chart legend, 370

L
jabai(s)
data, in charts, 36b-366, 382-383
in lists, 513
on maps, 419420
tick mark, 374
fabel control, 833
LARGE fumction, 231
izst cell, selecting, 148
tawoul, Hexible, 358
LOM function, 682
Loft arrow, 101
LEFT function, 202, 215
legends
chart, 367, 370371
map, 421422
notion, 218, 470
fess than operator, 170, 172, 526
less than or enuad 1o operator, 170, 326
ke opscator, 5349
fine break 271
lne chart, 285, 306
linear trends, 347
bnes, 249252
link{s)
for data recovery, 444
intermediary, 447
link forraulas. See external refersncs
tormdas
Yinked charts, 587
linking

data, data sharing by, 6694670
text in object to cell, 339340
workbooks, 411-448
changing link source, 446
examining links, 445
exiernal reference formulas for,
442448
reasons for, 441442
to recover data from corvupted
files, 449
severing licks, 446
o unsayed workbook, 444
updating links, 446
worksheets, consolidating
workshieets and, 442
Enk-update requests, G710
Bist{s), 51138, See also database(s)
custorer, 481
data enfry into, 514-517
with Data Form dialog box, 515
Microsoft Access {ormas for,
516-517
database functions with, 528-529
dagabase tables, 231
defiped, 511-512
designing, 513
drop-down, 518
example of, 512
filtering, 517-528
advanced, 522528
AutoFiltering, 517522
foremula, 707
mailing, 637, 689
of names, pasting, 713
nick, 514
pivol tables and, 565
size Himits on, 518
sorting, 529-636
complex, 530534
custom. 5834-535
file list, 78
simple, 530
subtotals from, 536-538
uses of, 512-513
list management, 7
spreadsheets for, 348, 348
ListBox comrol, 833-8334
list-boxes, 67
Font Size, 34, 35
igeral arguments, 202
pan and annuity functions, 224-225
logical comparison operators, 170
logical functions, 216-218. Bee also
specific names of fanctions
lookup functions, 225229, See alsc
speciFic names of functions
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Laokup Wizard, 859

looping
with arvays, 461462
through raages, 845844

Lokus 1-2-3, 5, 488, 454-495
file formats, 73
spreadsheets, 201

Lotos Word Pro, 671

LOWER function, 216

M

mracro-assisted whatdf analvsas,
597598

mackos, 161 See albo VBA functions
assigning 10 tootbar button, 770
creating, 760
defined, 537, 755, 758
for dialog box controls, 825-530
editing, 765
exarnining, 762-764
exgmple of, 765767
nun-recordabie, TE-T83
proprietary, 8568
recording, 760-762, 767-769

absolute vs. relative, 768-768

storing, 769770
testing, 764-765
KLM tangtiage, 755

mailing lists, 687, 683

mailing workbook ag s-mall attachuent,

485486
mainframe systems, 475
malntenance

of spreadshest, 358
of workbook, 358
rogjor gridlines, 372
major tick marks, 373
Manual Calcolation mode, 183
mansal what-if analyses, 587
MAP (Messaging Applivation
Programming interface), 485
maps/mapping, 405-427
adding and removing leatures,
427424
adding data to. 428
available in Microsoflt Map, 407-409
copverting to picture, 426
creatiog, 409-417
category shading, 412-413
column-chart maps, 418, 417
combined formats, 416
data setup, 409
Aot density, 413-414
fermats, 418411
graduated symbaol, 414-415, 417
pie-chart maps, 415-418
value shading, 411412, 417

customizing, 417-418
example of, 406407
integrated mapping, 9
tabels on, 419420
tegends for, 421-422
overview of, 405
pins on, 420421
pivol table data to create, 591592
plotting U.S. zip codes, 424-425
repositioning, 419
templates, 426
worksheet, 707
zooming in and out, 418-418
argln adjusiments, 268
in print preview window, 275
MATH function, 227, 228
Barh & Trig category functions, 662
mathematical junctions, 209-213. Ses
also specific nomes of
funactions
mathemmatical operations, perferming
without formulas, 158-180
malriy, covariance, 644
MAX function, 230
WMAXA function, 231
maximizedd state, 43
MDURATION funciion, §62
megaformulas, 232-224
memaory, virtual, 72
menu(s), 51-57
animated, 737
automatic customization of, B5
dialog boxes invoked through, 54
wrayed out tems on, 54
keyhoard manipulation of, 55-58
mouse manipulation of, 52-55
meoving, 56-57
personalized, 1718, 736
shorteul (context menus), 57-68
shorioul kevs associated with flems
on, 54
subunenus, 53
meny bar, 23, 51-52
as toalbar, 56
Merge and Center, 112
Merge and Center button, 35
rmerging named stvles, 261-262
messages, preventing, 852-853
Messaging Application Programming
Tateriace {MAPL, 485
methods, 778
defined, 759
of oblects, 775, 778
Mexico, Tnap of, 408, 423
Microsoft Access forms, 518-517
Microsoft Accesstinks Add-ln, 858
AMicrosoft Bookshell Integration, 859
Microsoft Clip Gallery Live, 319

Microsolt Fquation, 680, 681
Microsoft islliMouse, scrolling with,

51

Microsolt Map. See maps/manping
Microsoft Map toolbar, 418
Microsoft Query, 540, See also
guery(ies)
running alone, 556
Microsoft Windows, 21
Microsoft Word
eopving Clipboard information to,
BHT-668
data sharing, 671-674
pasting with link, 673-674
pasting without link, 671-673
new Fxeel obiect in, 677678
ranige smbedded in Word document,
675677
workbook embedded i, 679
Microsolt WordArt, 580, 681
WD funciion, 215, 476
MIN function, 230
MINA function. 231
Minesweeper, 718
minimized state, 44
minor gridiines, 372
minor tick marks, 373
mdxed cell veferences, 180-181
WO function, 471
mrdeless UserForms, 20
module, defined, 758
month(s)
AutoFill to create series of, 187
grouping by, 553
MONTH function, 222
THISE
delating cells using, 148
menu marpulation with, 52-55
navigating through windows
without, 47
navigating through workshests
using, H0-51
0 select characters, 102
moving
buttons, 738
cells, 154-155
charts, 299
elements of charts, 301
menus, 36-57
queries, 553
ranges, 154-1585
toolbars, 62-63, 733-734
wingdows, 4445
worksheets, 124-125
Moving Average tool, €560-651
Maoving Tile Puzzle, 716
MROUND function, 662
MS Organization Chart, 680
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MS Guery Add-in for Excel 5
Compatibility, 859
Mz gBox function, RE3-506
muiticolumn filtering, 519-520%
MULTINOMIAL function, 862
andtiple docwnent Interface, B
multiple selections, 142-143
multiplication operator, 170, 172
muitisheet files, See workbook(s)
multisheet names, 189190
muttisheet ranges, selecting, 143145
multivser applications, 480

N
#N/A, TOE
MA function, 182
#MNAME?, 706
Nume box, 23, 163~1864, 186
name of field button, 575
named ranges, 381-382, 515
in VBA code, 840
zooming, 128
named styles, 257-262, 358
applying, 256
controliing with templates, 262
creating, 260
deleting, 261
merging, 261-262
modifving, 261
overriding, 260
named views, 133
names/nantng, 188-196
applying o exisiing references,
194198
as arguments, 202
of cells and ranges, 161168, 171
advantages of, 161-162
automatic, 164-166
changing, 168
deleting, 167
manual, 162164
redefining, 168
table of names, 166-167
valid, 162
constants, 190~191
arrors in, 182
of files, B2
formaulas, 191192
of functions, 780
liberal use of, 358
musitishest, 189190
range intersections and, 193-194
row and colurnn headings used as, 165
in BERIES formala, using, 381-382
sheet-tevel, 188-189
worksheet views, 133
worksheets, 123-124

Navigate Clrcular Reference box, 185
navigating, 43-70
through cell content, 101
dialog boxes, 54-69
controls in, 84, 6566
by keyboard, 85
tabbed, 68-69
giving commands, 51-64
reversing, 53
using menus, 31-57
using shortout keys, 64
using shorteut menus, 57-58
usiag tooibars, 53-83
windows, 43-47
closing, 47
mouseless manipulation of, 47
moving and resizing, 44-45
states of, 43—44
switching among, 4547
worksheets, 48-51
using keyhoard, 4950
using mouse, 50-31
nested function, 208
nested parentheses, 173
nesting
of castom funciions, 786
of IF functions, 217
of SEARCH function, 218
nesting functions, 203
network server, backup coples on, 90
networks, Excel over, 475488
fite reservafions, 479-481
mailing workbook as e-mail
attachimenm, 485486
routing workbook, 4864588
shared workbooks, 481484
advanced settings for, 483484
appropriate sharing, 481
conflicting changes hetwesn
users, 484
designating, 482483
limitations of, 482
personal views, 484
tracking changes, 484
upduting changes, 484
newsgroups, 587, 688
“noisy” data, 387
NOMINAL function, 861
noucontiguous ranges, selecting,
142143
nopdelimited text files, 503
nonrelative cell references, 181
novimal distribution, 652
Bormal style, 258
BMorth America, map of, 408
not equal to eperator, 170, 528
not ke operator, 549
notes. See comments

MPER function, 225

#MULLL 708

#MUMI, THE

Mum Lock key, 49

number format, 107

numbers, formatting. See also value(s)
automatic, 103
using shortcut keys, 104
using toolbar, 103104

numerical Hmitations, 85

o

object(s)
active, 774
AutoShape, lormatiing of, 328-330
cropping, 875
defined, 759
methods of, 775, 778
pasting worksheet, 672, 674
properties of, 774-775, 776-778
sejecting cells with, 146
VBA, 775776
YVBA raanipulation of, 773
object linking and embedding (OLE),
§74-681
new Exeel object in Word, 877-678
ohjects embedded in worksheet,
679-681
range embedded In Word document,
§75-677
waorkbook embedded in Word, 679
ohiect model. 773, 774
Object Packager application, 680
object-oriented tanguage, 775
olfects, drawing
adigning, 332
changing stack order, 330-331
formatting, 328-330
grouping, 331
sizing and rotating, 329
spacing evenly, 332
QCTRZEIN tunction, 659
OUTZDEC function, 659
OUT2HEX function, 659
GDEC AddHn, 858
ODBC Manager, 545
ODBC (Open DataBase Connectivity),
A2
ODOGFPRICE function, 661
ODDFYIELD function, §61
CUDLPRICE fupction, 661
ODDLYIELD function, 663
Office 2000, 585, 532
Oifice 2000 Cliphoard, 155158
CGffice Assistant, 7, 8, 19-20
Office Client Pak, 692
Office Clipboard, 18-19, 150-151, 497
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viearing contents of, 1587
sharing data using, 666668
tooibar, 157

Office tovibay, 155

oifset block lavout, 351

OFFSET fonction, 227, 403

OLAP Cube Wizard, 566

ULAFP cubes, pivot tables and, 566

QLAY {online analytical processing

databage, 543, 566

calculated fields and, D82
caloulated items and, 584

OLE {object linking and ambedding),

674681

new Exoel object 1n Word,
677578

objects embedded in worksheet,
£75-681

range embedded W Word dovument,
BI5-H677

warkbook embedded in Word, 579
OLE support, 13
(r Ervor staiement, 551
1-2-3, See Lotus 1-2-3
one-dimensional array, 457
one-input data tables, 600603
OnKey method, 721
online analytical provessing (OLAF)
databases, 543. 566
ontine help, 7, 784
online services, 687
Dpen DataBase Connectivity {GDBC),
542
opening workbooks, 75-80
avtomatic, B
iile display peeferences, §7-78
fillering by file type, 77
speciiying folder for, V7
Tooks menn for, 78
operand ervors, 182
operatog(s), 169, 170174, See also
specific types of operators
comparison, 526
conegtensiion, 806
in formaulas, 169
inversection, 192183
precedence of, 172-174
guery, H48
range, 201
raference, 1973
option {radley buttons, 65-66
CptionButton conteol, 834-835
OR funciion, 218
OR gperator, 525
organizational charts, 338
embedded, 631
orientation, 287

well, 245-246

of field button, 576

ing by, 534

ce worksheet outlines

Page Break Preview mmode, 265, 277278
page breaks, 276-278
inserting, 276
previewing, 268, 277278
removing, 276~277
page field, 562, 571
in pivot table, 561
page nuaber, first, 2687
page settings, 267
paired two-sample Hest for means, 8568
panes
freezing. 131-132
spiitting, 130

naper size, 267
parenthsses
nested, 173
1o sef operator precedence, 172-174
Pareto (sorted histogram) optlon, 849
passwords, 83
in Protect Sheet dialog box, 358
Paste AH button, 157
pasting
consolidating worksheets by, 451
of funetions, 204-207
example of, 206207
st of names, 713
names b {ornalas, 176
pictures of cells, 341-342
of VBA functions, ¥87-79¢
pasting information, 155-161
with Office Clipboard, 155158
special ways of, 158-161
patterned distribution, 652
PO files, 322
POT fites, 322
PCX fides, 322
peor-to-peer nebworks, 473
Percent Stvle button, 103
pereantage error bar 385
percentage format, 107
Parsonal divectory, 71
Personal foider, 82
Parsonal Macro Workbook, 769-770
parsonalized menu, 1718, 738
P function, 211
ek from List menu, 117
pick lists, 14
pleture charts, 395-399
Clipboard to create, 387399
graphic file to create, 397

BN

Ficture toolbar, 344
pictures
modifying, 524
pasting, 672, §74
pictures of calls, 341342

pie chart, 285, 287, 289, 307308
pie-chart maps, 415-415
pins on maps, 426-421
Pivot Table Wizard, 550
piyot tables, 10, 213, 844, 559-593
calculaied em in, 583585
changing steuciure of, 574
oharts from, BBY-58K
compieting, 367-573
finmished product, 571
lavouy, SHB-571
options, 568, 572-373
concepi of, 558561
1o consolidate worksheets, 585
creating, 564-367
daka foo 1, HE5-566
data specification, 567
CUBtorRer gEographic analvsals using.
591552
data appropriate for, B552-564
dispiaying on different sheets,
581-588
fields In
adiiing, 575
catoulated, HR2-583
customizing, 375-576
removing, 575
formatting, 876-577
grouping by dates in, 583
grouping Hems in, 577-581
DLAP cubes and, 368
produced by Scenario Manages,

refreshing, 575
survey deta snalysis uging, BHE-ES)
terminology of, 582563
PivotChart, 17
PivorChart Wizawd, 504, Hi5
pivoting, 574
PivotTable tooibar, 436, 569-570
MvorTable, 17, 564, 565
plod area, 367, 368-360
piotiing rigonometric functions,
725725
piotting 118, zip codes, 424425
PMT function, 225
PG diles, 322
points in data series, 367
Poisson distribution, 652
portiolio, investiment, 636-638
position, conselidating worksheets by,
452
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pound signs ), 135, 181
Power Utiliny Pak, 383
games, (17-720
Bowb Hunt, 718718
Dice Game, 718, 719
Hangman, 710720
Select By Yalue wility, 782
Yideo Poker, 717718
precodents
cell, Y01, T0E-704
selecting cells according 1o, 146
preformatiing columns, 513
presentalions, spreadsheets for, 348
PRICE lunction, 861
PRICEDIR function, 661
PEICEMAT function, 661
print area box, 271-2%2
print preview, 10
priog quality, 267
print settings. custom views of, 278
pring titles, 272
printer, selecting, 264-2865
printing, 10, 263282
charts, 302-303
custom views and, 278278
font problems
headers and footers, 266-271
1g cells before, 280281
margin adiustiments, 268
masltipie copiss, 286
nopcontiguous rasges on singie
page, 279280
aue-step, 263264
nage breaks, 276-278
inserting, 276
previewing, 265, $71-478
removing, 276277
page settings, 267
print preview feature, 275274
accessing, 274-275
making changes while
previewing, 275-276
printer-specific options, 273
reporis, 38
of selected pages, 266
settings for
adjusting, 204
in Page Setup dialog box, 264,
266-273
in Print dialog box, 264266
sheat options, 271-273
speciiving what to priut, 266
templazes to change defauits, 281
procedures, Sge alye macyos
defined, 7569
wariable declaration in, 855
programiming, See VBA programming
programs, 71

project tracking, 481
PROPER function, 216
property{ies}
control
CheckBox, 831
ComboBox, 832
ListBox, 834
OptionFutton, 835
protection options, 13
protection, spreadsheet, 355357
Purchase Order femplate, 8%
puzzles, word search, 723-T24
PV junction, 225
pyramid charts, 285, 314-315

Cuattre Pro, 5. 201, 493, 495
fite formats, 73
guery(lesy
defined, 542
on external database files,
540550
changiog, 553654
copying or moving, 553
creating, 554-555
deleting, 553
external data ranges, 551-554
1o get data, 341
mivltiple, 553
operators for, 54%
without Ouery Wizard, 354-357
vefreshing, B52-553
selecting data source, 542-545
stariing, 542
vsiog muoltiple database tables,
556
uging Guery Wizerd, 545-550
eshing, 549, 542, 562-383, 655
saving, 549
Wab, 634-697
query operators, H4Y
quitting Excel, 38
{HIOTIENT funcrion, HE2

R
raclar charts, 285, 311
RADIAMNS function, 203
radio (option) buttons, 5560
RAMD function, 201, 218
RANDBETWEEN function, 862
Random Number Geperation tool,
851652
range(s), 138-168, 838846, See nfso
pivot tables
as argumnent of function, 795-796
array, 464

mrrey doromdas for counting
characters i, 468-469
arrey formulas for dentifyving vatue
i, 467468
array bormulas for susiming nth
vadue in, 471-472
AutoShape around, 849-B50
bin, 648
copying, 149-154, §40-841
1o adisernt cells, 153
1o other sheets, 154
using drag and drop, 152-153
using menu commands, 151, 133
usiog shortent keys, 152
using shoricut menus, 151
using toolbar battons, {49
criteria, 523524
data
automnatically updated, 402
modifying, 379-380
defined, 128
embedded in Word docurnent,
875677
iooping through, 843844
maoving, 154-155, 843
multiple consolidation, 568
named, 381382, 515
in VBA code, 8440
zooming, 128
names/heming of, #1188, 171
advantages of, 161-162
aulomatic, 164166
changing, 168
deleting, 167
muanual, 162-164
redetining, 168
table of names, 166167
valid, 162
nonpoeontiguous, on singlo page,
279280
prompting for cell vaive, 844-845
reference operators for, 193
selecting, 140-147
all sheets, 145
in array, 464
for chariing, 296
complete rows and columns,
141-142
determdning type of, 845846
to end of row or colurn, 342
muitiple, 845
multlshiest ranges, 143-145
nneontiguous ranges, 142-143
row or eoluein, 847
speclal selections, 145-147
sorking, B36
text box to match, 848849
transposing, 160-161
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H

rangs intersection, 182, 192-154
Range object, 777
range operator, 201
range refsrences
as arguaroends, 202
changeable, 204
range selection boxes, 66, 67
Rank and Percengile tool, 652653
RANK function, 472-473
ranking, arcay formulas for, 472473
RATE function, 225
RC reference style, 140
read-gnly files, 480
read-cily option, 83
read-only properties, 776
recaleulation, aulomatic, 3
RECEIVED function, 561
record(s}, 542
adding, 556
editing, 556
recording macros, 760-782, 767769
absolute vs. relative, 768-769

feport Manager, 859
regervation, file, 479481
resizing

charts, 289

windows, 44-45
resource allocation, 635-638
reslorved state, 44
result set, 542
reversing comimands, 53
Right arrow, 101
RIGHT function, 213
ripple affect, 182, 695

E files, 322

ROMAN function, 216-211
votating drawing object, 329
BOUND function, 108, 211
rowting workbooks, 486485
row{sy, 133137

array formulas for returping last

wali in, 476
chanyging heights of, 136
copying, 528

seenario management, 11
Bcenario Manager, 598, 600, 607515

defining scenarios, 808-810
displaying scenarios, §11
lmitations of, 614615
merging scenarios, 612
modifving scenarios, 611
report generation, 612-614

Scenarios tool, 611

entific forat, 107

scrap, 877

Scereen Tips, 737
sereen updates, 8§52
Seroil Lock key, 48
SoroliBar, B36

cantrol
SpinButton, 836
TeutBrorsx, 837838
of Control Toolbox controls, 826-828
detined, 759
of files, 71-72
of objects, 774775, 1776778

rectangle obiect to hide cells, 281 deleting, 135

#REF!, 706 displaying unigue, 528

reference functions, 225229, See alsn hiding, 136-137
specific names of functions inserting, 133-135

reference operators, 193 in lists, 513 security, file, 83

Reference text box (Consolidate dialog selecting complete. 141-142 seethrough cell selection, 17
box), 452 row differernices, selacting cafls with, 146 “See-through View,” 141

Serolifler control, 835836
soroiibars, 5051

on workbook window, 27
SEARCH function, 216

refevences row tield, 563, 574 Setect All button on workbook window,
cell. Sze call references ROW function, 470 26
range, 207, 204 row headings, 28-30, 131 Seject by Walue utifity, 783

refreshing printing, 272
pivol tables, B2, 578 sorting and, 534

Select (ase construct 78O
selected cells and ranges, custom views

gueries, 540, 542 552-3353, 693 using as names, 195 of, 275
Kegistry, 72 on workbook window, 26 selecting
Regression tool, 653855 RTF file, posting, 672, 674 cells

relational database, 542, 5566 during data entry, 116
relative cell yeferencing, 178-175, 180, see-through, 17
i columng

run thine, 810

relative recording, 768768
relative references. naming iormulas
amd, 191

removable medium, backup copies on,

90
removing page breaks, 276377
renaming tookbars, 735

yepeating information during data enixy,

116

REPLACE function, 215
replacing cell contents, 99
repori(s)

PivorlChart, 587-588

priuting, 38

seenario, 612-614

Sclver-generated, 626, 627

5

Sampling tocl, 855
saving
in HTML format, 650
gueries, 548
to server, 1§
tesaplates, 752~753
workibooks, 37-38, 80-87
default location for, 82
file paming rules, 32
in older formats, B6-¥7
options for, §3-84
surnmary information, 84-85
as text file, 265
scaling, 267
seanner, kpporting graphics from,

compliete, 141142
multiple, 135
for querying, 545
data series, 377
during editing formulss, 183
with mouse, 102
parts of charts, 301, 366
printing selection, 268
rangey, 140-147
all sheets, 145
in array, 464
complete rows and colurans,
141142
multlsheet ranges, 143145
nonconfiguous ranges, 142-143
special selections, 145-147

spraadshests for, 348 324-325
swmmary, 707 scenario, defined, 397

SelectSpecie’l method, 344
self-repair feature, 15
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sequential routing, 487
serial number system, date, 98
series, AutoFill Lo create, 187
series axis, 367
SERIES formula
editing, 380381
using names in, 381382
SERIES function, 381
SERIESSUM function, 682
server, 479, 480
backup copies on, 50
Microsofl news, 688
saving 1o, 16
setup program, 72
1o install mapping features, 419
shading, 246-249
shadow, AutoShapes, 333334, 336-337
shared workbooks, 82, 88, 481484
advanced settings for, 483484
conflicting changes between
users, 484
personal views, 484
tracking changes, 484
updating changes, 484
appropriate sharing, 431
designating, 482483
limitations of, 482
shared worksheels, with Analysiz
TooiPak fumctions, 641
sharing. data. See under data
sheet(s). See also workshest(s)
chart, 284, 292, 294293
displaying pivot tables on different,
581-582
printing selected, 256
shest tabs on workbook window, 26
sheet xit file, 750
sheetdevel names. 188189
Shift+End, 102
Shift-Home, 102
Shift-teft/right arrow, 102
shortont keys
to activate sheet, 122
agsociated with menu Hems, 54
for Clipboard operations, 501
o copy ranges, 152
to create new workbook, 74
for excouting macros, 766-767
formatting values using, 104
giving commands using, 84
for grouping, 436
for inserting worksheet, 123
to open existing workboolk. 75
to recalculate formulas, 184
for repeating nformation, 115
ta select precedents and
dependents, 702-T03
to show function’s argument, 208
far ungrouping, 436

shortout menas (Contoxt menus),
5758
1o copy ranges, 151
custamizing, 733
simultaneous routing, 487
SN function, 212
single-cell goal seeking, 10, 618-622
example of, 618619
graphical, 620-622
single-factor analysis of variance, 642
sizing drawing object, 329
SLN function, 224
SRALL function, 231
smoothing constant (damping factor),
646
siapshots, 279
Solver, 622838, 859
appropriate problems for, 623
exanples, 823627
aflocating resources, 635830
miginizing shipping costs,
£29-631
optimizing investment portiolio,
£36-638
scheduling stalf, 631635
Options dialog box, 627-628
Sort Ascending button, 534, 538
Sort Descending button, 336
sorted histogram (Pareto) optlon, 649
soriing
data, 556
lists, 529-336
complex, 530-5334
customn, 534533
file Hst, 78
simpie, 530
order of, for query, 547548
rules for, 532
sound file player, 724
soiree application, 500, 866
source data, 563
source workbook, 441, 447
spacedelimited text files, 498
special number format, 107
Specialle’ls method, 844
spell checking, 11, 708-709
SpinBution control, 836-837
spinners, 6667
splitting panes, 130
spreadsheet(s), 343-360
audience for, 343-345
budget, 347
characteristics of successful,
345346
creating, 348-358
considering sudience, 350-351
designing workbook layout,
3531352
developing a plan, 350

entering data and lormulas,
352-353
formaltiog, 353-354
protection, 355-357
testing, 354
defined, 3
errors in, 358369
for-your-eyes-only, 344
maintenance of, 358
guick-and-dirty, 344
uses of, 346349
database access, 348
financiad or dats-analysis
wodels, 346348
list rmanagement, 348, 349
reports and presentations, 348
turnkey applications, 348
Boreadsheet Solutions tesmplates, 89
SQL (Struciured Query Language), 542
SORT hunction, 202, 212, 459
SORTPI function, 662
stacked cobumn chart, 3(4
staff scheduling, 631635
standard deviation errer har, 385
standard error bar, 385
Standard toolbhar, 31, 58-59
starting Excel, 21
states, window, 43-44
statistical functions, 229~231. See also
specific names of functions
status bar, 22, 24
status box, Goal Seek, 619
stock charts, 285, 313314
string criteria, 528
Structured Query Langnage (30L), 542
stvie(s)
applied to workshest outlines,
437438
built-in, 258
named, 257262, 358
applying, 259
controling with templates, 262
creating, 260
deleting, 261
merging, 261-~262
moditying, 261
overriding, 260
Sryle tool, 259
stylistic formatting, 112114, 295-262
alignment, 152
attribastes, 113
AwtoFormatiing, 253-256
cemrotling, 256
using, 254-255
backgroamd, 252-253
borders and lines, 113-114, 245-252
3D effects, 252
cell alignment, 242-246
horizontal, 242-244
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rext contrel options, 244245
wvertical, 244
celi ertentation, 245246
colors and shading, 114, 246245,
251
conditional, 256-257
font and text size, 113, 237-242
changing, 239-241
default, 238-239
multiple, in one cell, 241242
named styles, 257262
applying, 2569
controlling with tempiates, 262
creating, 266
deleiing, 261
merging, 261-262
maodifying, 261
overriding, 260
overview of, 235-237
reasons for, 235-235
tme for, 236
Sub keyword, 757
Sub statement, 7687
submenus, 53
subroutines, 598, 787788 See giso
Macros
defined, 759
event-handler, 810, 812-813, 817-81%
procedure, 772
VA, 757-758
subtotals, 563
cusinmizing, 576
subtraction operator, 176, 172
SUM humction, 202, 212, 471, 569
SUMIF function, 213
sutnmary formulas, 434
summary information, workbook, 84-85
summary report, 707
surface charrs, 285, 311-312
survey data analysls usiog plvol tables,
SHE-590
switching among windows, 45-47
SYD function, 224
Symbotic Link files (SYLK), 496
file format, 73
symbels, Euro currency, 19
symmetrical pattern drawing, 721
syntax srrors, 772

T
Tab, 65
tab order, in custom dialog boxes, 821
tab scroil buttons, 122

on workbook window, 26
tab split bar on workbook window, 26
tatvbed dialog boxes, 68-69
tab-delimited text files, 4596
table(s)

data, 367, 380, 391, BR&607
Hmitations of, 607
one-inpat, 600603
twoedngait, SO3-607
database (lista), 231
defined, 542
dynamde crosstab, array formalas in,
475476
formatting, 31-34
of names, 166-167
pivot. See pivol tables
TABLE fonction, 603
Tables pane, 858
target cell, 623
Taskhar, Windows, 18
TRILLEG function, 661
TRULLPRICE function, 661
THILLYELD function, 661
tetaplate(s), 11, 12, 74, 8800, 747-754
to change default printing, 281
controlling named styles with, 262
default workshest, 747, 749750
defined, 747
map, 428
overview of, 747
workbook
custom, 747, 750-754
clefauilt, 747, 748-749
aciuded in Excel, 751
operation of, 751
sizering, 753
Template Utilities, 859
Template Wizerd with Data Tracking,
#39
terminslogy
of databases, 542
of lnternet, 686
of pivol tabdes, 562563
of VBA, 759
testing spresdsheet, 354
text, B
centering, 112
changing or erasing, 99102
in chart jegend, 370
in drawing object, 330
embedding in worksheet, 879680
entering, 96
file formals supporied, 493, 495495
in formnuias, 169
inserting, in AutoShapes, 335
in map labels, 420
inobject to cell, linking, 330-340
pasting, 872, 674
using ouiline for, 435
text box oidect to hide cells, 281
rext boxes, 8
1o match range, 348849
rext criteria, 525, 526
text file format, 73

text files, 409-508
characteristics of, S03-504
dellmited, 458, 503
iraporting data from, 502-509
using Texd nport Wizard,
504569
nondelimited, 503
saving warkbook as, 265
fypes of, 496
text format, 107
text formatting, 9
text functions, 214-218, See also specific
names of functions
text handling, 8
Text Import Wizard, 304-509
text size, 113
et strings, inserting, 756
TextBox conirol, B37-838
TOA files, 322
30 charts, 290, 3685, 382364
modifying, 392
rotating, 392~-304
from two-input data tables, G06-607
30 effects, 252
AutolShapes, 333334, 336-337
tick marks, 373
Tick-Tack-Toe, 715716
TIF files, 322
rmeds), 97, 98
cugtnm formatting codes for,
110131
eniering current, 117
time format, 167
TIME funciion, 223
those functions, 221, 223, See also
specific names of fuactions

title(s)
adding, 34-35
chart, 365, 369370
print, 272
title bar, 22
on workbook window, 24
TODAY function, 221222
ToggleBulinn control, 838
tool(s). See also drawing tools
in Analysis ToolPak, 640-657
Analysis of Variance, 642643
Correlation, 643644
Covariance, 44
Descriptive Statistics, 645-646
Exponential Smoothing, £46-647
Fourier Anajysis, 648
FYest (Two-Sample Test for
Variznee), B47-648
Histogram, 648649
Moving Average, 850651
Random Number Generation,
£31-652
cordinued
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tool{s), {nontinued)
in Analysis ToolFak, (comtinued)
Rank and Percentile, 657653
Hegression, 653655
Saempling, 665
+Test, 656
=Test (Two-Sample Test for
Means), 636657
analytical, 10
auditing, 354, 706707
for racing vell relationships,
TO3-T05
Chart Oblects, 365
copy, 157
Cropping, 578
Histogram. 474
Seenarios, 611
teodbar(s), 23, 538-83, 731-724
adding/removing buttons, 738-738
attaching to workbook, 735-736
Anditing, 703-T04
Trace Error button of, 745
autosensing, 737
changing button funciionality,
T40-741
changing bution image, 740, 744-746
Chart, 293, 294, 365
Ciurcular Reference, 185, 186
Cliphoard, 19, 60
comfiguration of, 733
Control Toolbox, 814
creating new, 735, 741--744
customization of, 8, 18
deleting, 735
displaying, 735
Drawing, 325-327
in Excsl 2000, 55
floating, 59
Formatting, 58-50, 103~104, 237
formatting values using, 103-104
Forms, ¥24
dlving commands using, B8-63
hiding/showing, 8162, 738
list of, 6061
menu bar as, 58
Microsoft Map, 415
Hi-63, 733734
Office, 155
Office Cliphoard, 157
personalized, 736
Picture, 324
PivotTabie, 436, 569-571
renarming, 735
resetting, 733
Screen Tip
Htandard, 31, 38-5%
Weh, 692693
WordArt, 33
toolbar buttons. See bution(s), tooibar

8

Tools menu for opening workbooks, 78
Top 10 filtering, 521
tracers, cell, 704
tracing ¢ell relationships, 700-706
anditing tools foy, 703705
cirentlay references, 706
Go To Special dialog box, 101~703
tracing ervor values, 705-706
fransition options, 50
fransposing ranges, 160-161
rendlines, 387, 386388
trigonometric functions, 200-213. See
also specific names of
functions
plotting, 725-726
troubleshooting, 699-713
AutoComplete, 710-711
Aautolorrect, 709710
formula, 766
jearning about unfamiliar
spreadsbest, 711-713
pasting list of names, 713
viewing formulas, 712
zooming out, T11-712
ather auditing tools, 706767
spedl checking, 708749
tracing cell relationships, 700-708
auditing 1ools for, 703705
circular references, 706
Go To Special dialog box,
701-703
tracing error values, 705-706
types of worksheet problems,
HHE-T00
TrueType ionts, 279, 353
Flest tool, 858, 657
vrnkey applications, spreadsheets for,
349
two-ditnensional array, 457
rwa-factor analysis of variance
with repication, 642
without replicatica, 842
tweordngaat data tables, 603-607
Two-Sample Test for Means (z-Test)
tool, 856657
Two-Sarople Test for Variance (F-Test),
647648
two-sample Mest
assuming equal variances, 856
assuming unequal variance, 656
THRY extension, 504
TYPE function, 219

ij

Undo command, 53
Unile stack, B4

unhiding, See hiding
uniform distribution, 652

Uniform Resource Locator (URL), 686
tnited Kingdom, map of, 423
United Kingdom Standard Reglons, map
of, 408
United States, maps of, 408, 423
ap-hars, 367
Update Add-n Links, 859
upsiating changes, 484
UPPER function, 218
URL, defined, 686
Use labets in check boxes {Consolidate
dizdog box), 453
LiserForms, 807
defined, 759
modeiess, 20

¥

validating data entry, 114-115
validation criterla, pasting, 159
validation, selecting cells set up for
data, 147
walueds), 93-94, 95
#YALUE, 641
#VALUEL 706
value(s). See also numbers, formatting
changing Or erasing, 58102
on worksheet, by dragging,
354~395
converting formulas to, 197198
datae, 97-98
eniering, 98
errors redated to, 182
extreme input, 354
formatting, 102-112
automatic, 143
custom, 107, 108-112
types of formats, 1(4-108
using shortcut heys, 104
using toolbay, 103104
in formulas, 169, 196
hard-coding, 358, 304
i formutas, 195
incrementad, Autolill 1o ereate, 187
pasting formulas as, 159
in range, array formulas for
identifying, 467463
tirmne, 97, 98
vaiue axis, 283, 267
value axis titte, 368
vajue criteria, 5725, 526
value shading map format, 411412, 417
variable(s)
declaring, f53-855
in VBA, 778
variance, Two-Sample Test for, 647648
> Visual Basic for Applications
(VBA}
VBA code, preveating access to, 360
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VBA functions, 757, V58--740, TES-7593
analyzing, 788
arguments of, 792756
no argument, 792
one argament, 793-794
range argument, 795-796
two argoments, 794795
debugging, 796
declaring, 788-790
example of, TR6~TH8
axecuting, 750-791
Jearning more about, 798
mits of, 790
overview of, 785
pasting, 797-799
in VBA subroutine, TB7-788
m worksheet, T86-T87
VBA programuming, 835855
changing settings, 847-848
Boolean settings, 847
non-Boolean settings, 847-848
charts, 850-852
applviog formatting 1o, 851-852
modifying properties of, 851
modifying type of, 850-851
graphic objects (shapes), 848-850
AutoShape around range,
849850
text boy to match range, B48-849
ranges, 830348
copying, 340-841
detersnining type of selection,

245846
identifying muitiple selection,
B4

tooping through, 843-844

moving, 843

promagting for cell value,
844545

selecting row or antumn, $42

selecting o end of row or

Video Poker, 717-718
viewing formulas, 712
views of worksheets
rouitiple, 128129
paming, 133
YVillage remplate, 89
VIM (Vendor indepandent Messaging),
485
virtual memory, 72
visible cells, selecting, 147
Visual Basic Editor (VBE), 759, 768, 807
Toolbox controls, BG8-810
properties of, 809-810
YVisual Basic lor Applications (VBA), 4, 5,
12, 234, 785-784. See also
macros
coding, 770772, See alse YBA
programming
entering and editing code,
TI-772
tips on, 772
controiling execution in, 778780
For-Hext joop, 779
If-Ther construct, 778773
Lo construct, 780
o With constroct,
TI9-T80
tunctions. See VBA funciions
learning more about, 783-784
obiects and collections in, ¥75-776
methods, 778
properties of, 776778
subroutines, T57-758
terminoiogy of, 758
uses of, 756757
variables in, 778
workings of, 772-775
VIOOKUP function, 225-226, 793
volatile functions, 210

widh

what-if analyses, 11, 348, 395613
data tables, 598-607
mitations of, 607
onedaput, B00-803
two-tnput, 803607
example of, 595-536
macro-assisted, BHT-HIG
manual, 597
inreverse, 617
Scenario Manager, 598, 600, 667615
defining scenarios, 608610
displaying scenarios, 611
Hrnitations of, $14-815
merging scenarios, 612
modifving scenarios, 511
repart generation, 612-614
What's This? comnand, 58
L, COMUMI
chatging, 135-136
pasting, 159
window(s), 43-47
active, 45
closing, 47
maouselass manipulation of, 47
moving and resizing, 4445
sizes and positions, custom views
of, 278
states of, 4344
switching among, 45-47
workbook, 2427

window comrol meny button, 23, 24
Windows Chpboard, 150-151, 138, 487

sharing data using, 666668
Windows Paint program, 323
Windows Taskbar, 18, 44
With-Zad With construct, 778-7806
Wizard, Chart, 287-288

VKT files, 494
WK3 {iles, 494
WEA files, 4984
WKS files, 454

walls of 31t chart, 367, 392
WHI files, 485

WM files, 322
Word. See Microsoft Word
word search puzeles, 723-724

columnn, 342
speed tips, 852-855
alert messages, 852-853

declaring variabie types,
B53-#55
soreen updates, 852
simplifying object references,
853
YR function, 224
vector images, 321
Yendor Independent Messaging (VIb),
485
vertical coll alignment, 244
wvertical scroitbar on workbook window,
27
wvideo clips, emmbedding, 680
video modes, 351

WB2 files, 495
Web discussions, 16
Web Form Wizard, 858
Web pages, 348
activation froin toolbar hution, 746
Web queries, 694-697
Wels sitefs)
defined, $86
DG Books, 689
mfcrmation from, 687
Web subscription and netification, 18
Web toolbar, H02-693
WEEKDAY function, 222
SWERKNUM function, 858

Wordart, 334-356
drawing tips, 335-338
exampie of, 335

WordArt 1oolbar, 334
WordPad, 671

WordPerfect for Windows, 871
workbook(s), 6, 43, 72

active, 43

attaching toolbars to, 735735

closing, 87-88

creating new, T4-75

dependent, 441

documenting, 357

finuding lost, 79

costinued
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o RDOOR(S), (vontinued)

linking, 441-448
changing liok source, 448
examining inks, 445
sxiernal relerence formuias foy,
442446
zeasons fov, 441442
to recover data from corrupted
files, 449
serveriog lnks, 448
to unsaved workbook, 444
updating tinks, 446
mailing as e-mall atiachment,
485456
rasdnienance of, 368
mergting styles from other, 261-262
multisheat, BE
opening sxisting, 1580
automatic, 80
fije display preferences, 7778
filtering by file type, 77
specitying folder for, 77
Tools menu for, 78
protecting, 336
referving to cells i other, 177178
routing, 486488
saving, 3738, 8087
dedaudt location {or, 82
fite naming rules, 82
in FTML format, 690
in odder formats, B6-87
options for, 384
suomary informagion, 84-85
as text file, 265
shared, 82, 88, 481484
advanced seltings for, 483-484
appropriate sharing, 481
conflicting changes Detween
users, 484
designating, 482-483
Hrattations of, 482
porsonal views, 484
wacking changes, 484
updating changes, 484
source, 441, 447
templates
custom, 747, 750-754
aefault, 747, T4B-T50
inchuded in Fxcel, 751
operation of, 75}
storing, 783

shared workbooks, 82, BE, 481484
advanced settings {or, 485484
appropriate sharing, 481
confiicting changes between

users, 484
designaiing, 482483
Hmitations of, 482
personal views, 484
tracking chaoges, 454
updating changses, 484

worksheet(s), 43, 121137, See dlso

cell(s); column(e); row(s)
activating, 122
adding new, 122-123
guditing and anpotation of, 10
cell relerencing outside, 177-178
changing name of, 123-124
consolidaling, 448455
data sources foz, 454-455
inding worksheets and, 442
pivet tables for, 585587
shared workbooks for, 481
by using Data < Consolidate,
452454
by using formulas, 449451
by using Paste Special, 451
copying, 125
copying ranges to, 154
default template, 747, 740756
deleting, 123
erroy-iree, See troubleshooting
formatiing. See stylistic formatting
hiding/unhiding, 125
moving, 124-125
navigating through, 48-51
using keyboard, 49-50
using mousa, 50~51
obiects ambeddad in, §79-681
cuilining, 10
panes
freeving, 131-132
splitting, 130
pivod tables to consolidate, 5B6-587
profecting, 385-356
selecting entire, 145
shared, 641
size of, 49
VBA function i, 786-187
views of
rouitiple. 128-128
naming, 133

creation of, 435-436
automatic, 434
data preparation, 433-434
manial, 434430
displaying levels of, 437
exampie of, 429432
hiding svmbols of, 439
resnoving, 438
workspace files, 88
world countries, waap of, 408, 423

World Wide Welb (MWW, 685 G8E. See

also endries beginning with
Weh

WPG files, 322

W iles, 495

WOL files, 495

Wrap Text formatting feature. 118

X

X icon, 1064, 101

EER funciion, 661
Fldgalyyxds, 302

KLA files, 72, 868

KLB files, 72

KL files, 72

XLL tiies, 72

KM files, 72

KM language, 11, 755
XL3 files, 7, 72, 857
X18tary {older, 80

XX flles, 72

LW files, 72

KNPV fnction, 661
XY {scailer’ charts, 285, 308303
Y -sketch, 726-727

Y

Yoar 2000 issues, 98
YEAR function, 222
YEARFRAC function, 658
years, grouping by, 593
FIELD function, 661
YIELDDISC function, 661
YIELDMAT function, 661

4

zewo, diviston by, 182
zip codes, plotting U.8., 424-425

waorkbook window, 24-27
WORKDAY function, 658
waorkgroup appiication, 479488
file reservations, 479-48]
mailing workbook as eanall
atiachment, 485-486
routing workbook, 486483

zooming, 125-128 Zoorn toot box, 127
worksheet controis, 12, 13 zooming, 418-418, 711-712
worksheet map, 707 worksheet organization sensed
worksheet outlines, 10, 429440 from, 702
adding data to, 439 worksheets, 125128
applying styies to, 437439 z-Test (Two-Sampis t for Means)
charts from, 440 tool, 556~
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